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Introduction (English)

This Concise User’s Guide introduces the main features
of your computer. The English version of this guide be-
gins on page 1. The expanded User’s Manual is on the
Device Drivers & Utilities + User’s Manual CD-ROM.

Einfihrung (Deutsch)

Dieses Ausflhrliche Benutzerhandbuch fiihrt Sie in die
Hauptfunktionen des Notebooks ein. Die deutsche Versi-
on des Handbuchs beginnt auf Seite 45. Das erweiterte
Benutzerhandbuch finden Sie auf der CD-ROM fiir die
Gerétetreiber und Hilfsprogramme (CD-ROM Device
Drivers & Utilities + User's Manual).

Présentation (Francais)

Ce Guide Utilisateur Concis présente les fonctionnalités
principales de votre ordinateur. La version francaise de
ce guide commence a la page 89. Le Manuel de I'Utilisa-
teur étendu se trouve sur le CD-ROM de Pilotes & Utili-
taires + Manuel de [I'Utilisateur (CD-ROM Device
Drivers & Utilities + User's Manual).

Introduccion (Espariol)

Esta Guia del Usuario Concisa le presenta las caracteris-
ticas principales de su ordenador. La version espafiola de
esta guia comienza en la pagina 133. El Manual del usua-
rio completo se encuentra en el CD-ROM de Controla-
dores del dispositivo y Utilidades + Manual del usuario
(CD-ROM Device Drivers & Utilities + User's Manual).

Introduzione (Italiano)

La presente Guida Rapida per I'Utente introduce le carat-
teristiche principali del computer. La versione italiana di
questa guida inizia da pagina 177. Il Manuale utente
completo si trova nel CD contenente driver e utilita +
Manuale utente (CD-ROM Device Drivers & Utilities +
User's Manual).
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Notice

The company reserves the right to revise this publication or to change its contents without notice. Information con-
tained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any sub-
sequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this
publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse) of this pub-
lication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted
or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this pub-
lication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks
of their respective companies. They are mentioned for identification purposes only and are not intended as an endorse-
ment of that product or its manufacturer.

© November 2007

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents
and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copy-
right protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited
viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is
prohibited.

Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.

Notice - 1
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About this Concise User Guide

This quick guide is a brief introduction to getting your system started. This is a supplement, and not a substitute for
the expanded English language User’s Manual in Adobe Acrobat format on the Device Drivers & Utilities + User’s
Manual CD-ROM supplied with your computer. This CD-ROM also contains the drivers and utilities necessary for
the proper operation of the computer.

Some or all of the computer’s features may already have been setup. If they aren’t, or you are planning to re-configure
(or re-install) portions of the system, refer to the expanded User’s Manual. The Device Drivers & Utilities + User’s
Manual CD-ROM does not contain an operating system.

Regulatory Information

Regulatory notices and information are contained in the expanded User’s Manual on the Device Drivers & Utilities
+ User’s Manual CD-ROM.

N A
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Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the wireless modules are
OFF if you are using the computer aboard aircraft.

2 - About this Concise User Guide
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Instructions for Care and Operation

The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element.
This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other strong mag-
netic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget to
save your work. Remember to periodically save your data as data may be lost.

Take care when using peripheral devices.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the com-
puter to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power sup-
ply. Then refer servicing to qualified service personnel under any of the following conditions:

When the power cord is damaged or frayed.

If the computer has been exposed to any liquids.

If the computer does not work normally when you follow the operating instructions.

If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If there is an unusual odor, heat or smoke coming from your computer.

Instructions for Care and Operation - 3




Concise User's Guide

Power Safety
The computer has specific power requirements:

e Only use an AC/DC adapter approved for use with this computer.

* Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply.
If you are unsure of your local power specifications, consult your service representative or local power company.

» The AC/DC adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety fea-
ture; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.

« When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.

» Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.

» Before cleaning the computer, make sure it is disconnected from any external power supplies.

2N
I

Power Safety Warning

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals

and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the ma-
chine on.

Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a note-
book which is powered on in a travel bag may cause the vent(s) to be blocked. To prevent your computer from overheating make
sure nothing blocks the vent(s) while the computer is in use.

Cleaning

Do not apply cleaner directly to the computer, use a soft clean cloth. Do not use volatile (petroleum distillates) or
abrasive cleaners on any part of the computer.

4 - Instructions for Care and Operation
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way.
Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may pos-
sibly result in fire.

Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

Keep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

\ A/
PR
Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under
various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid
waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manu-
facturer. Discard used battery according to the manufacturer’s instructions.

Instructions for Care and Operation - 5
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System Startup

e ] Remove all packing materials.

Shut Down 2. Place the computer on a stable surface.

Note that you should al 3. Secur.ely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse)
to their ports.

ways shut your computer )
down by choosing the 4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC
Shut Down command power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
from the Lock Button 5. Use one hand to carefully raise the lid/LCD to a comfortable viewing angle, while using the
Menu in Windows Vista. other hand (as illustrated in Figure 1 below) to support the base of the computer (Note: Never
This will help prevent hard lift the computer by the lid/LCD).
disk or system problems. | g press the power button to turn the computer “on’”.

Model C Computers

Note that Model C com-
puters have latches on
the Lid/LCD. Move the left
latch to the unlock posi-
tion, and slide the right
latch (and hold it in place)
while raising the lid.

Figure 1
Opening the Lid/LCD/Computer with AC/DC Adapter Plugged-In

6 - System Startup
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Model Differences
This notebook series includes three different model types. The models differ as indicated in the table below.

Feature Model A Model B Model C

VIA VN896CE Integrated Video
Video Adapter System
(Internal On Chip)

NVIDIA GeForce 8400M G (NB8M-SE) Discrete Video System
(External On Board)

Windows Vista Home Basic Edition (64-bit)

Windows Vista Windows Vista Home Basic Edi- . ) : o
Version Supported tion (64-bit) Windows Vista Home Premium Edition/
PP Business Edition/Enterprise Edition/Ultimate Edition (64-bit)
Fingerprint Reader No Optional
Zoom & Audio
Record Buttons Yes @ See Table 4, on page 14 No
AC/DC Adapter 65W (DC Output 19V, 3.42A or 18.5V, 3.5A) 90W (DC Output 19V, 4.74A)

o

17" WXGA
17.1" WSXGA+
17.1" WUXGA

15.4" WXGA
15.4" WXGA+

LCD Type

Table 1 - Model Differences

System Startup - 7
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System Software Operating Systems Supported
Your computer may already come with system software Operating System
pre-installed. Where this is not the case, or where you are Note
re-configuring your computer for a different system, you Model A | Models B & C
will find this manual refers to the Microsoft Windows - —
Vista operating system. Further information on installing *Windows XP Home Edition or
the drivers and utilities is available in Chapters 4 & 7 of Professional
the expanded User’s Manual on the Device Drivers & Windows Vista (64-bit) Home In order to run Win-
Utilities + User’s Manual CD-ROM. Basic Edition dows Vista without
] _ limitations or
Windows Vista decreased perfor-
V. (64-bit) Home mance, your computer
Premium/Busi- requires a minimum
Drivers ness/Enterprise/ 1GB of system mem-
Ultimate Editions ory (RAM).
If you are installing/re-installing new system software, you

will need to install the appropriate drivers. Drivers are pro-

- . . . .
grams which act as an interface between the computer and For information on the Windows XP OS see the Device

a hardware component e.g. a wireless network module. It is Drivers & Utilities + User’s Manual CD-ROM.

very important that you install the drivers in the order listed

in Table 5, on page 26. You will be un_able to use _rTl_ost ad- Not IncI u ded

vanced controls until the necessary drivers and utilities are . . . .

properly installed. Operating Systems (e.g. Windows Vista/Windows XP)

and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please
consult the appropriate manuals.

.|
8 - System Software



System Map: Top View with LCD Panel Open
(Models A & B)

\ A/
2§
Wireless Device
Operation Aboard Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the appropriate function
key  combination  (see

) to
toggle power to the wireless
modules (WLAN/Bluetooth),
and check the LED indicator
B to see if the modules
are powered on or not (see

)-

Figure 2 - Top View with LCD Panel Open (Models A & B)

Concise User’'s Guide
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BOXXNOOA~WDN

Optional Built-In PC
Camera

LCD

Speakers

Power Button

Hot-Key Buttons
Keyboard

TouchPad and Buttons
Built-In Microphone
LED Indicators

. Fingerprint Reader

(Optional for Model B
Computers only)

System Map: Top View with LCD Panel Open (Models A & B) -9
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Optional Built-In PC
Camera

LCD

Speakers

Power Button
Hot-Key Buttons
Keyboard
TouchPad and Buttons
Built-In Microphone
LED Indicators

0. Fingerprint Reader
(Optional)

BOX®NOOAWDN

System Map: Top View with LCD Panel Open
(Model C)

\ A/
ZAS
Wireless Device
Operation Aboard Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the appropriate function
key  combination (see

) to
toggle power to the wireless
modules (WLAN/Bluetooth),
and check the LED indicator
@Y to see if the modules
are powered on or not (see

)

Figure 3 - Top View with LCD Panel Open (Model C)

10 - System Map: Top View with LCD Panel Open (Model C)
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LED Indicators

The LED indicators display helpful information about the current status of the computer.

Table 2 - LED Indicators

Icon Color Description
@ Green Number Lock (Numeric Keypad) Activated
Green Caps Lock Activated
Eﬁ Green Scroll Lock Activated
Green The Computer is On
D/Q) Blinking Green The Computer is in Sleep Mode
Orange The AC/DC Adapter is Plugged In & the Computer is Powered Off
Orange The AC/DC Adapter is Plugged In & the Battery is Charging
[T Blinking Orange The Battery has Reached Critically Low Power Status
Green The Battery is Fully Charged
‘@ Green Hard Disk Activity
(((x))) Green The WLAN/Bluetooth Module(s) is/are Powered On

LED Indicators - 11
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Keyboard

The keyboard has a numeric keypad for easy numeric
data input, and features function keys to allow you to 4

change operational features instantly. Note that Model Special Characters

C computers have a numeric keypad to the right of the Some software applications allow the number-keys to be

main keyboard. used with Alt to produce special characters. These special
i ’ characters can only be produced by using the numeric key-
e o - pad. Regular number keys (in the upper row of the key-
v, a8 jo 8 jofN §- ggmti‘i‘ s board) will not work. Make sure that the numeric keypad
Y Numeric© M E (NumLK) is on.
« Keypad

Other Keyboards

If your keyboard is damaged or you just want to make a
change, you can use any standard USB keyboard. The sys-
tem will detect and enable it automatically. However special
functions/hot keys unique to the system’s regular keyboard
may not work.

12 - Keyboard
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Function Keys & Visual Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down (see Table 3). In
addition to the basic function key combinations; visual indicators are available when the hot key driver is installed
(see page 28). After installing the driver an icon & will appear in the taskbar.

Keys Function Keys Function
Fn +~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness
Decrease/Increase
TouchPad —= — = PC Camera Power ;
Fn+FL Toggle — @ Fn+ F10 Toggle R 2,
Turn LCD Backlight Off WLAN Module '
Fn+F2 (Press a key to or use TouchPad to turn on) Fn+Fll Power Toggle i ,.,ME(‘"*’)) s M:‘ |
Bluetooth
Fn+ F3 Mute Toggle I ® Fn + F12 Module Power 9 .
Valume ' On  Volume ¥ Mute Toggle 8 reee @ reea |
Fn + F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle
Fn + F5/ | Volume Decrease/ Number Lock (Numeric Keypad) Toggle
F6 Increase Saleiaiiidiaing, Fn + NumLk (Models A & B)
Fn +F7 Display Toggle NumLk Number Lock (Numeric Keypad) Toggle (Model C)

Table 3 - Function Keys & Visual Indicators

.|
Keyboard - 13
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Hot-Key Buttons

The Hot-Key buttons give quick access to the default internet browser W and e-mail program &a. The PC Camera
buttons & (@] (&) can be used to run the camera application, to take still pictures and to zoom the camera in/out if a
PC Camera module is installed. If you have not included a PC Camera module in your purchase option, you can in-
stall the Quick Button driver (QButton) to enable you to use the Hot-Key buttons to launch applications of your choice
(see “Application Quick Buttons” on page 15 for details). Note that Model C computers do not support the audio

record or camera zoom hot keys functions.
Table 4 - Hot-Key Buttons

Hot-Key Button Function
w Activate the Default Internet Program
ﬁ Activate the Default E-Mail Browser
PC Camera Installed Activate the BisonCap/VideoView program/Take Still Picture (See Page 33)
'J E PC Camera Not Installed Activate Application Quick Button 1 (See Page 15)
Models A & B PC Camera Installed Camera Zoom-In (See Page 33)
Only PC Camera Not Installed Activate Application Quick Button 2 (See Page 15)
Models A & B PC Camera Installed Camera Zoom-Out (See Page 33)
Only PC Camera Not Installed Activate Application Quick Button 3 (See Page 15)
E] Mo%erLfyA &B Audio Record Start/Stop (See Page 23)

14 - Hot-Key Buttons



Application Quick Buttons

Note that the Quick Button driver (QButton) is designed
to allow use of the Hot-Key buttons & (@ as application
quick buttons in absence of the optional PC camera (only
install the Quick Button driver if the PC Camera is
not installed). You will need to install the quick button
utility to enable the functions.

The application quick buttons give instant access to user-
defined applications, with one quick button press. To
configure a program to open when the application quick
buttons &= @ (see Table 4, on page 14) are pressed fol-
low the instructions below. The application quick but-
tons will function as long as the program is running (the
icon Bf will appear in the taskbar). If the program is not
running you will need to restart the computer.

3

1. Press a button &[@ @ or right-click the icon [
taskbar.

2. Select Setup from the menu, scroll to AP1/2/3 (or just
Applicationl for Model C computers) and select
Custom.

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe
program exists (see below).

5. Double-Click on the program file or choose Open.

in the

Concise User’'s Guide

=
BT
Models A & B
I [apicanoad i s | Feoweel J |
i Exit Flesclype.  [Fpphestony eue =l |
™ Open as read anly
Model C

Application.exe

You will need to locate the actual application exe-
cutable (.exe) file, not just the shortcut. To find the
application right-click its shortcut on the desktop
and click Properties. Click the shortcut (tab) and
see where the executable file is located by clicking
the Open File Location (button).

Figure 5 - Application Quick Button Configuration
Screens

Hot-Key Buttons - 15
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System Map: Front & Rear Views

LED Indicators

1*USB 2.0 Port

DC-In Jack

Battery - -
LCD Latches

(Model C Only)

arwNE

Models A & B

1

Model C

Figure 6 - Front & Rear Views

16 - System Map: Front & Rear Views
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System Map: Left View

=

Security Lock Slot
Models A & B 2. Optical Device Drive

S Bay (for CD/DVD
Device)
Emergency Eject Hole
RJ-11 Modem Jack
S/PDIF-Out Jack
Microphone-In Jack
Headphone-Out Jack
Line-In Jack

NGO rW

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may
push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened
pencil or similar object that may break and become lodged in the hole.

Figure 7 - Left View

System Map: Left View - 17
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System Map: Right View
1. ExpressCard/54(34)
Slot Models A & B
7-in-1 Card Reader
2 *USB 2.0 Ports
RJ-45 LAN Jack
External Monitor Port

aroN

ExpressCard Slot

The ExpressCard slot accepts either ExpressCard/34 or ExpressCard/54 formats.

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)
MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

Figure 8 - Right View
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System Map: Bottom View

Vent

Battery

Hard Disk Bay Cover
CPU/RAM Bay Cover

2 2

PR

Models A & B Model C

The CPU is not a user
serviceable part. Ac-
cessing the CPU in any
way may violate your
warranty.

4

Battery Information

Overheating

To prevent your comput-
er from overheating
make  sure  nothing
blocks any vent while the
computer is in use.

Always completely discharge, then fully charge, a new battery before using it. Completely dis-
charge and charge the battery at least once every 30 days or after about 20 partial discharges.

Figure 9 - Bottom View
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Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive,
and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu icon 4, and
then select Properties if you want to customize the appearance of the Start menu.

‘ Open \;@a Default Programs [0 - — et
Explore ;"T\ Windows Update .
indows Update e :
! Searchu. e \, Lo 5’)
| Properties Programs » @ -
| Open All Users ';/_.’ Documents . Sy o
Fal Explore All Users B Control Panel ik
. : - .
| & Network Connections u ‘\‘ s
Todbe E= |&# Printers e
: [l Taskbar and Start Menu -
K - ;

. :
Click here to toggle Classic View

¥ ANFregrams

Figure 10 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel
is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows
(e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however
many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 5, on
page 26. To see all controls it may be necessary to toggle to Classic View on.

. |
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Video Features

This computer features two different (either VIA for Model A or NVIDIA for Models B & C) video options.
You will be provided with an appropriate driver on the Device Drivers & Utilities + User’s Manual CD-ROM.

You can switch display devices, and configure display options, from the Display Settings control panel (in Person-
alization) in Windows Vista.

To access Display Settings in Windows Vista:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click Personalization >
Display Settings).

3. Move the slider to the preferred setting in Resolution: 0 (Figure 11 on page 22).

4. Click the arrow, and scroll to the preferred setting In Colors: Q (Figure 11 on page 22).

5. Click Advanced Settings (button) Q (Figure 11 on page 22) to bring up the Advanced Settings tabs.

For VIA
1. Clicking through the S3 tabs e (Figure 11 on page 22) allows you to make any video adjustments you require.

For NVIDIA

1. Click GeForce 8400M G (tab).
2. Click Start the NVIDIA Control Panel e (Figure 11 on page 22) to access the control panel.
3. The NVIDIA Control Panel can also be accessed by right-clicking the desktop, and then clicking NVIDIA Control Panel.

Video Features - 21
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Figure 11 - Display Settings
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Audio Features

You can configure the audio options on your computer
from the Sound > control panel in Windows, or from the
VIA Audio Deck & icon in the taskbar, or on the desktop
(this will bring up the VIA Audio Deck menu). The
volume may also be adjusted by means of the Fn + F5/
F6 key combination.

Click any of the buttons (e.g. £ @1 ) on the left to ex-
pand the audio menu selections.

Figure 12 - VIA Audio Deck Configuration Menus
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Recording Audio (Models A & B Only)

The [¢) audio record Hot-Key button allows you to record
audio from either the built-in microphone, or from a mi-
crophone connected to the microphone-in jack.

1. Press the [¢] audio record Hot-Key button to begin the
recording process (the record icon ™= j| flash in the
top left of the screen).

2. Pressthe [¢] audio record Hot-Key button again to stop the
recording process (the record icon will disappear in the top
left of the screen).

3. The recorded audio file (in .wav format) will appear in the
Wav folder (Computer > Local Disk (C) > Users > (Your
Login Name) > Wav).

4. Double-click the file to playback the recorded audio.

4

Sound Volume Adjustment

The sound volume level is set using the volume
control within Windows. Click the Volume icon
in the taskbar to check the setting.

Audio Features - 23
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Power Management Features

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 20) allows you to con-
figure power management features for your computer. You can conserve power by means of power plans and con-
figure the options for the power button, sleep button, computer lid (when closed), display and sleep mode from
the left menu. Note that the power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to create
a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration
options.

- - A ———— @@ .
¥ | BEERe ceereeoe pe [
4 « Power Options = |43 [l search ) bk g . - ——
@ Define power buttons and turn on password protection l

Require a passward an wakeup

Select a power plan
Choose what the power

Power plans can help you maximize your computer's performance or
buttons do P B i ity

conserve energy. Make a plan active by selecting it, or choese a plan and

Choose what closing the id customize it by changing its power settings. Tell me mare sbout power plans
does
Plans shown on the battery meter Q Wiek e B poid e [ =
Create a power plan 5 -
@ Balanced Battery life: 900 L |
€ Choose when to tum off the Change plan settings Performance: 999 Q rentprentnesecp uen. TS Shaep.
display ._,—l
. Change when the computer (@) Power saver Battery life: @90000 1
2 Change plan settings Performance: @@
() High performance Battery life: @9
Change plan settings Performance: @essse

Whtr s etrputer mabe fram sleep, asyene £an stcets e dats Becrste the eomgbes a1

[

Note: Sleep is the default power saving state in Windows Vista

Figure 13 - Power Options

.|
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Charging on Model B & C Computers

Note that Model B & C computers under a heavy load (e.g. using applications which
require a lot of video processing), while running on battery power, will take time (3
to 20 minutes before charging begins) to recharge the battery when plugged in to the
AC/DC adapter. This is due to safety considerations which dictate that the battery
should only start to recharge when the computer has reached a safe temperature to do
SO.

Make sure you save your work when the battery LED is blinking orange, and plug in
the AC/DC adapter. The battery LED will change from blinking orange to orange
when the battery starts to charge (3 to 20 minutes before charging begins).

Low Battery
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, other-
wise, the unsaved data
will be lost when the pow-
er is depleted.

Power Management Features - 25
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Driver Installation

The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for the
proper operation of the computer. Insert the CD-ROM
and click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

Install the drivers in the order indicated in Table 5. Af-
ter installing each driver it will become grayed out (if you
need to reinstall any driver, click Unlock).

Manual Driver Installation

Click the Browse CD button in the Drivers Installer ap-
plication and browse to the executable file in the appro-
priate driver folder.

Windows Update

After installing all the drivers make sure you enable
Window Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

26 - Driver Installation

Driver (Windows Vista) Page #
Video (VIA-Model A) page 27
Video (NVIDIA-Models B & C) page 27
Audio page 27
Modem page 27
LAN page 27
Card Reader page 27
TouchPad page 27
Hot-Key page 28
Quick Button Utility page 28
Wireless LAN Module(Optional) page 29
PC Camera Module (Optional) page 30
Fingerprint Reader (Optional) page 34
Bluetooth (Optional)

Note: No driver installation required (see page 36)

USB Advance AP (Model A) page 28

Enable Windows Update (see left)

Table 5 - Driver Installation




Driver Installation Procedure

Video (VIA - Model A)

1. Click Install Drivers.

2. Click 1.Install Video Driver > Yes.
3. Click Next > Next.

4. Click Finish to restart the computer.

Video (NVIDIA - Models B & C)
1. Click Install Drivers.

2. Click 1.Install Video Driver > Yes.
3. Click Next.

4. Click Finish to restart the computer.

Audio

1. Click Install Drivers.

Click 2.Install Audio Driver > Yes.

Click Next.

Click the button to accept the license and click Next.
Click Next > Next > Next.

Click Finish to restart the computer.

ouhkhwd
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Modem

1. Click Install Drivers.

2. Click 3.Install Modem Driver > Yes.

3. Click OK.

4. The modem is ready for dial-up configuration.

LAN

1. Click Install Drivers.

2. Click 4.Install LAN Driver > Yes.

3. Click OK.

4. The network settings can now be configured.

Card Reader

1. Click Install Drivers.

2. Click 5.Install Cardreader Driver > Yes.
3. Click Next > Next.

4. Click Finish to restart the computer.

TouchPad

1. Click Install Drivers.

2. Click 6.Install Touchpad Driver > Yes.

3. Click Next.

4. Click Finish > Restart Now to restart the computer.
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Hot-Key

1. Click Install Drivers.

2. Click 7.Install Hotkey Driver > Yes.

3. Click Next > Install.

4. Click Finish > Finish to restart the computer.

Application Quick Buttons

If you do not have a PC Camera module installed, you
can install the Quick Button driver (QButton) to enable
you to use the hot key buttons to launch applications of
your choice (see “Application Quick Buttons” on
page 15 for details).

You will need to install the Quick Button driver (QBut-
ton) manually as it does not appear in the Drivers Install-
er menu.

1. Insert the Device Drivers & Utilities + User’s Man-
ual CD-ROM and click Browse CD (button).

2. Double-click to open the Option > QButton folders.
3. Double-click the Setup.exe file.
4. Click Next > Finish to restart the computer.

USB Advance AP (Model A)

Install this driver for Model A computers only. This
will help prevent USB 1.1 keyboards and/or mice
ceasing to respond after resuming from the Hibernate
power-saving state.

Click Option Drivers (button).
Click 4.USB Advance AP > Yes.
Click Close to complete the installation.

Make sure you run Windows Update (see “Windows
Update” on page 26) to check for any critical
updates.

H o
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Wireless LAN
A

Power Toggle for the Wireless LAN Module

Enable power to the Wireless LAN module by using the
Fn + F11 key combination. When the Wireless LAN mod-
ule is powered on, the {g) LED will be green and the in-
dicator , _“? will briefly be displayed.

Wireless LAN Driver Installation
Make sure the module is powered on.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Choose the language you prefer and click Next.
Click Next > Install.

Click Finish to complete the installation.

o~ wbdPE

Note: The operating system is the default setting for

Wireless LAN control in Windows Vista.

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1.
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Click the taskbar wireless icon , and then click Connect
to a network (or right-click the icon , and then click
Connect to a network).

In the Show list, click to choose Wireless from the drop-
down menu.

A list of currently available networks will appear.

Click a network, and then click Connect.

If you do not see a network you want to connect to, click
Set up a connection or network (a list of options will
appear allowing manual searching, and creating a new
network).

Move the cursor over the taskbar icon E to see the
connection status.

To disconnect from the wireless network you can click the
taskbar wireless icon E and then select Connect or
disconnect to access the network menu, and click
Disconnect (or right-click the icon [®g, and then click
Disconnect from).

Wireless LAN - 29
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PC Camera

There are 2 camera options available for this computer.
The 1.3M pixel camera module uses the BisonCap ap-
plication to capture video files. The 2.0M pixel camera
module uses the VideoView application to capture video
files.

PC Camera Driver Installation

For the 1.3M Pixel Camera Module:

1. Turn on the module using Fn + F10 (the indicator
. @ will briefly be displayed when the module is
powered on).

2. Click Option Drivers (button).

Click 2.Install Camera Driver > Yes.

4. Choose the language you prefer and click Next >
Next.

5. Click Finish to restart the computer.

6. Run the BisonCap application program from the
BisonCam shortcut on the desktop, or from the
BisonCam item in the Start > Programs/All
Programs menu (if the hardware is turned off use the
Fn + F10 key combination to turn it on again).

w

For the 2.0M Pixel Camera Module:

1. Turn on the module using Fn + F10 (the indicator

. @ will briefly be displayed when the module is
powered on).

Click Option Drivers (button).

Click 2.Install Camera Driver > Yes.

Click Install.

Click to select Yes or No in answer to the power
system question.

Click Finish > Finish to restart the computer

Run the VideoView application program from the
VideoView shortcut on the desktop, or from the
USB2.0 PC Camera item in the Start > Programs/
All Programs menu (if the hardware is turned off
use the Fn + F10 key combination to turn it on
again).

ok~ wn

N o
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Color Scheme Setup

Before running the PC Camera application, make sure the Col-
or Scheme in Windows Vista is set to Windows Aero (Con-
trol Panel > Appearance and Personalization >
Personalization > Windows Color and Appearance).
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PC Camera Hot-Key Buttons

You can use the PC Camera Hot-Key buttons & (]
to run the BisonCap or VideoView program, to take still
pictures and to zoom the camera in and out (Models A &
B only).

Hot-Key Button Function
Activate the BisonCap/VideoView
7% program/Take Still Picture

(See Page 33)
Models A & B Camera Zoom-In

Only (See Page 33)
Models A & B Camera Zoom-Out

Only (See Page 33)

Table 6 - PC Camera Hot-Key Buttons
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PC Camera Audio Setup

If you wish to capture video & audio with your camera,
it is necessary to setup the audio recording options in
Windows.

1. Click Start, and click Control Panel (or point to Settings
and click Control Panel).

2. Click Sound = (Hardware and Sound).

Click Recording (tab).

4. Right-click “Microphone (VIA High Definition Audio)”
(external microphone)/“Front Mic (VIA High Definition
Audio)” (internal microphone) and make sure the item is
not disabled.

5. Double-click Microphone/Front Mic (or select Properties
from the right-click menu).

6. Click Levels (tab), and adjust the Microphone slider to
the level required.

7. Click OK and close the control panels.

8. Run the BisonCap/VideoView program from the Start >
Programs/All Programs > BisonCam/USB2.0 PC
Camera menu.

9. Go to the Devices menu heading and select Front Mic
(VIA High Definition Audio) or Microphone (VIA High
Definition Audio) (it should have a tick alongside it).

10. Go to the Capture menu heading and select Capture
Audio (it should have a tick alongside it).

w
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BisonCap/VideoView

The BisonCap (for 1.3M pixel camera) and VideoView
(for 2.0M pixel camera) applications are video viewers
useful for general purpose video viewing and testing, and
can capture video files to .avi format.

1. Runthe BisonCap/VideoView program from the Start >
Programs/All Programs > BisonCam/USB2.0 PC Cam-
era menu (it is recommended that you Set Capture File
before the capture process - see “Set Capture File”
below).

2. Go to the Capture menu heading (if you wish to capture
audio see “PC Camera Audio Setup” on page 31) and
select Start Capture.

3. Click OK (the file location will be displayed in the pop-up
box) to start capturing the video, and press Esc to stop the
capture (you can view the file using the Windows Media
Player).

Set Capture File

Prior to capturing video files you may select the Set Cap-
ture File... option in the File menu, and set the file name
and location before capture (this will help avoid acciden-
tally overwriting files). Set the name and location then
click Open, then set the “Capture file size:” and click
OK. You can then start the capture process as above.

Eliminating Screen Flicker

If you find that the video screen in the BisonCap/Video-
View program is flickering, you can try to adjust the set-
ting in the Video Capture Filter options.

For BisonCap:
1. Runthe BisonCap program.

2. Goto Options and scroll down to select Video Capture
Filter....

3. Click either 50Hz or 60Hz under Frequency in Property
Page (tab).

For VideoView:

1. Runthe VideoView program.

2. Goto Options and scroll down to select Video Capture
Filter....

3. Click either 50Hz or 60Hz under Flickering Reduction in
Image (tab).
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Taking Still Pictures
The BisonCap and VideoView programs allow you to
take still pictures.

1. Runthe BisonCap/VideoView program.

2. (BisonCap) Go to Options and select Take Picture.
or
(VideoView) Go to Capture and select SnapShot.

3. The picture (in JPEG format) will be placed in the
Snapshot folder -_n;| on the desktop (do not move or
rename the folder).

Zoom

The BisonCap and VideoView programs allow you to
zoom the camera in and out.

For BisonCap:
1. Runthe BisonCap program.
2. Goto Zoom and select Zoom Out/Zoom In.

For VideoView:

1. Run the VideoView program.

2. Goto Options and scroll down to select Setting (use the
slider to adjust the zoom level, and click OK to save the
setting).
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L&
Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot
co-exist.

If you wish to add a PC Camera module to your computer
at a later date, then uninstall the Quick Button Driver (enti-

tled Multimedia Keyboard Driver) before installing the PC
Camera and driver. Drivers can be uninstalled from the Pro-
grams and Features control panel in Windows.

If you wish to remove a PC Camera module from your com-
puter at a later date, then uninstall the PC Camera Driver af-
ter removing the camera module. You can then insert the
Device Drivers & Utilities + User’'s Manual CD-ROM and
install the Quick Button driver (QButton) from the Drivers
Installer menu.
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Fingerprint Reader

If you have included the fingerprint reader in your pur-
chase option (Optional for Model B & C computers
only) you will need to install the driver as per the instruc-
tions below.

Make sure you have administrator’s rights to your com-
puter, and have a Windows password enabled for full se-
curity protection.

Before beginning the enrollment process it is recom-
mended that you go through the fingerprint tutorial. To
run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after in-
stalling the driver.

Fingerprint Reader Driver Installation
Click Option Drivers (button).

Click 3.Install FingerPrint Driver > Yes.

Click Software Installation.

Click Next > Next > Next.

Click Finish > Yes to restart the computer.

agrwbdE
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Help & Manual

Right-click the taskbar icon ¥ to bring up the menu to select
Help.

Insert the Device Drivers & Utilities + User's Manual CD-
ROM and click Option Drivers (button). Click Unlock (but-
ton) and then click 3.Install FingerPrint Driver > Yes.

Click Documentation to open the folder containing the manual
in .pdf format.

To install the Adobe Acrobat Reader software to read the file,
insert the Device Drivers & Utilities + User’s Manual CD-
ROM and click User’s Manual (button), and click Install Ac-
robat Reader (button).

User Enrollment

1. Click Start > Programs/All Programs > Protector Suite
QL > User Enrollment, or double click the taskbar icon

2. On the first run of the program you will be asked to click
the button to accept the license, and then click OK.

3. Click Next and select “Enrollment to the hard disk”, and

click Finish.
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11.
12.

13.
14.
15.

16.
17.

If you have not set a Windows password you will be
prompted to do so (note: If you have not set a password
Protector Suite QL cannot secure access to your
computer).

Click Next and you will then be prompted to enter your
Windows password.

Click Next > Next (if you have the “Run interactive
tutorial” tickbox selected you will run through the
Fingerprint Tutorial).

Click Next for each window of the tutorial (you can click
the button to “skip tutorial” at any time).

Click the button above any of the fingers to begin the
enroliment process for that finger.

Swipe the finger three times to enroll that finger.

Repeat the process for all the fingers you wish to enroll,
and then click Next.

Click Finish.

Click any of the headings under “Learn more about:” to
get more information on any topic.

Click Close.

Restart the computer.

Right-click the taskbar icon E] to bring up the menu that
allows you to Edit Fingerprints, Start Control Center,
access the Help menu etc. You can also run the Control
Center etc. from the Protector Suite QL item in the
Programs/All Programs menu.

See “Help & Manual” on page 34 for further details.

If you swipe your finger over the reader at any time you
can access the Biomenu to lock the computer, register
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websites, open the Control Center and access the Help
menu.

18. The Control Center allows you to change the Settings,
enroll Fingerprints and get Help.
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Fingerprint Enroliment

Note that it is strongly recommended that you enroll
more than one finger in case of injury etc.

Figure 14 - Fingerprint Enrollment
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Bluetooth Configuration in -
Windows Vista e Va

Bluetooth Data

Setup your Bluetooth Device so the Transfer

Computer Can Find it Note that transferring

1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on. CEE) [EREET s Eoi
- puter and a Bluetooth

2. Make the device discoverable (to do this check your S [ o enabled device is sup-

device documentation). | T ported in one direction
Show Blustooth Devices on|y (3imu|taneous

To Turn the Bluetooth Module on i gi‘;ap O‘r;ggffer s not
1. Pressthe Fn + F12 key combination to power on the Blue- || |t o Pernng Aiea Netiik '

tooth module. Open Bluctooth Settings
2. A Bluetooth icon [ will appear in the taskbar (you may | Remove Blustooth lcon

need to enable the option from the Bluetooth control

panel).

3. You can then do any of the following to access the Figure 15 - Bluetooth Devices & Click Icon Menu

Bluetooth Devices control panel.

To Add a Bluetooth Device

» Double-click the icon {3 to access the Bluetooth Devices .
1. Access the Bluetooth Devices control panel.

control panel.
« Click Start, and click Control Panel (or point to Settings ~ 2-  Click Options (tab), and make sure that Allow Bluetooth
and click Control Panel), and then click Bluetooth devices to connect to this computer check box
Devices (Hardware and Sound). (Connections) has a tick inside it.
« Click/Right-click the icon [ and choose an option from 3. Click Devices (tab), and then click Add.
the menu. 4. The Add Bluetooth Device Wizard will appear.

.|
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5. Click to select “My device is set up and ready to be To Ch ange Settings for the Bluetooth
found”, and then click Next. Device
) 5 B D Wt B [0 et == .
Melkome o the A Buctooth e st e o ) 1. Access the Bluetooth Devices control panel.
‘ 2. Click on the device you want to change and click
: . Properties to:
' ¢ Change the name of the device (click General, type a new
. name and click OK).
e ¢ Enable/Disable a service (click Services, tick/clear the
i el o check box next to the service and click OK).
6. The Wizard will then search for any available Bluetooth To Bluetooth Devices
devices within range. 1. Access the Bluetooth Devices control panel.
7. Select the device you want to communicate with, and click 2 click Options, and make sure that Allow Bluetooth
Next. devices to find this computer check box (Discovery)
8. Select an appropriate passkey option and click Next > has a tick inside it.
Finish. 3. Make sure that Alert me when a new Bluetooth device
e - wants to connect check box (Connections) has a tick
9 inside it, if you want to be notified when a Bluetooth device
o wants to connect.
]
: oy Figure 18
i = grue Bluetooth
\ e e [ Devices
Figure 17 - Passkey Option Options
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Troubleshooting

Problem Possible Cause - Solution
The Wireless LAN/Bluetooth The modules are off. Check the LED indicator @ and/or function key indicator to see if the
modules cannot be detected. WLAN/Bluetooth module is on or off (see “LED Indicators” on page 11). If the LED

indicator is off, then press the Fn + F11 (WLAN) or Fn + F12 (Bluetooth) key
combination(s) in order to enable the modules (see Table 3, on page 13).

The Bluetooth module is off | The Bluetooth module’s default state will be off after resuming from the Sleep power-saving
after resuming from Sleep. state. Use the key combination (Fn + F12) to power on the Bluetooth module after the
computer resumes from Sleep.

A file cannot be copied to/from a | Transferring data between the computer and a Bluetooth enabled device is supported in
connected Bluetooth device. one direction only (simultaneous data transfer is not supported). If you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file
from the Bluetooth enabled device to your computer until the file transfer process from the
computer has been completed.

The captured video files from the | Note that capturing high resolution video files requires a substantial amount of disk space
PC Camera are taking up too for each file.

much disk space. ) ) . -
! ISk'sp Note that the Windows Vista system requires a minimum of 15GB of free space on the C:

drive system partition. It is recommended that you save the capture video file to a location
other than the C:drive, limit the file size of the captured video or reduce video resolution
(Options > Video Capture Pin... > Output Size).
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Screen Resolution Error (Models B & C Only)

If you are experiencing either screen resolution reduction, or screen flickering after resuming from Sleep in Win-
dows Vista only then follow the instructions below to fix this problem. This error arises in compliance with Windows
Vista policy, which triggers TMM (Transient Multimon Manager) when the notebook lid (S3) is closed. TMM dis-
connects the LCD display from the OS and then adds the LCD display back when the lid is opened. This may trigger
TMM to restore an old display setting which may result in screen flickering or a screen resolution change.

Go to the Control Panel in the Windows OS and double-click the Administrative Tools icon (System and Maintenance).
Double-click Task Scheduler (Schedule Tasks)

Double-click Task Scheduler Library > Microsoft > Windows, and click MobilePC to open the control panel.

Right-click TMM and select Disable, and then close all the control panels.

»w bR

Figure 19 - Control Panel System and Maintenance
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Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check
with your service center for details.

Feature Specification

Processor Intel® Core™2 Duo Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package 4MB On-die L2 Cache & 800MHz FSB
T7300/ T7500/ T7700/ T7800 2.0/2.2/2.4/ 2.6 GHz
Intel® Core™2 Duo Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FC-PGA Package 2MB On-die L2 Cache & 800MHz FSB
T7100 1.8 GHz
Intel® Celeron® M Processor 65nm (65 Nanometer) Process Technology
(478-pin) Micro-FCPGA Package 1MB On-die L2 Cache & 533MHz FSB
530/ 540/ 550 1.73/1.86/ 2.0 GHz

Core Logic VIA VN896CE + VT8237A

Memory Two 200 Pin SO-DIMM Sockets Supporting 533/667 MHz DDRII (DDR2)
Memory Expandable up to 2GB

.|
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3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible

Feature Specification

Security Security (Kensington® Type) Lock Slot BIOS Password

BIOS One 8Mb SPI Flash ROM Phoenix™ BIOS

LCD Options Models A & B Model C
15.4" WXGA (1280 * 800) TFT LCD 17.0" WXGA (1440 * 900) TFT LCD
15.4" WXGA+ (1440 * 900) TFT LCD 17.1" WSXGA+ (1680 * 1050) TFT LCD

17.1" WUXGA (1920 * 1200) TFT LCD

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page 43 for drive
options)
One Easy Changeable 2.5" 9.5 mm (h) SATA HDD

Audio Intel High Definition Audio Compliant Interface 2 * Built-In Speakers

Built-In Microphone

Video Adapter

Model A

VIA VN896CE Integrated Video System
(Internal On Chip)

Integrated 128bit 2D/3D Graphic Engine
Supports CRT Resolutions up to 2048 * 1536
MS DirectX® 9.0 Compatible

Models B & C

NVIDIA GeForce 8400M G (NB8M-SE) Discrete
Video System (External On Board)
TurboCache™ Total Graphics Memory up to
895MB (with System Memory)

128MB Using On Board DDRIII (DDR3) Memory
Supports Dual Display and Ergonomic Refresh
Rates up to 2048 * 1536

MS DirectX® 10.0 Compatible
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Feature Specification
Keyboard & Winkey Keyboard Built-In TouchPad with Scrolling Function
Pointing Device
Interface Three USB 2.0 Ports One S/PDIF Out Jack
One External Monitor Port One RJ-11 Modem Jack
One Headphone-Out Jack One RJ-45 LAN Jack
One Microphone-In Jack One DC-in Jack

One Line-In Jack

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Note: MS Duo/ Mini SD/ RS MMC Cards require a PC adapter

ExpressCard Slot | One ExpressCard/54(34) Slot

Power Supports ACPI1 2.0

Management

Communication 56K Plug & Play Fax/Modem, V.90/92 Compliant Bluetooth 2.0 + EDR Module (Factory Option)
10Mb/100Mb Ethernet LAN 1.3M or 2.0M Pixel USB PC Camera Module
802.11b/g USB Wireless LAN Module (Option) (Factory Option)

Power Models A & B Model C
Full Range AC/DC Adapter 19V, 3.42A or 18.5V, Full Range AC/DC Adapter 19V, 4.74A (90W), 100-
3.5A (65W), 100-240V, 50-60Hz 240V, 50-60Hz

6 Cell Smart Lithium-lon Battery Pack, 4000mAH (All Models)
or
6 Cell Smart Lithium-lon Battery Pack, 4400mAH (Models B & C)
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Feature Specification
Environmental Temperature Relative Humidity
Spec Operating: 5°C -35°C Operating: 20% — 80%
Non-Operating: -20°C - 60°C Non-Operating: 10% — 90%
Dimensions Models A & B Model C
& Weight
360mm (w) * 267mm (d) * 25.4-34mm (h) 397mm (w) * 280.5mm (d) * 39mm (h)
2.6 kg With 6 Cell Battery 2.98 kg +/- 3% With 6 Cell Battery and Without
Optional Modules
Optional Optical Drive Module Options: Fingerprint Reader Module
DVD/CD-RW Combo Drive Module (Factory Option for Models B & C Only)

DVD-Dual (Super Multi) Drive Module 1.3M or 2.0M Pixel USB PC Camera Module

802.11b/g USB Wireless LAN Module (Factory Option)
Bluetooth 2.0 + EDR Module (Factory Option)
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Ausfihrliches Benutzerhandbuch

Hinwels

Das Unternehmen behélt sich das Recht vor, diese Publikation ohne Vorankiindigung zu tberarbeiten und den Inhalt zu
verandern. Alle enthaltenen Informationen sind nur Anhaltspunkte und stellen keine Verpflichtung seitens des Herstellers
oder Wiederverkéufers dar. Sie Ubernehmen weder Verantwortung oder Haftung fiir mdgliche Fehler oder Ungenauigkei-
ten dieser Publikation noch sind sie in irgendeiner Weise verantwortlich flir Verluste oder Schaden aus der Nutzung (oder
fehlerhaften Nutzung) dieser Publikation.

Die Publikation und alle beiliegende Software darf nicht, ganz oder in Teilen, ohne vorheriges Einverstandnis des Verkau-
fers, Herstellers oder Autors dier Publikation reproduziert, (ibersetzt, iibertragen oder in maschinenlesbare Form umgewan-
delt werden, abgesehen von Kopien, die fiir Archivzwecke erstellt werden.

In dier Publikation erwahnte Marken- und Produktnamen kénnen Copyrights und/oder eingetragene Warenzeichen ihrer
jeweiligen Firmen in. Sie werden nur zu Identifikationszwecken erwahnt und sind nicht als Werbung fir die Produkte oder
ihre Hersteller gedacht.

© November 2007

Warenzeichen

Dies Produkt beinhaltet durch Urheberrechte geschiitzte Technologie, die durch Anspriiche bestimmter US-Patente und an-
dere geistige Eigentumsrechte geschiitzt ist, welche der Macrovision Corporation und anderen Rechtsbesitzern gehort. Die
Verwendung dier durch Urheberrechte geschiitzten Technologie mul3 von der Macrovision Corporation genehmigt werden
und dient nur fir den Heimgebrauch bzw. andere beschrénkte Ansichtszwecke, wenn nicht anderweitig von der Macrovi-
sion Corporation genehmigt. Reverse Engineering oder Auseinandernehmen ist untersagt.

Intel, Celeron, und Intel Core sind warenzeichen/eingetragenes warenzeichen der Intel Corporation.

. |
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Ausfiuhrliches Benutzerhandbuch

Uber das Ausfiihrliche Benutzerhandbuch

Diese Kurzanleitung soll einen Uberblick tiber die Schritte geben, die dazu notwendig sind, das System zu starten. Dieses
ist nur eine Ergédnzung und kein Ersatz fur das erweiterte englischsprachige Benutzerhandbuch, das auf der mitgelieferten
CD-ROM Device Drivers & Utilities + User's Manual im Adobe-Acrobat-Format vorliegt. Diese CD-ROM enthalt auch
die Treiber und Utility-Programme, die flr einen einwandfreien Betrieb des Notebooks notwendig sind.

Einige oder alle Funktionen des Notebooks sind bereits eingerichtet worden. Falls das nicht der Fall ist oder wenn Sie ein-
zelne Teile des Systems neu konfigurieren (oder neu installieren) méchten, finden Sie eine Anleitung im erweiterten Be-
nutzerhandbuch. Die CD-ROM Device Drivers & Utilities + User's Manual enthélt nicht das Betriebssystem.

Informationen zu gesetzlichen Vorschriften
Die Informationen zu gesetzlichen Vorschriften finden Sie im erweiterten Benutzerhandbuch auf der CD-ROM Device
Drivers & Utilities + User's Manual.

SN
P

Betrieb von Wireless-Geraten in Flugzeugen

In der Regel ist die Benutzung jeglicher tragbarer elektronischer Funkgerate in Flugzeugen verboten. Achten
Sie darauf, da die Wireless-Module AUSGESCHALTET sind, wenn Sie das Notebook im Flugzeug be-
nutzen.
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Hinweise zu Pflege und Betrieb
Das Notebook ist zwar sehr stabil, kann aber dennoch beschadigt werden. Damit es nicht dazu kommt, sollten Sie die fol-
genden Hinweise beachten:

» Das Gerat darf nicht herunterfallen und in anderer Form Sté3en ausgesetzt werden. Wenn der Computer fallt, kénnen das
Gehduse und andere Komponenten beschadigt werden.

« Halten Sie den Computer trocken, Das Gerét darf nichtiiberhitzt werden. Computer und Netzteil diirfen nicht in der Néhe von
Waérmequellen stehen oder gelagert werden. Dies ist ein elektrisches Gerét. Wenn Wasser oder andere Flissigkeiten eindringen,
kann der Computer stark beschadigt werden.

« Vermeiden Sie Interferenzen mit anderen Geréaten. Halten Sie den Computer fern von magnetischen Feldern, die von Stromquel-
len, Monitoren, Magneten etc. erzeugt werden. Die kdnnen die Leistung beeintrachtigen und Ihre Daten beschadigen.

» Achten Sie auf die richtige Bedienung des Computers. Schalten Sie ihn erst aus, wenn alle Programme geschlossen wurden
(speichern Sie lhre Daten!). Speichern Sie regelméaRig lhre Daten, da diese verloren gehen kénnen, wenn der Akku verbraucht ist.

 Seien Sie vorsichtig bei der Verwendung von Peripheriegeraten.

yoasinag

Reparatur

Reparieren Sie das Gerat nicht selbst. Damit verstoRen Sie gegen die Garantiebedingungen und Sie kénnen Schaden am
Gerdt und an der eigenen Gesundheit verursachen. Uberlassen Sie alle Reparaturen autorisiertem Fachpersonal. Trennen
Sie das Notebook vom Stromnetz. Unter den folgenden Umsténden sollten Sie das Geréat zur Reparatur geben:

e Wenn das Netzkabel oder der AC/DC-Adapter beschadigt oder zerschlissen sind.

« Wenn der Computer Regen ausgesetzt war oder mit Flissigkeiten in Beriihrung gekommen ist.

« Wenn der Computer unter Beachtung der Bedienungsanweisungen nicht korrekt arbeitet.

* Wenn der Computer heruntergefallen ist oder beschadigt wurde (beriihren Sie nicht die giftige Flussigkeit des LCD-Bildschirms).
* Wenn ein ungewohnlicher Geruch, Hitze oder Rauch aus dem Computer entweicht.

.|
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Stromsicherheit
Fur dieses Computer werden bestimmte Stromanforderungen gestelit:

» Verwenden Sie nur einen AC/DC-Adapter, der fir die Verwendung mit diesem Computer zugelassen ist.

» Der AC/DC-Adapter kann zwar fur internationale Benutzung vorgesehen sein, bendtigt aber trotzdem eine gleichmégige, ununter-
brochene Stromversorgung. Wenn Sie sich Uber lhre lokalen Stromspezifikationen nicht im klaren sind, wenden Sie sich an lhren
Servicevertreter oder lhre lokale Stromgellschaft.

» Der AC/DC-Adapter kann einen zwei- oder dreipoligen geerdeten Netzstecker haben. Der dritte Pol hat eine wichtige Sicherheits-
funktion. Setzen Sie die nicht auBer Kraft. Wenn Sie keinen Zugang zu einer passenden Steckdose haben, lassen Sie von einem qua-
lifizierten Elektriker eine solche einbauen.

» Fassen Sie das Netzkabel am Stecker und nicht am Kabel an, wenn Sie es vom Stromnetz trennen mdchten.

 Achten Sie darauf, daf die Steckdose und alle verwendeten Verldngerungskabel die Gesamtstromlast aller angeschlossenen Geréte trégt.

» Trennen Sie den Computer vor dem Reinigen von allen externen Stromquellen.

2N
I

Warnung zur Stromsicherheit

Bevor Sie Schritte zum Aufristen des Computers unternehmen, missen Sie zunachst das Gerat ausschalten und alle Peripheriegerate
und Kabel (einschlie3lich Telefonkabel) abtrennen. Sie sollten auch den Akku herausnehmen, damit das Gerat nicht versehentlich ein-

geschaltet werden kann.
Vor dem Transport in einer Tasche ausschalten

Achten Sie darauf, dass Ihr Notebook ausgeschaltet ist, wenn Sie es fur den Transport z.B. wahrend einer Reise in eine Tasche einpak-
ken. In einer Tasche kann/konnen die Luftungsoffnung(en) verdeckt werden. Wenn das Gerat dann noch eingeschaltet ist, kann es uber-
hitzt werden. Damit das eingeschaltete Notebook nicht uberhitzt wird, stellen Sie sicher, dass die Luftungsoffnung(en) immer frei sind.

Reinigung
 Tragen Sie Reinigungsmittel nicht direkt auf das Computer auf. Reinigen Sie es mit einem weichen, sauberen Tuch.
» Verwenden Sie keine fliichtigen Reinigungsmittel (Petroleumdestillate) oder Scheuermittel zum Reinigen des Computers.

.|
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Sicherheitshinweise zum Akku

Verwenden Sie nur Akkus, die fiir diesen Computer entwickelt wurden. Ein falscher Akku-Typ kann explodieren, auslaufen oder
den Computer beschadigen.

Verwenden Sie den Akku nicht mehr, wenn er heruntergefallen ist oder in anderer Weise beschéadigt (z.B. verzogen) ist. Auch wenn
das Notebook mit dem beschédigten Akku zu funktionieren schein, kdnnen dadurch Stromkreise beschédigt werden, die schlieflich
einen Brand verursachen kénnen.

Laden Sie die Akkus tber das Notebook auf. Durch falsches Laden kann der Akku explodieren.

Versuchen Sie nicht, Akkus zu reparieren. Lassen Sie die Akkupacks durch den Servicevertreter oder qualifiziertes Fachpersonal
reparieren oder austauschen.

Halten Sie Kinder vom Akku fern und entsorgen Sie beschadigte Akkus sofort. Seien Sie vorsichtig bei der Entsorgung der Akkus.
Akkus kdnnen explodieren oder auslaufen, wenn sie Feuer ausgesetzt sind oder unsachgemag behandelt oder entsorgt werden.
Halten Sie den Akku von Metallgeraten fern.

Bringen Sie Klebeband auf den Akkukontakten an, bevor Sie den Akku entsorgen.

Beriihren Sie die Akkukontakte nicht mit Ihren Handen oder mit metallenen Gegenstanden.

SN
P

Entsorgen der Akkus/Batterien & Achtung

Das von Ihnen gekaufte Produkt enthalt einen aufladbaren Akku. Dier Akku ist wiederverwertbar. Nach verschiedenen nationalen
und regionalen Getzgebungen kann es verboten in, einen nicht mehr gebrauchsféhigen Akku in den normalen Hausmdill zu wer-

fen. Informieren Sie sich bei Ihrem regionalen Entsorgungsunternehmen tiber Recycling-Mdglichkeiten oder korrekte Entsorgung.

Wenn ein falscher Akku eingesetzt wird, besteht Explosionsgefahr. Tauschen Sie den Akku nur durch den gleichen oder einen
baugleichen Typ aus, der vom Hersteller empfohlen wird. Entsorgen Sie den verbrauchten Akku entsprechend der Anweisungen
des Herstellers.

Hinweise zu Pflege und Betrieb - 49
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Schnellstart

/ 1. Entfernen Sie das gesamte Verpackungsmaterial.
Herunterfahren 2. Legen Sie das Notebook auf eine stabile Unterlage.

3. Schlie3en Sie alle Peripheriegeréte, die Sie mit dem Notebook verwenden wollen (z. B. Tastatur und
Maus), an die entsprechenden Schnittstellen an.

4. SchlieRBen Sie den AC/DC-Adapter an die DC-Eingangsbuchse an der Riickseite des Notebooks an.

Bitte beachten Sie, daf’ der
Computer immer mit dem
Befehl Herunterfahren in

g das Menti der Schaltflache Verbinden Sie dann das Netzkabel mit einer Netzsteckdose und dem AC/DC-Adapter.

ﬂ Sperren in Windows Vista 5. Klappen Sie den Deckel/LCD vorsichtig mit einer Hand auf, und 6ffnen Sie ihn auf einen

- heruntergefahren werden angenehmen Sichtwinkel. Mit der anderen Hand halten Sie das Unterteil des Notebooks fest (siehe
(] muf3.  Dadurch  werden Abb. 1 unten) (Hinweis: Heben Sie den Computer niemals am Deckel/LCD hoch).

o Festplatten- bzw. System- 6

- . Driicken Sie auf den Netzschalter, um das Notebook einzuschalten.
probleme vermieden.

Modell C

Beachten Sie, dass die Ge-
rate des Modells C am
Deckel/LCD Riegel haben.
Schieben Sie den linken
Riegel in die Offnen-Stel-
lung, schieben Sie dann
den rechten Riegel (halten
Sie ihn in dieser Stellung),
und heben Sie gleichzeitig
den Deckel an. Abb. 1

Offnen des Deckels/LCD/Notebooks mit angeschlossenem AC/DC-Adapter
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Modellunterschiede
Diese Notebook-Serie umfasst drei verschiedene Modelltypen. Die Modelle unterscheiden sich wie in der Tabelle be-

schrieben.

Modell B Modell C

Funktion Modell A

) VIA VNB96CE Integrated Video NVIDIA GeForce 8400M G (NB8M-SE) Discrete Video System
Videoadapter : O
System (auf dem Chip) (extern onboard) @
. . ) ) . Windows Vista Home Basic Edition (64-bit) E_
Unte\r/si‘.;lt.lg_z\t/eer\ls\/ilgr?ows Wlndogjiti\/c; it?eljl?l;? S BasiC | Windows Vista Home Premium Edition/Business Edition/Enterprise %
Edition/Ultimate Edition (64-bit) %
Option

Nein

Fingerabdruckleser

Zoomtasten & ; :
Audioaufnahmetaste Ja@ siehe Tabelle 4 auf Seite 58

65W (DC-Ausgang 19V, 3,42A oder 18,5V, 3,5A)

Nein

AC/DC-Adapter 90W (DC-Ausgang 19V, 4,74A)

17" WXGA
17,1" WSXGA+
17,1" WUXGA

15,4" WXGA
15,4" WXGA+

LCD-Typ

Tabelle 1 - Modellunterschiede
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Systemsoftware

Mdglicherweise wurde das Notebook bereits mit vorinstal-
lierter Software ausgeliefert. Ist das nicht der Fall, oder
wenn Sie das Notebook fiir ein anderes System neu konfi-
gurieren mdchten, finden Sie dazu eine Anleitung in diesem
Handbuch zum Betriebssystem Microsoft Windows Vista.
Weitere Informationen zur Installation der Treiber und
Hilfsprogramme finden Sie in den Kapiteln 4 und 7 des er-
weiterten Benutzerhandbuchs auf der CD-ROM Device
Drivers & Utilities + User's Manual.

4

Treiber

Wenn Sie eine neue Systemsoftware installieren oder erneut in-
stallieren, mussen Sie die geeigneten Treiber installieren. Trei-
ber sind Programme, die als Schnittstelle zwischen dem
Computer und einer Hardware-Komponente, z.B. einem Wire-
less-Netzwerkmodul, dienen. Es ist sehr wichtig, dass Sie die
Treiber in der in Tabelle 5 auf Seite 70 angegebenen Reihen-
folge installieren. Sie k6nnen die meisten erweiterten Einstel-
lungen nicht benutzen, bevor nicht die notwendigen Treiber und
Hilfsprogramme sachgemaR installiert sind.

Unterstltzte Betriebssysteme

Betriebssystem

Modell A

Modelle B & C

Anmerkung

*Windows XP (Home Edition oder

Professional)

Windows Vista (64-bit) Home Basic

Edition

Windows Vista
(64-bit)
Home Premium Edi-
tion/Business Edition/
Enterprise Edition/

Windows Vista kann
nur dann mit voller Lei-
stung laufen, wenn der

Computer Uber einen

Systemspeicher
(RAM) von minde-
stens 1GB verfuigt.

Ultimate Edition

*Informationen zum Betriebssystem Windows XP finden
Sie auf der CD-ROM Device Drivers & Utilities + User’s
Manual.

Nicht enthalten

Zu den Betriebssystemen (z.B. Windows Vista/Windows
XP) und zu den Programmen (z.B. Textverarbeitung, Kal-
kulationsprogramme und Datenbanken) gibt es eigene
Handblicher, in denen Sie entsprechende Informationen fin-
den.
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Systemubersicht: Ansicht von oben mit gedff-
netem LCD-Bildschirm (Modelle A & B)

\ A/
26
Die Benutzung drahtlos

angeschlossener Geréte in
Flugzeugen

In der Regel ist die Benutzung
jeglicher tragbarer elektroni-
scher Funkgerate in Flugzeu-
gen verboten. Achten Sie
darauf, dal? die Module AUS-
GESCHALTET sind, wenn Sie
das Notebook im Flugzeug
benutzen.

Drucken Sie die entsprechen-
den Tastenkombinationen (sie-
he ), um
das WLAN- und das Bluetooth-

Modul ein- und auszuschalten.
Prifen Sie die Statusanzeige
(%), um festzustellen, ob die
Module ein- oder ausgeschaltet
sind (siehe

).

Abb. 2 - Ansicht von oben mit ge6éffnetem LCD-Bildschirm (Modelle A & B)

.|
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Optionale PC-Kamera
LCD-Bildschirm
Lautsprecher
Netzschalter
Hot-Key-Tasten
Tastatur

TouchPad mit Tasten
Mikrofon
LED-Anzeigen
Fingerabdruckleser
(optional nur fur Modell
B)
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Ausfiuhrliches Benutzerhandbuch

Systemubersicht: Ansicht von oben mit gedff-

L. optionale PC-kamera netem LCD-Bildschirm (Modell C)
2. LCD-Bildschirm
3. Lautsprecher W
4. Netzschalter 7£l<
- 5. Hot-Key-Tasten Die Benutzung drahtlos
(&) 6. Tastatur angeschlossener Geréte in
i) 7. TouchPad mit Tasten Flugzeugen
8 8. Mikrofon In der Regel ist die Benutzung
Q 9. LED-Anzeigen jeglicher tragbarer elektroni-
10. Fingerabdruckleser scher Funkgerate in Flugzeg-
(Option) gen verboten. Achten Sie

darauf, daf3 die Module AUS-
GESCHALTET sind, wenn Sie
das Notebook im Flugzeug
benutzen.

Driicken Sie die entsprechen-
den Tastenkombinationen (sie-
he ), um
das WLAN- und das Bluetooth-

Modul ein- und auszuschalten.
Prifen Sie die Statusanzeige
BQ). um festzustellen, ob die
Module ein- oder ausgeschaltet
sind (siehe

).

Abb. 3 - Ansicht von oben mit gedffnetem LCD-Bildschirm (Modell C)
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LED-Anzeigen

Die LED-Anzeigen auf dem Computer zeigen wichtige Informationen (iber den aktuellen Status des Computers.

Tabelle 2 - LED-Anzeigen

Symbol Farbe Beschreibung
O
IEI Grin Die Funktion NumLk (Nummerntastatur) ist aktiviert g
purl
n
Griin Caps-Lock ist aktiviert %
Eﬁ' Griin Scroll-Lock ist aktiviert
Grin Der Computer ist angeschaltet
D/Q) Lampe blinkt griin Das System ist im konfigurierten Energiesparmodus
Orange Der AC/DC-Adapter ist angeschlossen und der Computer ist ausgeschaltet
Orange Der AC/DC-Adapter ist angeschlossen und der Akku wird geladen
m Lampe blinkt Orange Der Akku hat einen kritisch niedrigen Stromstatus erreicht
Grin Der Akku ist voll geladen
% Grin Es wird auf die Festplatte zugegriffen
(((i))) Griin Das/Die Wireless-LAN- oder/und Bluetooth-Modul/Module ist/sind eingeschaltet
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Tastatur

Die Tastatur hat eine eingebettete Nummerntastatur fiir ein-
fache Zahleneingabe. Mit der Fn-Taste kénnen Sie auf Ta-
stendruck einige Betriebsfunktionen des Computers
andern. Beachten Sie, dass das Notebook-Modell C am
rechten Rand der Haupttastatur eine Nummerntastatur hat.

Abb. 4 - Tastatur

T T e T o e

EREMCNE Funktionstasten [l peibviite=cilc
1 : 5

5 i . Bl Nummemtastatur [

s 17 7 1™ 7 [V e Jm NumLk & ScrLk Tasten
Rl Fn Taste gl | ] ]
-— ) —
Modelle A & B

B Funktionstasten [EEECEREEE

1 2 : 3 i :‘ Ll T ol qlle 01 A\ " *
- ] w E R T F u (=}
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Sonderzeichen

Bei einigen Programmen kdnnen die Nummern-Tasten zur
Erzeugung von Sonderzeichen zusammen mit der Taste Alt
gedriickt werden. Diese Sonderzeichen kdnnen nur mit der
Nummerntastatur erzeugt werden. Die normalen Zahlenta-
sten (in der oberen Tastenreihe der Tastatur) kénnen dazu
nicht verwendet werden. Die Funktion NumLk muR aktiviert
sein.

Andere Tastaturen

Wenn |hre Tastatur beschadigt ist oder Sie aus anderen
Griinden eine andere benutzen mochten, kdnnen Sie hierzu
jede Standard-USB-Tastatur verwenden. Sie wird automa-
tisch vom System erkannt und aktiviert. Es ist jedoch mdg-
lich, dalR Sonderfunktionen/Hotkeys, die speziell auf die
Standard-Tastatur des Computers zugeschnitten sind, bei
anderen Tastaturen nicht funktionieren.




Funktionstasten und visuelle Anzeigen

Ausfihrliches Benutzerhandbuch

Wenn die Funktionstasten (F1 - F12) gleichzeitig mit der Fn-Taste gedriickt werden, funktionieren sie wie Hotkeys. Ne-
ben den Tastenkombinationen fir die Grundfunktionen gibt es visuelle Anzeigen, wenn der Treiber fiir die Hotkeys (Hot-
Key Driver) installiert ist (siehe Seite 72). Wenn der Treiber installiert ist, erscheint in der Taskleiste das Symbol [&.

Tasten Funktion Tasten Funktion
Fn + ~ Wiedergabe/Pause (in Audio /Videoprogrammen) | Fn + F8/F9 LC_D-He”ng(?‘It ver IEE £
ringern/erhéhen PN, N
TouchPad aktivieren/ — i PC-Kamera aktivie-
Fn+Fl deaktivieren * @ Fn+F10 ren/deaktivieren B res "& e _jsj
LCD-Hintergrundlicht ausschalten . .
Fn + F2 (zum Einschalten beliebige Taste driicken oder Fn + F11 \\//;g:iﬁzzzlgi’:l/i:ﬁ; (@D) 9
TouchPad bertihren) © msoon | faseen |
Stummschaltung/ -
Fn+F3 | Stummschaltung auf- I Fn+F12 Bluetooth aktivieren/ 9 | .
heben Valume *  On  Valume © Mute deaktlweren £ torm - @ Peoa |
Fn+F4 Wechsel Schlaf/Wiederaufnahme anoﬁ;::'k/ Ein-/Ausschalten des Scroll-Modus
Fn + F5/ | Audio-Lautstarke ver- Fn + Ein-/Ausschalten des NumLk (Nummerntastatur)
F6 ringern/erhéhen Sateiashiataiats NumLk (Modelle A & B)
Fn+ E7 Wechseln der Anzeigegerate Num Ein-/Ausschalten d?,a;\ldu;]Lé()(Nummerntastatur)

Tabelle 3 - Funktionstasten & visuelle Anzeigen

Tastatur - 57

O
@
c
=
&)
9
>
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Hot-Key-Tasten

Mit den Hot-Key-Tasten haben Sie einen direkten Zugriff auf den Standard-Internetbrowser MW und das E-Mail-Programm
. Wenn ein PC-Kameramodul installiert ist, dienen die Hot-Key-Tasten fiir die PC-Kamera (& (&) zum Starten des
Kameraprogramms, zum Aufnehmen von Fotos und zum VergroRern/Verkleinern der Aufnahmen. Wenn kein PC-Kame-
ramodul installiert ist, kénnen Sie den Direkttasten-Treiber (QButton) installieren, sodass Sie die Hot-Key-Tasten so
festlegen konnen, dass von lhnen festgelegte Programme damit gestartet werden kénnen (Detailinformationen finden Sie un-

e
8 ter “Anwendungs-Direkttasten” auf Seite 59). Beachten Sie, dass das Notebook-Modell C die Hotkey-Tastenfunktionen
= fur Audioaufnahme und Kamera-Zoom nicht unterstitzt.
8 Tabelle 4 - Hot-Key-Tasten
Hot-Key-Taste Funktion
w Einen Standard-Internet browser aktivieren
“' Das Standard-E-Mail-Programm aktivieren
Das BisonCap/VideoView-Programm aktivieren/Fotos aufnehmen (siehe
PC-Kamera angeschlossen .
(.R Seite 77)
Keine PC-Kamera angeschlossen Anwendungs-Direkttaste 1 aktivieren (siehe Seite 59)
Modelle PC-Kamera angeschlossen Kamera vergréRern (siehe Seite 77)
A&B Keine PC-Kamera angeschlossen Anwendungs-Direkttaste 2 aktivieren (siehe Seite 59)
Modelle PC-Kamera angeschlossen Kamera verkleinern (siehe Seite 77)
A&B Keine PC-Kamera angeschlossen Anwendungs-Direkttaste 3 aktivieren (siehe Seite 59)
E] Xl?gcdglle Audioaufnahme starten/stoppen (siehe Seite 67)

58 - Hot-Key-Tasten



Anwendungs-Direkttasten

Beachten Sie, dass mit dem Direkttasten-Treiber (QButton)
die Hot-Key-Tasten &@@ als Anwendungs-Direkttasten
nur dann verwendet werden kénnen, wenn die optionale
PC-Kamera nicht angeschlossen und installiert ist (der
Treiber kann nur dann installiert werden, wenn die PC-
Kamera nicht installiert ist). Um die Tastenfunktionen zu
aktivieren, muss der Direkttasten-Treiber (QButton) instal-
liert werden (siehe “Anwendungs-Direkttasten” auf
Seite 72).

Mit den Direkttasten haben Sie mit nur einem Tastendruck
direkten Zugriff auf benutzerdefinierte Anwendungen. Um
eine Taste so zu konfigurieren, dass ein bestimmtes Pro-
gramm beim Drucken dieser Taste &[@ @ gedffnet wird
(siehe Tabelle 4 auf Seite 58), mussen Sie die folgenden
Anweisungen ausfuhren. Solange das Programm l&uft,
funktionieren auch die Direkttasten (das Symbol & wird in
der Taskleiste angezeigt). Wenn das Programm nicht lauft,
muss der Computer neu gestartet werden.

1. Dricken Sie auf eine Anwendungs-Direkttaste &[] l_l oder
klicken Sie mit der rechten Maustaste auf das Symbol 4 i
der Taskleiste.

2. Wahlen Sie Setup aus dem Men, scrollen Sie zu AP1/2/3
(oder beim Notebook-Modell C nur Applicationl) und
wahlen Sie Benutzerdefiniert.

Ausfihrliches Benutzerhandbuch

Ein Dialogfeld Offnen erscheint auf dem Bildschirm.
Wechseln Sie zum Verzeichnis, in dem sich das gewiinschte
.exe-Datei des Programms befindet (siehe unten).

Klicken Sie doppelt auf die Programmdatei oder wéahlen Sie
Offnen.

B 2 Cttnen
» = e
» etul - y

hliessen -

Modell C

Application.exe

Sie mussen die eigentliche ausfiihrbare (.exe) Programmda-
tei angeben, nicht nur die Verkniipfung. Um das Programm
zu finden, klicken Sie mit der rechten Maustaste auf die Ver-
knupfung auf dem Desktop und klicken auf Eigenschaften.
Klicken Sie auf Verkniipfung (Registerkarte) und suchen
das Verzeichnis, in dem sich die ausfiihrbare Datei befindet,
indem Sie auf Dateipfad 6ffnen (Schaltflache) klicken.

Abb. 5 - Konfigurationsfenster fur die An-
wendungs-Direkttasten

Hot-Key-Tasten - 59
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- Systemubersicht: Ansicht von vorne und Ruck-
-Anzeigen
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vorderseite 1
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Modell C

Abb. 6 - Ansicht von vorne und Rickansicht
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Systemubersicht: Ansicht von links

1. SicherheitsschloR3-
Buchse
Modelle A & B 2. Schacht fiir optisches
Laufwerk (fir CD/DVD-
Geréte)
3. Notauswurfloch
4. RJ-11-Telefonbuchse
5. S/PDIF-Ausgangs-
buchse
6. Mikrofon-Eingangs-
buchse
7. Kopfhérer-Ausgangs-
buchse
8. Line-Eingangsbuchse
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CD/DVD-Notauswurf

Wenn eine CD/DVD manuell entnommen werden muf (z.B. wegen eines Stromausfalls) kénnen Sie
mit dem Ende einer geradegebogenen Buroklammer in das Notauswurfloch driicken. Verwenden Sie
hierzu aber keinen spitzen Bleistift oder &hnliche Objekte, die im Loch abbrechen und darin stekken-
bleiben kdénnten.

Abb. 7 - Ansicht von links

.|
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Systemubersicht: Ansicht von rechts
1. ExpressCard/54(34)-

Steckplatz Modelle A & B
7-in-1 Kartenleser

2 USB 2.0 Anschliisse
RJ-45 LAN-Buchse
Schnittstelle fiir exter-
nen Monitor

arOD
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ExpressCard-Steckplatz

Der ExpressCard-Steckplatz kann sowohl fiir ExpressCard/34 als auch ExpressCard/54 verwendet
werden.

7-in-1 Kartenleser

Mit dem Kartenleser kdnnen einige der neuesten digitalen Speicherkarten gelesen werden.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /
MS Pro (Memory Stick Pro) / MS Duo (PC adapter erforderlich) /
Mini SD (PC adapter erforderlich) / RS MMC (PC adapter erforderlich)

Abb. 8 - Ansicht von rechts

.|
62 - Systemtubersicht: Ansicht von rechts
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Systemibersicht: Ansicht von unten Ll
. Luftungsoffnung

2. Akku

3. Abdeckung des Fest-
plattenschachts

4. Abdeckung des CPU/

Modelle A & B Modell C RAM-Schachts

)
D
1 =
(0)]
(@)
o

L
2N

Garantie

Die CPU darf nicht vom
Anwender repariert wer-
den. Jeglicher Zugriff auf
die CPU fuhrt zum Verlust
der Garantieanspriiche.

Hinweis zum Akku

Uberhitzung

Ein neuer Akku sollte bei seiner ersten Verwendung zuerst einmal vollstandig entladen und dann kom-
plett wieder geladen werden. Entladen und laden Sie den Akku mindestens einmal im Monat oder nach

etwa 20 Teilentladungen einmal vollstandig.

Zum Schutz vor Uberhit-
zung lhres Computers
dirfen die Luftungsoff-
nung(en) nicht wahrend
das Notebook in Betrieb
ist verdeckt werden.

Abb. 9 - Ansicht von unten

Systemubersicht: Ansicht von unten - 63
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Windows Vista Startmenl und Systemsteuerung

Die meisten Einstellfenster, Utilitys und Programme erreichen Sie in Windows Vista (und bei den meisten anderen Ver-
sionen von Windows) tiber das Start-Menii. Wenn Sie Programme und Utilitys installieren, werden diese auf der Festplatte
installiert. Eine Verknipfung davon wird in das Start-Men( und/oder auf dem Desktop erstellt. Klicken Sie mit der rechten
Maustaste auf das Startmenti-Symbol 4, und wahlen Sie die Option Eigenschaften, um das Erscheinungsbild des Start-
mens zu &ndern.

Offnen {@ et e . e =
Explorer .-"-'[ Windows Update \5 = .‘.‘3 —
Suchen... s
Eigenschaften {f@ Progiamme e v
- Dokumente . - By -
Offnen - Alle Benutzer ~y umen ~
Systemsteuerus e
Explorer - Alle Benutzer E’ Einstellungen H st L t_' o “ 2
— e - & Netrwerkverbindungen C -
. i |8 Drucker ta \ich
Windews Mede Player o
a > |l Teskleiste und Startmend - @
» . )
" 3 e 7] Weer
9 [T\
=
H [ D Herunterfahren... N
i pam

Klicken Sie hier, um in die Klassi-
sche Ansicht zu wechseln

Abb. 10 - Startmeni und Systemsteuerung

In diesem Benutzerhandbuch finden Sie wiederholt die Aufforderung, die Systemsteuerung zu 6ffnen. Zur Systemsteue-
rung gelangen Sie (iber das Start-Mend. In der Systemsteuerung kénnen Sie die Einstellungen fiir die meisten wichtigen
Windows-Funktionen (z.B. Strom, Video, Netzwerk, Audio) vornehmen. Windows Vista bietet fiir viele dieser Funktionen
Einstellfenster, wobei viele neue Fenster bereits hinzugefligt werden (oder die bestehenden verbessert werden), wenn Sie
die in Tabelle 5 auf Seite 70 aufgefiihrten Treiber installieren. Es kann sinnvoll sein, die klassische Ansicht des Startmends
einzustellen.

.|
64 - Windows Vista Startmenl und Systemsteuerung
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Grafikfunktionen

Dieses Notebook verflgt je nach Modell iiber zwei verschiedene Videooptionen (V1A bei Modell A und NVIDIA bei Mo-
dellen B & C). Auf der CD-ROM Device Drivers & Utilities + User's Manual befindet sich der jeweils dazugehdrige
Treiber.

Wenn der Grafiktreiber installiert ist, kdnnen Sie bei Windows Vista im Einstellfenster Anzeigeeinstellungen die Anzei-
gegeréte wechseln und Anzeigeoptionen konfigurieren.

So 6ffnen Sie in Windows Vista das Dialogfeld Anzeigeeinstellungen:

Yosinaq

1. Klicken Sie Start (Meni) und klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung).
2. Klicken Sie im Menii Darstellung und Anpassung auf Bildschirmaufldsung anpassen (oder doppelklicken Sie auf Anpassung >
Anzeige).
3. Verschieben Sie den Regler auf die gewiinschte Einstellung fur die Auflosung 0 (siehe Abb. 11 auf Seite 66).
. Klicken Sie auf den Pfeil, und wahlen Sie die gewilinschte Einstellung fiir die Farbtiefe 9 (siehe Abb. 11 auf Seite 66).
5. Klicken Sie auf Erweiterte Einstellungen (Schaltflache) e (siehe Abb. 11 auf Seite 66) um das Einstellfenster Erweiterte
Eigenschaften aufzurufen.

Far VIA
1. Klicken Sie auf die verschiedenen S3-Registerkarten e (siehe Abb. 11 auf Seite 66), um die erforderlichen Einstellungen vorzu-
nehmen.

Fir NVIDIA
1. Klicken Sie auf GeForce 8400M G (Registerkarte).
2. Klicken Sie auf NVIDIA Systemsteuerung starten e (siehe Abb. 11 auf Seite 66), um das Einstellfenster aufzurufen.

3. Sie kdénnen die NVIDIA Systemsteuerung auch aufrufen, indem Sie mit der rechten Maustaste auf den Desktop klicken und in dem
Menu NVIDIA Systemsteuerung wéahlen.

Grafikfunktionen - 65
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Audiofunktionen

Die Audioeinstellungen koénnen Sie bei Windows durch
Anklicken des Soundsymbols » oder des VIA Audio
Deck-Symbols i in der Taskleiste bzw. auf dem Desktop
aufrufen (dadurch wird das VIA Audio Deck-Meni ge-
offnet). Die Lautstdrke kdnnen Sie durch Driikken der Ta-
stenkombination Fn + F5/F6 &ndern.

Klicken Sie links auf eine der Tasten (z. B. @) _)), um die
Optionen des Audiomendis zu erweitern.

Abb. 12 - VIA Audio Deck-Konfigurationmenis

Ausfuhrliches Benutzerhandbuch

Audioaufnahmen (Modelle A & B)

Mit der Hot-Key-Taste fiir die Audioaufnahme [¢] kdnnen
Sie Ton entweder (iber das eingebaute Mikrofon oder (ber
ein an den Mikrofonanschluss angeschlossenes Mikrofon
aufnehmen.

1.

Driicken Sie auf die Hot-Key-Taste fiir die Audioaufnahme [e],
um die Aufnahme zu starten (oben links im Bildschirm blinkt
das Aufnahmesymbo| M==tl)

Drucken Sie ein zweites Mal auf die Hot-Key-Taste fiir die
Audioaufnahme [#], um die Aufnahme zu beenden (oben links
im Bildschirm wird das Aufnahmesymbol nicht mehr
angezeigt).

Die aufgenommene Audiodatei (im Format .wav) erscheint im
Ordner Wav (Computer > Lokaler Datentrager (C:) >
Benutzer > (Ilhr Loginnamen) > Wav).

Klicken sie doppelt auf die Datei, um die Audiowiedergabe zu
starten.

4

Lautstarkeeinstellung

Die Lautstarke wird mit den Windows-Lautstar-

kereglern (oder den Lautstarkereglern am Note-
book) eingestellt. Uberpriifen Sie die Einstellung,
indem Sie in der Taskleiste auf das Lautstéarke-
Symbol klicken.

Audiofunktionen - 67
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Energieverwaltungsfunktionen

Die Energieoptionen von Windows (siehe Seite 64) ermdglichen Ihnen die Konfiguration der Optionen fiir das Energiema-
nagement des Computers. Sie kdnnen Strom sparen, indem Sie Energiesparplane erstellen, die Netzschalter-, Energie-
spartasten- und Zuklappeinstellung (beim SchlieRen des Deckels) konfigurieren und im linken Meni den Anzeige- und
Energiesparmodus festlegen. Beachten Sie, dass sich die Energiesparpléne (Energiesparmodus) auf die Computerlei-
stung auswirken.

Wahlen Sie einen bestehenden Plan aus, oder klicken Sie im linken Menii auf Energiesparplan erstellen, und wéhlen Sie

die Optionen, um einen neuen Plan zu erstellen. Klicken Sie auf Energieplaneinstellungen andern, und klicken Sie auf
Erweiterte Energieeinstellungen andern, um weitere Optionen fir die Konfiguration aufzurufen.

@+ Systemsteuerung » Energieopticnen [ g [ sucher B K3\ ) 7@ = toegesptionen + Sysiemencieiungen +[4

s Netzschalters definieren und Kennwortschutz einschalten

Aihlen Sie einen HIUngDMp an aus
M
Abtwsieren Sie eeen Plan, -\!!l'\s-( m m.nle
Jodem e i Er rgeeeinsbeliangen Bndem. Yeq,

n e DnizeBungen, de Se ol

nstedungen 1t S6n Computer sus. Dot Arer

o, i breen eige angessiic Energiesparplin
Scheden des Liptopdeckeh,
geachehen 2ci

Abuusian 999
Lentung: oe:

Enmgiesparplan eritifon

0 Zespunt 10a das Mamschation
A' Ragichuma surwihlen

L Enegepamedin andern Hochuleistung Abkusustand: o9

s umnn ------

Kennwertengebe bel Reaktvierang

Der Computes ot geiperd. Winn der Computer sus dem Energresparmedin reabimied werd, kann
okl i i g o mmm ok ¢ Rerwet Epegeen wiste

Bar Compuber st nicht gepae, Wann dar Computer sus dem Inergiesgsmodis maktiviert wind,
Rann jocker sl e Diten sugraden.

Hinweis: Bei Windows Vista ist die Standardeinstellung Energie sparen

Abb. 13 - Energieoptionen

.|
68 - Energieverwaltungsfunktionen



Ausfuhrliches Benutzerhandbuch

Hinweise zum Akku

Zur optimalen Nutzung lhres Akkus befolgen Sie bitte diese einfachen Anweisungen. ﬁ
. Warnung zu niedrigem
Laden des Akkus bei Computer-Modellen B und C Akkuladestand

Beachten Sie, dass es bei den Computermodellen B und C im Akkubetrieb und bei hoher Be- B e oGl etk o
lastung (z. B. Anwendungen mit einem hohen Anteil an Videoverarbeitung) eine gewisse B ANEEEEIREEEEIE

Zeitlang dauert, bis das Aufladen des Akkus beginnt, wenn sie an den Netzadapter angesteckt :gpt Sieﬂg:rs N°;Zﬁ°°k:g:

werden (3 bis 20 Mln_uten_). Aus Slcherheltsgrun_den startet der Ladevorgang namlich erst, N T
wenn der Computer eine sichere Temperatur erreicht hat. Stromnetz verbinden: Ist
das nicht mdglich, sollten

Speichern Sie lhre Arbeit, wenn die Akku-LED orange blinkt und stecken Sie den Netzad- [ s SeiS WEaiileis
chern, da die ungespei-

apter an. Die Akku-LED wechselt von orange blinken zu orange, wenn das Laden des Akkus ~BESERESSIEESrEaas

beginnt (3 bis 20 vor dem eigentlichen Ladevorgang). bei einer Unterbrechung
der Stromversorgung verlo-
ren gehen kénnen.
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Installation der Treiber

Die CD-ROM "Device Drivers & Utilities + User's Manu-
al" enthélt die Treiber und Hilfsprogramme, die fiir das ein-
wandfreie Funktionieren des Notebooks notwendig sind.
Legen Sie die mitgelieferte CD-ROM und klicken Sie auf
Install Drivers (Schaltflache), oder klicken Sie auf Option
Drivers (Schaltflache), um das optionale Treibermeni auf-
zurufen.

Installieren Sie die Treiber in der in Tabelle 5 angegebenen
Reihenfolge. Nachdem ein Treiber installiert wurde, wird er
grau dargestellt (wenn einer dieser Treiber ein weiteres Mal
installiert werden soll, klicken Sie auf die Schaltflache Un-
lock).

Manuelle Treiber-Installation

Klicken Sie in der Anwendung Drivers Installer auf die
Schaltflache Browse CD (CD durchsuchen) und navigieren
Sie zu der ausfiihrbaren Datei in dem Ordner fiir Ihren Trei-
ber.

Windows Update

Nachdem Sie alle Treiber installiert haben, sollten Sie die
Funktion Windows Update aktualisieren, um immer die
neuesten Sicherheits-Updates usw. zu erhalten (die Updates
enthalten die neuesten Fehlerbehebungen von Microsoft).

70 - Installation der Treiber

Treiber (Windows Vista) Seite #
Video (VIA-Modell A) Seite 71
Video (NVIDIA-Modelle B & C) Seite 71
Audio Seite 71
Modem Seite 71
Network (LAN) Seite 71
Kartenleser Seite 71
TouchPad Seite 71
Hot-Key Seite 72
Anwendungs-Direkttasten Seite 72
Wireless-LAN (Option) Seite 73
PC-Kamera (Option) Seite 74
Fingerabdruckleser (Option) Seite 78

Bluetooth-Modul (Option)

Hinweis: Ein Treiber muss nicht installiert werden (siehe

Seite 80)

USB Advance AP (Modell A)

Seite 72

Windows Update aktivieren (siehe links)

Tabelle 5 - Installationsvorgang




Installationsverfahren fir den Treiber

Video (VIA - Modell A)

1. Klicken Sie auf Install Drivers.

2. Klicken Sie auf 1.Install Video Driver > Ja.
3. Klicken Sie auf Weiter > Weiter.

4. Klicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Video (NVIDIA - Modelle B & C)

1. Klicken Sie auf Install Drivers.

2. Klicken Sie auf 1.Install Video Driver > Ja.
3. Klicken Sie auf Weiter.
4

. Klicken Sie auf Fertig stellen, um das Notebook neu zu
starten.

Audio

1. Klicken Sie auf Install Drivers.

2. Klicken Sie auf 2.Install Audio Driver > Ja.

3. Klicken Sie auf Weiter.

4. Klicken Sie auf die Schaltflache Ich stimme zu, und dann

auf Weiter.

Klicken Sie auf Weiter > Weiter > Weiter.

6. Klicken Sie auf Fertigstellen, um das Notebook neu zu
starten.

o
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Modem

b e

LAN g
1. Klicken Sie auf Install Drivers. c
2. Kilicken Sie auf 4.Install LAN Driver > Ja. 7
3. Kilicken Sie auf OK. %
4. Nun konnen die Netzwerkeinstellungen konfiguriert

Klicken Sie auf Install Drivers.

Klicken Sie auf 3.Install Modem Driver > Ja.
Klicken Sie auf OK.

Ihr Modem ist nun bereit zur Konfiguration.

werden.

Kartenleser

1.
2. Klicken Sie auf 5.Install Cardreader Driver > Ja.

3.

4. Klicken Sie auf Fertig stellen, um das Notebook neu zu

Klicken Sie auf Install Drivers.

Klicken Sie auf Weiter > Weiter.

starten.

TouchPad

1.

o

Klicken Sie auf Install Drivers.
Klicken Sie auf 6.Install Touchpad Driver > Ja.
Klicken Sie auf Weiter.

Klicken Sie auf Fertig stellen > Jetzt neu starten, um das
Notebook neu zu starten.

Installation der Treiber - 71



L=
(&)
(%)
4+
>
)
O

Ausfihrliches Benutzerhandbuch

Hot-Key

1. Klicken Sie auf Install Drivers.

2. Kilicken Sie auf 7.Install Hotkey Driver > Ja.

3. Kilicken Sie auf Next > Install.

4, Klicken Sie auf Finish > Finish, um das Notebook neu zu
starten.

Anwendungs-Direkttasten

Wenn kein PC-Kameramodul installiert ist, kdnnen Sie
den Direkttasten-Treiber installieren, sodass Sie die Hot-
Key-Tasten so festlegen kdnnen, dass von lIhnen festgelegte
Programme damit gestartet werden kénnen (Detailinforma-
tionen finden Sie unter “Anwendungs-Direkttasten” auf
Seite 59).

Der Direkttasten-Treiber (QButton) muss manuell instal-
liert werden, da er nicht im Drivers Installer-Meni er-
scheint.

1. Legen Sie die CD-ROM Device Drivers & Utilities +
User’s Manual in das CD/DVD-Laufwerk und klicken auf
Browse CD (Schaltflache).

2. Kilicken Sie doppelt auf die Ordner Option > QButton.

Klicken Sie doppelt auf Setup.exe.

4. Klicken Sie auf Weiter > Fertigstellen, um das Notebook
neu zu starten.

w

USB Advance AP (Modell A)

Installieren Sie diesen Treiber nur beim Notebook-Modell
A. Dadurch wird vermieden, dass USB 1.1-Tastaturen
und/oder -Mause nach dem Aufwecken aus dem Ruhezu-
stand nicht mehr reagieren.

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 4.USB Advance AP > Ja.

Klicken Sie auf Close, um die Installation abzuschlieRen.
Sehen Sie regelméaRig bei Windows Update (siehe
“Windows Update” auf Seite 70) nach, ob wichtige
Aktualisierungen vorhanden sind.

N .
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Wireless LAN
A

Ein- und Ausschalten des Wireless-LAN-Moduls

Das Wireless-LAN-Modul wird durch Driicken der Tastenkom-
bination (Fn + F11) eingeschaltet. Wenn das Wireless-LAN-
Modul eingeschaltet ist, leuchtet die LED (ﬂ;ﬂ) grin und er-
scheint kurz die Anzeige = @

Installieren des Wireless-LAN-Treibers
Schalten Sie das Modul ein.

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 1.Install WLAN Driver > Ja.

Wabhlen Sie eine Sprache und klicken auf Weiter.
Klicken Sie auf Weiter > Installieren.

Klicken Sie auf Fertig stellen, um die Installation
abzuschlieRen.

ok wN e

Hinweis: Das Betriebssystem ist die Standardeinstellung fiir
die Steuerung des Wireless LAN bei Windows Vista.

Ausfihrliches Benutzerhandbuch

AnschlielRen an ein Drahtlosnetzwerk
Stellen Sie sicher, dass das Wireless-LAN-Modul aktiviert ist.

1. Klicken Sie auf das Wireless-Symbol [= in der Taskleiste,
und Kklicken Sie dann auf Verbindung mit einem Netz-
werk herstellen (oder klicken Sie mit der rechten Mausta-
ste auf das Symbol (&, und klicken Sie dann auf
Verbindung mit einem Netzwerk herstellen).

2. Klicken Sie in der Liste Anzeigen aus dem Dropdown-

Men( die Option Drahtlosnetzwerke.

Eine Liste der verflighbaren Netzwerke wird angezeigt.

. Klicken Sie auf ein Netzwerk und dann auf Verbinden.

Wenn das gewunschte Netzwerk nicht angezeigt wird,

klicken Sie auf Eine Verbindung oder ein Netzwerk

einrichten (eine Liste der Optionen wird angezeigt, die
eine manuelle Suche und Einstellung eines neuen

Netzwerks ermdglichen).

6. Schieben Sie den Cursor iiber das Taskleistensymbol &,
um den Verbindungsstatus aufzurufen.

7. Wenn Sie die Verbindung zum Wireless-Netzwerk trennen
mdchten, klicken Sie in der Taskleiste auf das Wireless-
Symbol &, und wahlen Sie dann die Option Verbindung
herstellen oder Trennen, um das Netzwerkmeni aufzuru-
fen. Klicken Sie dann auf Trennen (oder klicken Sie mit
der rechten Maustaste auf das Symbol &, und klicken Sie
dann auf Verbindung trennen von).

yoasinag
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PC-Kamera

Dieses Notebook verfiigt Giber zwei Kameraoptionen. Das
1,3M-Pixel-Kamera-Modul verwendet fiir die Aufnahme
von Videodateien die Anwendung BisonCap. Das 2,0M-
Pixel-Kamera-Modul verwendet fiir die Aufnahme von
Videodateien VideoView.

Installieren des PC-Kamera-Treibers
Fir 1,3M-Pixel-PC-Kamera-Modul:

1.

a b~ own

Schalten Sie das Modul mit der Tastenkombination Fn +
F10 ein (wenn das Modul eingeschaltet wird, erscheint
kurz die Anzeige . @),

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 2.Install Camera Driver > Ja.

Wabhlen Sie eine Sprache und klicken auf Weiter.
Klicken Sie auf Weiter > Fertig stellen, um das
Computer neu zu starten.

Die BisonCap-Software wird uber die Verknipfung auf
dem Desktop oder tiber den Eintrag BisonCam im Menii
Start > Programme/Alle Programme gestartet (wenn
die Hardware ausgeschaltet wurde, kdnnen Sie sie mit der
Tastenkombination Fn + F10 wieder einschalten).

Fir 2,0M-Pixel-PC-Kamera-Modul:

1.

aorwn

Schalten Sie das Modul mit der Tastenkombination Fn +
F10 ein (wenn das Modul eingeschaltet wird, erscheint
kurz die Anzeige . @),

Klicken Sie auf Option Drivers (Schaltflache).

Klicken Sie auf 2.Install Camera Driver > Ja.

Klicken Sie auf Installieren.

Wabhlen Sie als Antwort auf die Frage zum Stromsystem
Ja oder Nein.

Klicken Sie auf Fertig stellen > Fertig stellen, um das
Notebook neu zu starten.

7. Die VideoView-Software wird tber die Verknipfung auf

dem Desktop oder tber den Eintrag USB2.0 PC Camera
im Mendi Start > Programme/Alle Programme gestartet
(wenn die Hardware ausgeschaltet wurde, konnen Sie sie
mit der Tastenkombination Fn + F10 wieder einschalten).

4

Einrichten des Farbschemas

Das Farbschema von Windows Vista sollte auf Windows-
Aero eingestellt werden, ehe Sie die PC Camera-Anwen-
dung ausfiihren (Systemsteuerung > Darstellung und
Anpassung > Anpassung > Fensterfarbe und -darstel-

lung).

74 - PC-Kamera



Hot-Key-Tasten fir die PC-Kamera

Mit den Hot-Key-Tasten fir die PC-Kamera & (@] (& kon-
nen Sie, das Programm BisonCap/VideoView starten, Fo-
tos aufnehmen und die Kameraaufnahme vergréfiern und
verkleinern (nur Modelle A & B).

Hot-Key-Taste Funktion
(.Q Das BisonCap/VideoView-Programm akti-
vieren/Fotos aufnehmen (siehe Seite 77)
Modelle - ; ;
Kamera vergréBern (siehe Seite 77)
A&B
Modelle Kamera verkleinern (siehe Seite 77)
A&B

Tabelle 6 - Hot-Key-Tasten fur die PC-Kamera

Ausfihrliches Benutzerhandbuch

Audio-Setup fur die PC-Kamera

Wenn Sie mit der Kamera Video- und Audio-Daten aufneh-
men mochten, missen Sie bei Windows die Optionen fir die
Audio-Aufnahme einstellen.

w

10.

Klicken Sie Start (Meni) und klicken Sie Systemsteuerung
(oder zeigen auf Einstellungen und klicken Systemsteue-
rung).

Klicken Sie auf Sound “** (Hardware und Sound).

Klicken Sie auf Aufnahme (Registerkarte).

Klicken Sie mit der rechten Maustaste auf “Mikrofon (VIA
High Definition Audio)” (externes Mikrofon)/"Front Mic (VIA
High Definition Audio) (internes Mikrofon)” und stellen Sie
sicher, dass die Funktion nicht deaktiviert ist.

Klicken sie doppelt auf Mikrofon/Front Mic (oder wéhlen Sie
aus dem Rechtsklick-Meni die Option Eigenschaften).
Klicken Sie auf Pegel (Registerkarte), und regeln Sie die
Einstellung von Mikrofon.

Klicken Sie auf OK und schlieBen Sie alle Fenster.

Starten Sie das Programm BisonCap/VideoView aus dem
Meni Start > Programme/Alle Programme > BisonCam/
USB2.0 PC Camera.

Rufen Sie das Menti Geréate/Devices auf, und wéahlen Sie
Mikrofon/Front Mic (VIA High Definition Audio) (es sollte mit
einem Hakchen gekennzeichnet sein).

Rufen Sie das Menl Aufnahme/Capture auf, und wahlen Sie
Audio aufnehmen/Capture Audio (es sollte mit einem
Hakchen gekennzeichnet sein).

PC-Kamera - 75
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BisonCap/VideoView

Die Anwendungen BisonCap (fir 1,3-Megapixel-Kame-
ras) und VideoView (fiir 2,0-Megapixel -Kameras) sind
Video-Viewer-Programme fiir die allgemeine Videowie-
dergabe und -priifung. Die Videodateien werden im Format
.avi aufgenommen.

1. Starten Sie das Programm BisonCap/VideoView aus dem
Meni Start > Programme/Alle Programme > BisonCam/
USB2.0 PC Camera (es wird empfohlen, vor der Aufnahme
die Aufnahmedatei einzustellen - siehe "Einstellen der
Aufnahmedatei” weiter unten).

2. Gehen Sie zum Meniu Aufnahme/Capture (wenn Sie Ton
aufnehmen méchten, siehe “Audio-Setup fir die PC-
Kamera” auf Seite 75) und wahlen Sie dann Aufnahme
starten/Start Capture.

3. Klicken Sie auf OK (der Speicherort der Datei wird im Pop-up-
Fenster angezeigt), um die Aufzeichnung zu starten, und auf
Esc, um sie zu stoppen (Die Datei kdnnen Sie sich dann mit
Windows Media Player ansehen).

Einstellen der Aufnahmedatei

Vor dem Aufnehmen von Videodateien kénnen Sie im
Menl Datei/File die Option Aufnahmedatei einst./Set
Capture File wahlen und den Dateinamen und den Spei-
cherort fiir die aufgenommene Datei festlegen (dadurch
kénnen Sie vermeiden, dass andere Dateien versehentlich

tberschrieben werden). Wahlen Sie den Namen und den
Speicherort, und klicken Sie auf Offnen. Legen Sie dann
bei "Capture file size:" die Grofle der Aufnahmedatei fest,
und klicken Sie auf OK. Nun koénnen Sie den Aufnahme-
vorgang wie oben beschrieben starten.

Bildschirmflimmern beseitigen

Wenn das Videobild bei der Wiedergabe mit dem Pro-
gramm BisonCap/VideoView flimmern sollte, kdnnen Sie
bei den Optionen des Video Aufnahme Filters/Video
Capture Filters die Einstellung vornehmen.

Fur BisonCap:
1. Starten Sie das Programm BisonCap.

2. Gehen Sie zu Optionen und wéhlen Sie "Video Aufnahme
Filter...".

3. Wabhlen Sie aus dem Feld Frequenz in der Registerkarte
Eigenschaftenseite entweder 50Hz oder 60Hz.

Fur VideoView:

1. Starten Sie das Programm VideoView.

2. Gehen Sie zu Options und wéahlen Sie "Video Capture
Filter...".

3. Wahlen Sie aus dem Feld Flickering Reduction in der
Registerkarte Image entweder 50Hz oder 60Hz.
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Fotografieren
Mit den Programmen BisonCap und VideoView konnen
Sie auch fotografieren.

1. Starten Sie das Programm BisonCap/VideoView.

2. (BisonCap) Gehen Sie zum Meni Optionen und wéhlen Sie
dann Fotografieren.
oder
(VideoView) Gehen Sie zum Menu Capture und wahlen Sie
dann SnapShot.

3. Das Bild (im Format JPEG) wird im Desktopordner Snapshot
& | gespeichert (der Ordner darf nicht verschoben oder
umbenannt werden).

Zoom
Mit den Programmen BisonCap und VideoView kdénnen
Sie das Kamerabild verkleinern und vergréBern.

Fir BisonCap:

1. Starten Sie das Programm BisonCap.

2. Gehen Sie zum Menii Zoom und wahlen Sie dann
VergroRern/Verkleinern.

Fir VideoView:

1. Starten Sie das Programm VideoView.

2. Gehen Sie zum Menii Options und wahlen Sie dann Setting
(verwenden Sie den Schieberegler zu Einstellen der
VergroRerung, und klicken Sie auf OK, um die Einstellung zu
speichern).

Ausfuhrliches Benutzerhandbuch

\ o/
Z &
AnschlieBen/Entfernen einer PC-Kamera

Beachten Sie, dass die Treiber der Direkttasten und der PC-Ka-
mera nicht gleichzeitig installiert sein kdnnen.

Wenn Sie eine PC-Kamera an das Notebook anschliel3en
mdochten, missen Sie zuerst den vorhandenen Direkttasten-
Treiber (Multimedia Keyboard Driver) deinstallieren und dann

erst den Kameratreiber und die PC-Kamera installieren. Die
Treiber kdnnen im Windows-Fenster Programme und Funk-
tionen deinstalliert werden.

Wenn Sie die PC-Kamera nicht mehr benétigen und entfernen,
sollten Sie auch den PC-Kameratreiber deinstallieren. Dann
kénnen Sie die Device Drivers & Utilities + User's Manual
CD-ROM einlegen und wieder den Direkttasten-Treiber
(QButton) aus dem Menu Drivers Installer installieren.

PC-Kamera - 77
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Fingerabdruckleser

Wenn das von lhnen erworbene Gerét Uber einen Fingerab-
druckleser verfugt (optional nur fir die Modelle B und C)
missen Sie den Treiber entsprechend der folgenden Anwei-
sung installieren.

Fur einen vollen Schutz missen Sie fir den Computer Ad-
ministratorrechte und ein Windows-Kennwort aktiviert ha-
ben.

Bevor Sie mit der Registrierung beginnen, sollten Sie das
Lernprogramm zum Fingerabdruckleser durchgehen. Um
das Lernprogramm zu starten, klicken Sie auf Start > Pro-
gramme/ Alle Programme > Protector Suite QL > Fin-
gerprint Tutorial (Fingerabdruck-Lernprogramm).

Installieren des Fingerabdruckleser-

Treibers

Klicken Sie auf Option Drivers (Schaltflache).
Klicken Sie auf 3.Install FingerPrint Driver > Ja.
Klicken Sie auf Softwareinstallation.

Klicken Sie auf Weiter > Weiter > Weiter.

Klicken Sie auf Fertig stellen > Ja, um das Notebook neu
zu starten.

aprwd e

Hilfe & Handbuch

Klicken Sie mit der rechten Maustaste auf das Taskleistensym-
bol [ und wahlen Sie aus dem Menii die Option Help (Hilfe).

Legen Sie die CD-ROM Device Drivers & Utilities + User's Manu-
al ein und klicken Sie auf Option Drivers. klicken Sie auf Unlock
(Schaltflache) und dann klicken Sie auf 3.Install FingerPrint
Driver > Ja.

Klicken Sie auf Documentation um den Ordner zu 6ffnen, in
dem Sich das Benutzerhandbuch im .pdf-Format befindet.

Um die Adobe Acrobat Reader-Software zu installieren, die Sie
bendtigen, um die Datei lesen zu kdnnen, legen Sie die CD-ROM
Device Drivers & Utilities + User's Manual ein, und klicken sie auf
User's Manual (Schaltflache) und dann auf Install Acrobat
Reader (Schaltflache).

Benutzerregistrierung

Klicken Sie auf Start > Programme/ Alle Programme > Pro-
tector Suite QL > Benutzerregistrierung, oder doppelklik-
ken Sie in der Taskleiste auf das Symbol [ £

Wenn das Programm das erste Mal gestartet wird, werden Sie
gefragt, ob Sie die Lizenzvereinbarung annehmen mdochten.
Klicken Sie dann auf OK.

Klicken Sie auf Weiter und wéhlen Sie “Registrierung auf
der Festplatte”, und klicken Sie auf Fertig stellen.
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10.

11.

12.
13.
14.

Wenn Sie kein Windows-Kennwort eingerichtet haben,
werden Sie dazu aufgefordert (Hinweis: Wenn kein Kennwort
festgelegt wurde, kann Protector Suite QL nicht den Zugriff
auf den Computer sichern).

Wenn Sie auf Weiter klicken und werden Sie aufgefordert, lhr
Windows-Kennwort einzugeben.

Klicken Sie auf Weiter > Weiter (Markieren Sie das
Kontrollfeld bei “Interaktives Lernprogramm ausfiihren”,
um das Fingerabdruck-Lernprogramm durchzugehen).
Klicken Sie bei jedem Fenster des Lernprogramms auf Weiter
(sie kdnnen jederzeit auch auf die Schaltflache
“Lernprogramm Uberspringen” klicken).

Klicken Sie auf eine der Tasten lber einem beliebigen Finger,
um mit der Registrierung dieses Fingers zu beginnen.

Tippen Sie dreimal mit dem Finger auf, um diesen Finger zu
registrieren.

Wiederholen Sie diesen Vorgang fiir alle Finger, die registriert
werden sollen (siehe unten), und dann klicken Sie auf Weiter
> Fertig stellen.

Klicken Sie auf einen der Eintrage unter "Weitere
Informationen zu:", um weitere Informationen Uber dieses
Thema zu erhalten.

Klicken Sie auf SchlieRen.

Starten Sie das Notebook neu.

Klicken Sie mit der rechten Maustaste auf das
Taskleistensymbol E| um das Menl mit den Optionen zu
starten, mit denen Sie Fingerabdriicke bearbeiten, auf das
Control Center zugreifen, die Hilfe aufrufen kdnnen. Sie

15.

16.

17.

Ausfuhrliches Benutzerhandbuch

kénnen das Control Center usw. auch tber den Eintrag
Protector Suite QL im Meni Start > Programme/Alle
Programme starten.

Eine ausfiihrliche Beschreibung finden Sie unter “Hilfe &
Handbuch” auf Seite 78.

Wenn Sie mit dem Finger auf den Fingerabdruckleser tippen,
kénnen Sie auf das Biomeni zugreifen, um den Computer
zu sperren, Websites zu registrieren, das Control Center
zu 6ffnen und das Hilfe-MenU aufzurufen.

Im Control Center kdnnen Sie die Einstellungen und
Fingerabdriicke bearbeiten, und hier erhalten Sie auch Hilfe
dazu.

b e

\ A/

7 \Y

Fingerabdruckregistrierung

Beachten Sie, dass es fiir den Fall einer Verletzung o. &.
sinnvoll ist, mehr als einen Finger zu registrieren.

Abb. 14 - Fingerabdruckregistrierung
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Bluetooth-Konfiguration in
Windows Vista

Richten Sie Ihr Bluetooth-Gerét so ein,
dass der Computer es erkennen kann

1.
2.

Schalten Sie Ihr Bluetooth-Gerat (z. B. PDA, Mobiltelefon) ein.
Schalten Sie das Gerat in den Erkennbar-Modus (eine
Beschreibung dazu finden Sie in der dazugehdrigen
Dokumentation).

Einschalten des Bluetooth-Moduls

1.

Schalten Sie das Bluetooth-Modul mit der Tastenkombination
Fn + F12 ein.

In der Taskleiste erscheint das Bluetooth-Symbol 3
(moglicherweise missen Sie die Option iber das Bluetooth-
Fenster aktivieren).

Fuhren Sie dann einen der folgenden Schritte aus, um das
Fenster Bluetooth-Geréate aufzurufen.

« Kilicken Sie doppelt auf das Symbol £, um das Fenster
Bluetooth-Gerate aufzurufen.

« Kilicken Sie Start (Ment) und klicken Sie Systemsteue-
rung (oder zeigen auf Einstellungen und klicken System-
steuerung), und klicken Sie dan auf Bluetooth-Geréte
(Hardware und Sound).

* Kiicken/klicken Sie mit der rechten Maustaste auf das
Symbol 3 und wahlen Sie eine Option aus dem Menl.

4

Bluetooth-
Datenuibertragung

Beachten Sie, dass die
Datenlibertragung  zwi-
schen dem Notebook und
einem  Bluetooth-Gerat
nur in einer Richtung
maoglich ist (eine gleich-
zeitige  Datenlbertra-
gung in beide
Richtungen wird nicht
unterstutzt).

Bluetooth-Gerat hinzufigen

Bluetooth-MNetzwerkgerate anzeigen

Datei senden

Datei empfangen
Einem PAN beitreten

Bluetooth-Einstellungen offnen

Bluetooth-Symbol entfernen é

Abb. 15 - Fenster "Bluetooth-Gerate" und beim Ank-

licken des Symbols angezeigtes Meni

Hinzufiigen eines Bluetooth-Gerats

1.
2.

Rufen Sie das Fenster Bluetooth-Geréate auf.

Klicken Sie auf Optionen (Registerkarte), und machen Sie ein
Hakchen bei Bluetooth-Gerate kénnen eine Verbindung
mit diesem Computer herstellen (Verbindungen).

Klicken Sie auf Gerate (Registerkarte) und klicken Sie dann
auf Hinzuflgen.

Der Assistent zum Hinzufligen von Bluetooth-Geréten
erscheint.
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5. Klicken Sie auf “Gerat ist eingerichtet und kann erkannt Andern der Einstellungen flir das Blue-
werden”, und klicken Sie dann auf Weiter. L
tooth-Gerat

10 bmstars s vinnupsgan 2o Blatzom- Sermten - T ——— -]

Wik Temsmmmts—— 0 1. Rufen Sie das Fenster Bluetooth-Gerate auf.
m i 2. Klicken Sie auf das Geréat, das Sie andern méchten, und dann
auf Eigenschaften, um:
¢ den Namen des Geréts zu &ndern (klicken Sie auf Allgemein,
geben Sie einen neuen Namen ein, und klicken Sie auf OK).
« einen Dienst zu aktivieren/deaktivieren (klicken Sie auf Dien-
——— ste, markieren Sie das Kontrollkéstchen neben im Feld Dienst
(oder entfernen die Markierung), und klicken Sie auf OK).

" EE R
ie= 3 & B

O
@
c
=
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Abb. 16 - Assistent zum Hinzufiigen von Bluetooth-

Gerdten Schalten des Computers in den Er-

6. Der Assistent sucht dann innerhalb der Reichweite nach .. s
verfiigbaren Bluetooth-Geraten, kennbar-Modus Fur Bluetooth-Gerate
7. Wahlen Sie das Gerat aus, mit dem Sie kommunizieren 1. Rufen Sie das Fenster Bluetooth-Geréte auf.
mochten, und klicken Sie auf Weiter. 2. KI.i'cken Sie a_\uf Optionen (R?giste"rkarte), qnd machen Sie ein
8. Wahlen Sie einen geeigneten Hauptschlissel, und klicken Sie Hak<_:he|n bei BI;:etooth-Gerate kénnen diesen Computer
auf Weiter > Fertig stellen. ermitteln (Suche).
. 3. Machen Sie ein Hakchen bei Benachrichtigung anzeigen,
e srrore s é" wenn ein Bluetooth-Gerat eine Verbindung herstellen mochte
(Verbindungen), wenn Sie benachrichtigt werden mdchten, wenn
ein Bluetooth-Gerét eine Verbindung herstellen méchte.

[0 thartoc-temme (=]

Abb. 18
Bluetooth-Gerate -
Optionen

Abb. 17 - Hauptschllissel-Option
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Fehlerbehebung

Problem

Mogliche Ursache - Lésung

Die Module Wireless-LAN/
Bluetooth kénnen nicht erkannt
werden.

Das/Die Modul(e) ist/sind ausgeschaltet. Stellen Sie anhand der Anzeige-LED ((flll) fest, ob das
Modul an- oder ausgeschaltet ist (siehe “LED-Anzeigen” auf Seite 55). Wenn die Anzeige-
LED nicht leuchtet, driicken Sie die Tastenkombination Fn + F11 (WLAN) oder Fn + F12
(Bluetooth), um das/die Modul(e) zu aktivieren (siehe Tabelle 3 auf Seite 57).

Das Bluetooth-Modul ist aus,
wenn das Gerat aus dem
Energiesparmodus zurlickkehrt.

Das Bluetooth-Modul ist standardm&Rlig ausgeschaltet, wenn es aus dem Energiesparmodus
zuriickkehrt. Driicken Sie die Tastenkombination (Fn + F12), um das Bluetooth-Modul nach der
Riickkehr aus dem Energiesparmodus wieder einzuschalten.

Eine Datei kann nicht auf ein/von
einem angeschlossenen
Bluetooth-Gerat Ubertragen
werden.

Die Dateniibertragung zwischen dem Notebook und einem Bluetooth-Gerat nur in einer
Richtung mdoglich ist (eine gleichzeitige Datenlibertragung in beide Richtungen wird
nicht unterstutzt). Sie kdnnen eine Datei vom Notebook auf ein aktiviertes Bluetooth-Gerét nur
dann kopieren, wenn nicht gleichzeitig Dateien vom Gerat zum Computer Uibertragen werden.
Dieser Vorgang muss zuerst abgeschlossen werden.

Die mit der PC-Kamera
aufgenommenen Dateien
bendtigen zu viel Speicherplatz.

Videodateien, die mit hoher Aufldsung aufgenommen werden, erfordern sehr viel Speicherplatz.

Beachten Sie, dass das Betriebssystem Windows Vista mindestens 15 GB freien Speicher im
Laufwerk C: der Systempartition benétigt. Es wird empfohlen, die aufgenommenen
Videodateien in einem anderen Laufwerk als C: zu speichern, die Dateigrof3e der
Aufnahmedateien zu beschrénken oder die Auflésung der Videos zu verringern (Optionen/
Options > Video Aufnahme konfigurieren.../Video Capture Pin... > AusgabegroRie).
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Bildschirmauflésungs-Fehler (Modelle B & C)

Wenn nach der Wiederaufnahme aus dem Schlafmodus (nur in Windows Vista) entweder die Bildschirmauflosung
geringer ist oder der Bildschirm flimmert, fiihren Sie die folgenden Schritte aus, um dieses Problem zu beheben. Dieser
Fehler tritt im Zusammenhang mit Windows Vista auf, welches beim SchlieRen des Notebooks (S3) TMM (Transient Mul-
timon Manager) auslést. TMM trennt den LCD-Bildschirm vom Betriebssystem und verbindet ihn wieder, wenn das No-
tebook gedffnet wird. Dieser Vorgang kann dazu fiihren, dass TMM veranlasst wird, eine alte Bildschirmeinstellung
wiederherzustellen, die dann zum Bildschirmflimmern fiihrt oder eine Anderung der Auflésung zur Folge hat.

1. Klicken Sie Start (Menu), klicken Sie Systemsteuerung (oder zeigen auf Einstellungen und klicken Systemsteuerung)
und doppelklicken Sie auf Verwaltung (System und Wartung).

2. Doppelklicken Sie auf Aufgabenplanung (Aufgaben planen).

3. Doppelklicken Sie auf Aufgabenplanungbibliot > Microsoft > Windows, und klicken Sie auf MobilePC um die
Systemsteuerung zu 6ffnen.

4. Klicken Sie mit der rechten Maustaste auf TMM und wahlen Sie Deaktivieren, und schlieBen dan Sie alle
Systemsteuerungen.
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Abb. 19 - System und Wartung (Systemsteuerung)
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Technische Daten

Aktualitat der technischen Daten
- Die in diesem Anhang aufgefuihrten technischen Daten sind zum Zeitpunkt der Druckstellung richtig. Bestimmte Elemente (ins-
) besondere Prozessortypen/-geschwindigkeiten) konnen im Rahmen des Entwicklungsplans des Herstellers zwischenzeitlich ge-
(7)) andert oder aktualisiert werden. Detailinformationen erhalten Sie bei lhrem Servicezentrum.
o
=)
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Funktion Technische Daten
Prozessor Typen Intel Core 2 Duo Prozessor (65nm) 65 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin) 4 MB L2 Cache & 800-MHz-Systembus (FSB)
T7300/ T7500/ T7700/ T7800 2,012,2/ 2,4/ 2,6 GHz
Intel Core 2 Duo Prozessor (65nm) 65 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin) 2 MB L2 Cache & 800-MHz-Systembus (FSB)
T7100 1,8 GHz
Intel Celeron M Prozessor (65nm) 65 Nanometer-Prozesstechnologie
Micro-FCPGA-Paket (478-pin) 1 MB L2 Cache & 533-MHz-Systembus (FSB)
530/ 540/ 550 1,73/ 1,86/ 2,0 GHz
Core Logic VIA VN896CE + VT8237A
Speicher Zwei 200-Pin SODIMM-Sockel, Unterstiitzung von DDRII (DDR2) 533/ 667 Speicher
Speicher auf bis zu 2GB erweiterbar

. |
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Funktion Technische Daten
Sicherheit Offnung fiir SicherheitsschloR (Typ Kensington) BIOS-PaRwort
BIOS Phoenix BIOS (8Mb SPI Flash-ROM) Phoenix BIOS

LCD-Optionen

Modelle A & B

15,4" - WXGA (1280 x 800) TFT LCD
15,4" - WXGA+ (1440 x 900) TFT LCD

Modell C

17,0" - WXGA (1440 * 900) TFT LCD
17,1" - WSXGA+ (1680 * 1050) TFT LCD
17,1" - WUXGA (1920 * 1200) TFT LCD

VIA VN896CE Integrated Video System (auf dem
Chip)

Unterstitzt Analog Monitor Pixel Auflésung bis 2048 *
1536

Integrierter 128-bit 2D/3D Grafikbeschleuniger
Kompatibel mit MS DirectX 9

Speicher Ein Austauschbares optisches Laufwerk (12,7 mm Hohe) fiir CDs/DVDs
Eine einfach auszuwechselnde SATA-2,5"-Festplatte (9,5 mm Hbéhe)
Audio Intel High-Definition-Audio-kompatible Schnittstelle 2 eingebaute Lautsprecher
3D Stereo-Soundsystem Eingebautes Mikrofon
Kompatibel mit Sound-Blaster PRO™
Videoadapter Modell A Modelle B & C

NVIDIA GeForce 8400M G (NB8M-SE) Discrete Video
System (extern onboard)

TurboCache™ - gesamter Grafikspeicher bis zu 895 MB
(mit Systemspeicher)

128MB DDR3 Videospeicher on Board

Unterstitzt Dual-Display und ergonomische Bildwieder-
holfrequenzen von bis zu 2048 * 1536

Kompatibel mit MS DirectX 10

. |
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Funktion Technische Daten
Tastatur “Win Key"-Tastatur
Zeigegerat Eingebautes TouchPad (integrierte Rolltastenfunktion)
Schnittstellen Drei USB 2.0-Anschliisse Eine S/PDIF-Ausgangsbuchse
g Eine Schnittstelle fir externen Monitor Eine RJ-11 Buchse fur Modem
) Eine Lautsprecher/Kopfhdrer-Ausgangsbuchse Eine RJ-45-Buchse flur LAN
":_—; Eine Mikrofon-Eingangsbuchse Eine DC-Eingangsbuchse
8 Eine Line-Eingangsbuchse (Line-In)
Kartenleser Festes 7-in-1 Kartenleser-Modul (MS/ MS Pro/ SD/ Mini SO/ MMC/ RS MMC/ MS Duo)
Hinweis: MS Duo/ Mini SD/ RS MMC Karte erfordert PC-Adapter
Kommunikation | 56K MDC-Modem (V.90- und V.92-kompatibel) USB Bluetooth 2.0 + EDR-Modul (Werkseitige Option)
10Mb/100Mb Ethernet LAN 1,3M oder 2,0M Pixel USB PC-Kamera-Modul (Werk-
USB 802.11b/g Wireless LAN-Modul (Option) seitige Option)
ExpressCard-
Steckplatz ExpressCard/54(34)-Steckplatz

Energieverwal-

Unterstitzt ACPI v2.0
tung

. |
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Funktion Technische Daten
Stromversor- Modelle A & B Modell C
gung AC/DC-Adapter fir den gesamten Spannungsbereich | AC/DC-Adapter fir den gesamten Spannungsbereich
AC-Eingang: 100-240 V, 50-60Hz AC-Eingang: 100-240 V, 50-60Hz
DC-Ausgang: 19V, 3,42A oder 18,5V, 3,5A (65W) DC-Ausgang: 19V, 4,74A (90W)
Akkupack mit Smart-Lithium-lonen (6- Zellen), 4000mAH (Alle Modelle) c?
oder c
Akkupack mit Smart-Lithium-lonen (6-Zellen), 4400mAH (Modelle B & C) ('7)"
O
Umgebungsbe- | Temperatur Relative Luftfeuchtigkeit >
dingungen In Betrieb: 5°C — 35°C In Betrieb: 20 — 80%
Bei Aufbewahrung: -20°C — 60°C Bei Aufbewahrung: 10 — 90%
Abmegsungen Modelle A & B Modell C
und Gewicht 360 (B) x 267 (T) x 25,4-34 (H) mm 397 (B) x 280,5 (T) x 39 (H) mm
2,6 kg mit 6-Zellen-Akku 2,98 kg +/- 3 % mit 6-Zellen-Akku und ohne optionale
Module
Optional Optionen fur optische Laufwerks-Module: Fingerabdruckleser
Kombiniertes-Laufwerk (Werkseitige Optlon - nur fur Modelle B & C)
DVD-Dual (Super Multi)-Laufwerk 1,3M oder 2,0M-Pixel USB PC-Kamera-Modul (Werk-

seitige Option)

USB 802.11b/g Wireless LAN-Modul
USB Bluetooth 2.0 + EDR-Modul (Werkseitige Option)

. |
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Avertissement

La compagnie se réserve le droit de revoir cette publication ou de modifier son contenu sans préavis. Les informations
qu’elle contient sont pour référence seulement et n’engagent pas la responsabilité du fabricant ou d’aucun distributeur. Ils
n’assument aucune responsabilité en cas d’erreurs ou d’imprécisions qui pourraient se trouver dans cette publication et ne
sont en aucun cas responsable d’aucunes pertes ou dommages résultant de I’ utilisation (correcte ou incorrecte) de cette pu-
blication.

Cette publication et les logiciels qui I’accompagnent ne peuvent pas, dans leur intégrité ou en partie, étre reproduits, tra-
duits, transmits ou convertis en format électronique sans I’autorisation préalable du vendeur, du fabricant ou des créateurs
de cette publication, a I’exception de copies conservées par |’utilisateur pour archive.

Les noms de marques ou de produits mentionnés dans cette publication peuvent ou pas étre protégés et/ou étre des marques
déposées par leur compagnies respectives. Ils sont mentionnés dans un but d’identification seulement et ne signifient pas
I’approbation de ce produit ou de son fabricant.

© Novembre 2007

Marques déposées

Ce produit incorpore une technologie de protection des droits d'auteur protégée par certains brevets américains et autres
droits sur la propriété intellectuelle appartenant a Macrovision Corporation et d’autres propriétaires légitimes. L’ utilisation
de cette technologie de protection des droits d'auteur doit étre autorisé par Macrovision Corporation, et n’est prévu que dans
un cadre privé ou limité, a moins d’obtenir I’autorisation de Macrovision Corporation. L'ingénierie inverse et le désassem-
blage sont interdits.

Intel, Celeron, et Intel Core sont des marques déposées ou enregistrées d’Intel Corporation déposées.

Avertissement - 89
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Guide Utilisateur Concis

A propos de ce Guide Utilisateur Concis

Ce guide rapide est une bréve introduction a la mise en route de votre systéme. | s’agit d’un supplément, et non pas d’une
alternative au Manuel de I’Utilisateur en Anglais complet au format Adobe Acrobat sur le CD-ROM Device Drivers &
Utilities + User's Manual fourni avec votre ordinateur. Ce CD-ROM contient aussi les pilotes et utilitaires nécessaires au
fonctionnement correct de votre ordinateur portable.

Certains ou tous les éléments de I’ordinateur peuvent avoir été déja installés. Si ce n’est pas le cas, ou si vous avez I’inten-
tion de reconfigurer (ou réinstaller) des portions du systéme, reportez-vous au Manuel de I’Utilisateur complet. Le CD-
ROM Device Drivers & Utilities + User’s Manual ne contient pas de systéme d’exploitation.

Informations de contrdle

Des mises en garde et informations de contréle sont incluses dans le Manuel de I'Utilisateur complet qui se trouve sur le
CD-ROM Device Drivers & Utilities +User’s Manual.

N A
Z S

Utilisation des appareils sans fil a bord d'un avion

L'utilisation de tout appareil électronique de transmission est généralement interdite a bord d'un avi-
on. Assurez-vous que les modules sans fil sont éteints si vous utilisez I'ordinateur a bord d'un
avion.

90 - A propos de ce Guide Utilisateur Concis
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Instructions d’entretien et d’utilisation
L’ordinateur portable est robuste, mais il peut toutefois étre endommagé. Afin d’éviter ceci, veuillez suivre ces recommandations :

* Ne le laissez pastomber. Ne I’exposez a aucun choc ou vibration. Si I’ordinateur tombe, le boitier et d’autres éléments pour-
raient étre endommages.

» Gardez-le sec. Ne le laisser pas surchauffer. Tenez I’ordinateur et son alimentation externe a distance de toute source de chaleur.
Il s’agit d’un appareil électrique. Si de I’eau ou tout autre liquide venait & pénétrer a I’intérieur de votre ordinateur, il pourrait étre
sérieusement endommagg.

« Euvitez les interférences. Tenez I’ordinateur a distance de transformateurs a haute capacité, moteurs électriques, et autres appareils
générateurs de champs magnétiques importants. Ceux-ci peuvent géner ses performances normales et endommager vos données.

» Suivez les procédures appropriées d’utilisation de votre ordinateur. Arrétez I’ordinateur correctement, et fermez tous vos pro-
grammes (n’oubliez pas d’enregistrer votre travail). N’oubliez pas d’enregistrer vos données régulierement puisqu’elles peuvent
étre perdues si la batterie est vide.

» Soyez prudent lorsque vous utilisez des périphériques.

I
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Révision

N’essayez pas de réaliser les opérations de révision de votre ordinateur par vous-méme. Le faire pourrait annulez votre
garantie et vous exposez a des chocs électriques. Pour toute opération de révision, adressez-vous a des personnes agrées.
Débranchez votre ordinateur de toute source d’alimentation. Puis adressez-vous a des professionnels agréés si vous ren-
contrez I’une des situations suivantes :

 Sile cordon d’alimentation ou I’adaptateur CA/CC est endommagé, abimé ou effiloché.

 Sivotre ordinateur a été exposé a la pluie ou tout autre liquide.

 Si votre ordinateur ne fonctionne pas normalement bien que vous ayez suivi les instructions de mise en marche a la lettre.

 Si votre ordinateur est tombé par terre ou a été endommagé de quelque maniére que ce soit (ne touchez pas le liquide qui sortirait
de I’écran LCD au cas ou celui-ci serait cassé : il est trés dangereux et contient des produits qui pourraient vous empoisonner).

 Siune odeur inhabituel, de la chaleur ou de la fumée apparaissait sortant de votre ordinateur.

. |
Instructions d’entretien et d’utilisation - 91



Guide Utilisateur Concis

Sécurité electrique

\otre ordinateur posséde des besoins en énergie propre :

« Utilisez uniquement un adaptateur CA/CC agréé avec votre ordinateur.

» \otre adaptateur CA/CC peut avoir été congu pour les voyages internationaux mais il lui faut tout de méme une source de courant
réguliére et ininterrompue. Si vous n’étes pas sir des caracteristiques du réseau électrique local, consultez notre représentant de
service ou la compagnie électrique locale.

» L’adaptateur CA/CC que vous utilisez, peut étre a 2 broches ou a 3 broches, comprenant une prise de terre. Cette prise de terre est
un des éléments de sécurité importants, ne vous en passez pas ! Si une prise murale compatible n’est pas disponible, demandez a un
électricien qualifié de vous en installez une.

» Quand vous voulez débrancher le cordon d’alimentation, ne tirez pas sur le fil, mais attrapez la téte de la prise.

» Assurez-vous que la prise murale et la (les) rallonge(s) que vous utilisez peuvent supporter la consommation électrique de tous les
appareils qui y sont reliées.

» Avant de nettoyez votre ordinateur, assurez-vous qu’il n’est relié & aucune source de courant.
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Mise en garde pour le sécurité electrique

(70}
@©
(&)
C
©
—
LL

Avant d’entreprendre des procédures de mise a niveau, assurez-vous d’'avoir éteint I'ordina-teur, et déconnecté tous les périphériques et
ca-bles (y compris les cor-dons téléphoniques). Il est également conseillé d’enlever la batterie afin d’éviter d’allumer I'ap-pareil par mégarde.

Eteignez avant de partir en voyage

Assurez-vous que votre notebook est complétement éteint avant de le mettre dans un sac de voyage (ou tout autre bagage similaire). Si
vous placez le notebook allumé dans un sac de voyage, cela peut obstruer la (les) ventilation(s). Pour éviter que votre ordinateur ne sur-
chauffe, assurez-vous que rien n‘obstrue la (les) ventilation(s) quand l'ordinateur est en cours d'utilisation.

Nettoyage
» N’appliquez pas de produit de nettoyage directement sur I’ordinateur, utilisez un bout de tissu propre et souple.
» Nutilisez pas de produit de nettoyage volatil (des distillés pétrdle) ou abrasifs sur aucun des éléments de I’ordinateur.

. |
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Précautions a prendre pour la batterie

» Utilisez uniquement des batteries congues pour votre ordinateur. Un mauvais type de batterie peut provoquer des explosions, des
fuites et/ou endommager votre ordinateur.

» Ne continuez pas d'utiliser une batterie qui est tombée, ou qui parait endommagée (ex: tordue ou vrillée) d'une maniere quelconque.
Méme si l'ordinateur continue de fonctionner avec la batterie en place, cela peut détériorer le circuit, pouvant déclencher un incendie.

» Rechargez les batteries en utilisant le systéme de I’ordinateur portable. Un rechargement incorrect peut provoquer I’explosion de la
batterie.

» N’essayez jamais de réparer la batterie. Au cas ou votre batterie aurait besoin d’étre réparée ou changée, veuillez vous adresser a
votre représentant de service ou a des professionnels qualifiés.

» Gardez les batteries endommagées hors de portée des enfants et débarrassez-vous en le plus vite possible. Veuillez toujours jeter les
batteries avec précautions. Les batteries peuvent exploser ou se mettre a fuire si elles sont exposées au feu ou si elles sont manipu-
lées ou jetées d’une fagon non appropriée.

» Gardez la batterie loin des appareils métalliques.

e Placez un morceau de scotch sur les contacts de la batterie avant de la jeter.

* Ne touchez pas les contacts de la batterie avec les mains ou avec des objects en métal.

2NZ
2 &

Elimination de la batterie & avertissement

n
u
Q
=

O
QD
”

Le produit que vous venez d’acheter contient une batterie rechargeable. Cette batterie est recyclable. Quand elle n’est plus utili-
sable, en fonction des lois locales des différents états et pays, il peut étre illégal de s’en débarrasser en la jetant avec les ordures
ménageres normales. Vérifiez aupres du responsible local de I'élimination des déchets solides de votre quartier pour vous infor-

mer des possibilités de recyclage ou de la maniere appropriée de la mettre au rebut.

Il existe un danger d’explosion si la batterie est replacée de fagon incorrecte. Remplacez-la uniquement par des batteries de
méme type ou de type équivalent, recommendé par le fabricant. Eliminez les batteries usagées selon les instructions du fabricant.
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Guide de démarrage rapide

/ 1. Enlevez tous les emballages.
Arrét 2. Posez l'ordinateur sur une surface stable.

Veuillez noter que vous de- 3. Connectez fermement les périphériques que vous souhaitez utiliser avec votre ordinateur portable
vriez toujours éteindre vo- (par ex. clavier et souris) & leurs ports respectifs.

tre ordinateur en utilisant la 4. Branchez l'adaptateur CA/CC a la prise d'entrée CC a l'arriere de 'ordinateur, branchez ensuite le

commande Arréter du cordon secteur a une prise murale, puis a I'adaptateur CA/CC.

menu du bouton de ver- 5. D'une main, soulevez soigneusement le couvercle/LCD pour obtenir un angle de vision confortable,
rouillage de,Wind_ows’V?s- de l'autre main (comme illustré dans la Figure 1 ci-dessous) maintenez la base de l'ordinateur

ta. Cette précaution évite (Remarque : Ne soulevez jamais I'ordinateur par le couvercle/LCD).

des problemes de disque

dur ou de systéme. 6. Pressez le bouton de mise en marche pour allumer.

Modele C

Remarquez que les ordina-
teurs de Modéle C compor-
tent des loquets sur le
couvercle/LCD. Déplacez
le loquet gauche sur la po-
sition déverrouillée, et fai-
tes coulisser le loquet droit
(et maintenez-le) tout en
soulevant le couvercle.
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Figure 1
Ouvrir le couvercle/LCD/ordinateur avec un adaptateur CA/CC branché
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Différences de Modéles

Cette série de notebooks comprend trois types de modeles différents. Les modéles different comme indiqué dans le tableau
ci-dessous.

Caractéristique Modéele A Modéle B Modele C
Affichage Systeme vidéo intégré de VIA Systeme vidéo discret NVIDIA GeForce 8400M G (NB8M-SE)
g VNB896CE (Interne sur puce) (Externe sur carte)
Version de Windows Vista Windows Vista Home Basic Wmdows V|st.a Home Basic E_dltlon (.6.4_b't)
. L . Windows Vista Home Premium Edition/
supportée Edition (64-bit)

Business Edition/Enterprise Edition/Ultimate Edition (64-bit)

Lecteur d'empreintes digitales Non

Option

Boutons de Zoom & . N
. . i voir le Tableau 4 a la page 102
Enregistrement audio Oui E pag Non

Adaptateur CA/CC

n
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65W (Sortie c.c. 19V, 3,42A ou 18,5V, 3,5A) 90W (Sortie c.c. 19V, 4,74A)

17" WXGA
17.1" WSXGA+
17.1" WUXGA

Type de LCD

Tableau 1 - Différences entre modéles
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Logiciel systeme

\otre ordinateur peut étre livré avec un logiciel systeme
pré-installé. Si ce n’est pas le cas, ou si vous re-configurez
votre ordinateur pour un systeme différent, vous constaterez
gue ce manuel fait référence au systéme d’exploitation Mi-
crosoft Windows Vista. De plus amples informations sur
I’installation des pilotes et utilitaires sont disponibles aux
Chapitres 4 & 7 du Manuel de I’ Utilisateur sur le CD-ROM
Device Drivers & Utilities + User’s Manual.

4

Pilotes

Si vous installez/réinstallez un nouveau logiciel systéme, vous
devrez installer les pilotes appropriés. Les pilotes sont les pro-
grammes qui servent d'interface entre I'ordinateur et un maté-
riel, par exemple un module réseau sans fil. Il est tres
important d'installer les pilotes dans l'ordre indiqué dans le
Tableau 5 ala page 114. Vous ne pourrez pas utiliser les con-
troles les plus avancés tant que les pilotes et les utilitaires né-
cessaires n‘auront pas été correctement installés.

Systemes d'exploitation pris en charge

Systeme d’exploitation

Remarque

Modéle A Modeles B & C

*Windows XP (Home Edition ou
Professional)

Windows Vista (64-bit) Home Basic
Edition

Pour utiliser Win-
dows Vista sans
limitations ni baisse
de performances,
votre ordinateur doit
comporter au mini-
mum 1Go de
mémoire vive (RAM).

Windows Vista (64-bit)
Home Premium Edi-
tion/Business Editon/
Enterprise Editon/Ulti-

mate Editon

*Pour les informations sur le systeme d'exploitation Win-
dows XP consultez le CD-ROM Device Drivers & Utilities
+ User’s Manual.

Non inclus

Les Systemes d’exploitation (par ex. Windows Vista/Win-
dows XP, etc.) ainsi que les applications (par ex. program-
mes de traitement de texte, tableur et base de données) ont
leurs propres manuels, aussi veuillez consulter les manuels
approprieés.
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Carte du systeme : Vue du dessus avec |I’écran

dinateur a bord d'un avion.

Utilisez les combinaisons de
touches pour basculer l'ali-
mentation sur les modules
WLAN/Bluetooth (voir

), et re-
portez-vous a I'icone
d'indicateur Q) pour voir si
les modules sont allumés ou

pas (voir

).

Figure 2 - Vue du dessus avec I’écran LCD ouvert (Modéles A & B)

Carte du systéme : Vue du dessus avec I'écran LCD ouvert (Modéles A & B) - 97

6

(3 0q.

LCD ouvert (Modeles A & B) 1. Caméra PC optionnelle
2. Ecran LCD
3. Haut-parleurs
ﬁ 4. Bouton de mise en
Utilisation des appareils marche
sans fil a bord d'un avion 5. Boutons Hot-Key
6. Clavier
L'utilisat_ion de ol ap_pa_reil 7. Pavé tactile (TouchPad)
électr(’nnl’que de trapsms_smp et boutons
est gen'eralem.ent interdite a 8. Microphone
bord d'un avion. Assurez- ]
vous que ces modules sont 9. Indicateurs LED
éteints si vous utilisez I'or- 10. Lecteur d'empreintes

digitales (optionnel
pour Modele B
seulement)
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Guide Utilisateur Concis

Cameéra PC optionnelle

Ecran LCD

Haut-parleurs

Bouton de mise en

marche

5. Boutons Hot-Key

6. Clavier

7. Pavé tactile (TouchPad)
et boutons

8. Microphone

9. Indicateurs LED

NS s

10. Lecteur d'empreintes
digitales (optionnel)

98 - Carte du systeme : Vue du dessus avec I’écran LCD ouvert (Modele C)

Carte du systeme : Vue du dessus avec |I’écran
LCD ouvert (Modele C)

A&

2 &
Utilisation des appareils
sans fil a bord d'un avion

L'utilisation de tout appareil
électronique de transmission
est généralement interdite a
bord d'un avion. Assurez-
vous que ces modules sont
éteints si vous utilisez I'or-
dinateur a bord d'un avion.

Utilisez les combinaisons de

touches pour basculer l'ali-
mentation sur les modules
WLAN/Bluetooth (voir

), et re-
portez-vous a I'icbne
d'indicateur [§9) pour voir si
les modules sont allumés ou
pas (voir

)-

Figure 3 - Vue du dessus avec I'écran LCD ouvert (Modéle C)




Indicateurs LED

Les indicateurs LED sur votre ordinateur affichent des informations utiles sur I’état actuel de votre ordinateur.

Guide Utilisateur Concis

Tableau 2 - Indicateurs LED

Icéne Couleur Description
& Vert Verrouillage numérique (pavé numérique) activé
Vert Verrouillage majuscule activé
I:ﬁ Vert Verrouillage défilement activé
Vert L'ordinateur est allumé
D/Q) Vert clignotant Le systéme est dans le mode de Veille configuré
Orange L'adaptateur CA/CC est branchée & l'ordinateur est éteint
Orange L'adaptateur CA/CC est branchée & la batterie est en charge
] Orange clignotant La batterie a atteint le niveau bas critique
Vert La batterie est complétement chargée
f—1 \V/ B yoil :
CJ ert Le disque dur est en cours d'utilisation
(((x))) Vert Le(s) module(s) (WLAN, Bluetooth) est/sont allumé/allumés

Indicateurs LED - 99
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Guide Utilisateur Concis

Clavier

Le clavier est doté d'un pavé numérique intégré pour une
saisie des données numériques plus facile. La touche Fn
vous permet un acces immédiat a toute une gamme de fonc-
tions de votre ordinateur. Remarquez que les ordinateurs de
Modeéle C sont équipés d'un pavé numérique situé a droite
du clavier principal.

Figure 4 - Clavier

A
e ML Touches Fonction &2
1 2 a3 [

(]

s # U U= dfle Jii= Ml alfl{a olf) )jl= }

- A Z E R T ¥ U@ A z o
= . Pavé numérique SIEECE NIl
- '

a ||/s D ||F G H Ja|ka|lL Mm% |

L]

= - - == - uches
L S A o A (AL R A M N\ U Lk & Scrlk
SRIICE Touche Fn el m |l [ Ut

Modéles A & B

I RS Touches Fonction e i
= (1 2 3 & v " o . * -
2 L] - a A = . L IR *

€ $o ]

il Touche Verr Num/ArrétDét

= w x c v B N 7 : i 1] . n
* e ey A Pavé numérique
Bl Touche Fn ow ||/ []|m ' T

Modele C

re

| =
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Caracteres Spéciaux

Certaines applications permettent que les touches du pavé
numeérique soient utilisées avec Alt pour produire des ca-
racteres spéciaux. Ces caracteres spéciaux peuvent étre
produits uniqguement en utilisant le pavé numérique. Les
touches normales des chiffres (sur la rangée supérieure du
clavier) ne le permettent pas. Assurez-vous que NumLk
(pavé numérique) soit allumé.

Autres Claviers

Si votre clavier est endommagé ou vous souhaitez simple-
ment changer, vous pouvez utiliser n'importe quel clavier
standard USB. Le systeme le détectera et I'activera auto-
matiquement. Certaines fonctions ou touches de raccourci
spécifiques au clavier standard pourront toutefois ne pas
fonctionner.
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Touches fonction & indicateurs visuels

Les touches de fonctions (F1-F12 etc.) agiront comme touches de raccourci (hot-key) quand pressée en maintenant la
touche Fn appuyée. En plus des combinaisons des touches de fonction de base, les indicateurs visuels sont disponibles
quand le pilote de touches de raccourci (HotKey Driver) est installé (voir la page 116). Une fois le pilote installé une
icone [ apparaitra dans la barre des taches.

Touches Fonction Touches Fonction
Diminution/Augmen-
Fn+~ Lecture/Pause (dans les programmes audio/vidéo) Fn + F8/F9 tation de la lumino-
sité de I'écran LCD
Tl
Activer/Désactiver le —= — - Activer/Désactiver le Q
+ 1 a
Fn+Fl TouchPad S — s Fn+F10 module Caméra PC | 4 ... 4& e _js >
O
Eteindre le rétroéclairage LCD (Appuyez sur une tou- Activer/Désactiver le jab)
+ + ) o4 —.
Fn+F2 che ou utilisez le TouchPad pour allumer) Fn+Fl1 module LAN sans fil | o ME("*)) 8 ,,,,,_ml [ wn
e Activer/Désactiver le
+ +
Fn+ F3 Allume/Eteind le son o ! = HQ 2 Fn + F12 module Bluetooth ; __EB i ._
Fn + F4 Permutation veille Fn +Ascr!‘k/ Activer/Désactiver l'arrét défilement
ArrétDet
En + E5/F6 I?lmlnutlon/Augmenta- | En + NumLk Actlver/D,esactl\,/e'r le verroun\lage numeérique
tion du volume sonore Salpiatiiaiaiaks (pavé numérique) (Modéles A & B)
e Activer/Désactiver le verrouillage numérique
Fn+F7 Alternance d'affichage Verr Num . L .
(pavé numérique) (Modéle C)

Tableau 3 - Touches de fonctions & indicateurs visuels

Clavier - 101
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Boutons Hot-Key

Les touches de raccourcis permettent un accés rapide au navigateur Internet par défaut W et au programme de messagerie .
Les boutons Hot-Key & (&) (@] de la caméra PC peuvent étre utilisés pour exécuter I'application de la caméra, pour prendre
des images fixes et pour faire un zoom avant/arriere de la caméra si un module de caméra PC est installé. Si votre option d'achat
ne comprend pas de module de caméra PC, vous pouvez installer le pilote de bouton rapide (QButton) vous permettant d'uti-
liser les touches de raccourci pour lancer les applications de votre choix (reportez-vous a “Boutons rapides d'applications”
a la page 103 pour plus de détails). Remarquez que les ordinateurs de Modeéle C ne prennent pas en charge les fonctions du
bouton Hot-Key d'enregistrement audio ou zoom caméra.

Tableau 4 - Boutons Hot-Key

2
‘< Bouton Hot-Key Function
(&)
(- . - <
I w Active le navigateur Internet par défaut
L
ﬁ Active le programme d’e-mail par défaut
(_Q Caméra PC installée Activer le Programme BisonCap/VideoView/Prendre une Image Fixe (voir la page 121)
Caméra PC non installée Activer le bouton rapide d'application 1 (voir la page 103)
Modeéles Caméra PC installée Zoom avant de caméra (voir la page 121)
A&B Caméra PC non installée Activer le bouton rapide d'application 2 (voir la page 103)
Modéles Caméra PC installée Zoom arriere de caméra (voir la page 121)
A&B Caméra PC non installée Activer le bouton rapide d'application 3 (voir la page 103)
E chédgles Démarrer/Arréter 'Enregistrement Audio (voir la page 111)

102 - Boutons Hot-Key



Boutons rapides d'applications

Remarquez que le pilote de bouton rapide (QButton) est
destiné & permettre l'utilisation des boutons Hot-Key
J&[@ @ comme boutons rapides d'applications en I'absence
de la caméra PC optionnelle (installez simplement le pilo-
te de bouton rapide si la caméra PC n'est pas installée).
\Vous devrez installer le pilote de bouton rapide (reportez-
vous a “Boutons rapides d'applications” a la page 116)
pour activer les fonctions.

Les boutons rapides d'applications offrent un acces instan-
tané aux applications personnalisées, d'une simple pression
sur un bouton rapide. Pour configurer I'ouverture d'un pro-
gramme lorsque vous appuyez sur les boutons rapides d'ap-
plications &@ @ (voir le Tableau 4 a la page 102) suivez
les instructions ci-dessous. Les boutons rapides d'applica-
tions fonctionneront pendant toute la durée de I'exécution
du programme (l'icone E# apparaitra dans la barre des ta-
ches). Si le programme ne fonctionne pas vous devrez redé-
marrer l'ordinateur.

1. Appuyez sur un bouton & (@] (@l ou cliquez avec le bouton
droit de la souris sur l'icbne [ dans la barre des taches.

2. Sélectionnez Configuration dans le menu et faites défiler
jusqu’'a AP1/2/3 (ou juste Applicationl pour les ordinateurs
de Modele C) et sélectionnez Personnalisé.

Guide Utilisateur Concis

Une boite de dialogue Ouvrir apparaitra sur I'écran.
Naviguez jusqu’au répertoire ou I'application .exe du
programme désiré se trouve (voir au-dessous).
Double-Cliquez sur le fichier du programme ou choisissez
Ouvrir.

Modéles A & B

Modele C _ I Dol s

Application.exe

Vous aurez besoin de localiser le fichier exécutable
(.exe), pas seulement un raccourci. Pour trouver I'appli-
cation, faites un clic droit sur son raccourci sur le bureau,
puis cliguez sur Propriétés. Cliquez sur I'onglet Rac-
courci et regardez ou le fichier exécutable est situé en
cliquant sur le bouton Ouvrir I’emplacement du fichier.

Figure 5 - Ecrans de configuration des boutons
rapides d'applications

Boutons Hot-Key - 103
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Carte du systeme : Vues de face & arriere
Indicateurs LED
Port USB
Prise d’entrée CC
Batterie
Loquets de I'écran LCD
(Modéle C)

aprpwDhE

Arriere

Modeles A & B

1
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C
©
—
LL

Partie avant

4

Arriére

Modéle C

Figure 6 - Vues de face & arriéere

104 - Carte du systéme : Vues de face & arriere



Guide Utilisateur Concis

Carte du systeme : Vue de gauche

1. Fente de verrouillage de

- sécurité
Modeles A & B 2. Baie de périphérique
optique (pour lecteur
CD/DVD)
3. Trou d'ejection
d'urgence
4. Prise téléphone RJ-11
5. Prise de sortie S/PDIF
6. Prise d'entrée de
microphone
7. Prise de sortie haut-
parleurs/casque
8. Prise d'entrée de Ligne
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Ejection d’urgence du CD

Si vous devez éjecter manuellement un CD ou DVD (par ex. suite a une coupure de courant) vous pou-
vez enfoncer I'extrémité d’un trombone redressé dans le trou d’ejection d'urgence. N'utilisez pas la poin-
te d’'un crayon, ou tout autre objet similaire qui pourrait se casser et rester coincé dans le trou.

Figure 7 - Vue de gauche

Carte du systeme : Vue de gauche - 105
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Carte du systeme : Vue de droite
1. Logement

d'ExpressCard/54(34) Modeéles A & B
Lecteur de carte 7-en-1

2 Ports USB 2.0
Prise réseau RJ-45
Port moniteur externe

akrwn

Logement d'ExpressCard
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Le logement d'ExpressCard accepte les formats ExpressCard/34 ou ExpressCard/54.

Lecteur de carte 7-en-1

Le lecteur de carte vous permet d'utiliser certaines des cartes de stockage numériques les plus ressen-
tes.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS
Duo (nécessite un PC adaptateur) / Mini SD (nécessite un PC adaptateur) / RS MMC (nécessite un PC
adaptateur)

Figure 8 - Vue de droite

.|
106 - Carte du systéme : Vue de droite
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Carte du systeme : Vue d’en dessous

1. Ventilation

2. Batterie
> 3. Couvercle de baie de
2 disque dur
4. Couvercle de baie CPU/
Modéles A & B Modéele C RAM

Veuillez ne pas essayer
d'ouvrir ou de forcer le
processeur UC de votre
ordinateur. Le fait d'accé-
der au CPU de quelque
maniére que ce soit risque
de violer la garantie.

Informations batterie
Surchauffe

Décharger puis rechargez toujours complétement une batterie neuve avant de I'utiliser. Déchargez
compléetement puis rechargez la batterie au moins une fois tous les 30 jours ou aprées environ 20
décharges partielles.

Afin de ne pas causer une
surchauffe de votre ordi-
nateur, verifiez que rien ne
bouche la (les) ventila-
tion(s) quand le systeme
est allume.

Figure 9 - Vue d’en dessous

Carte du systéme : Vue d’en dessous - 107
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Guide Utilisateur Concis

Menu Démarrer & Panneau de configuration de Windows Vista

\Vous pouvez accéder a la plupart des panneaux de contréle, utilitaires et programmes dans Windows Vista (et la plupart des
autres versions de Windows) a partir du menu Démarrer. Quand vous installez des programmes et utilitaires ils seront installés
sur votre disque dur, et un raccourci sera habituellement placé dans le menu Démarrer et/ou le bureau. Faites un clic droit sur
I'icone menu Démarrer [, et sélectionnez Propriétés si vous voulez personnaliser I'apparence du menu Démarrer.

ST Ouvrit o
| uvrir Y Programmes par défaut

i Connexins réseau

Rechercher

redd, Explorer = :
: i D Windows Update 3 8
Rechercher... - H
Propriétés Programmes ° : y
Quvrir Tous les utilisateurs ,Li'v Documents &_- - ‘.‘
Explorer Tous les utilisateurs E =
> Paramétres -
o C]

»

4/'/ b Imprimantes

@ Aide et support |igl Bare des taches et menu Démarrer - - v s Tnst
]

o it e R s I L e B 1

Bars e U | S e S g coteston | Bttt

Exécuter..

@ anete.

| Windows Vista ™

e

Cliquezici pour basculer vers I'affi-
chage classique

Figure 10 - Menu Démarrer & Panneau de configuration

A de nombreuses reprises dans ce manuel vous verrez une instruction pour ouvrir le Panneau de configuration. Vous pou-
vez accéder au Panneau de configuration a partir du menu Démarrer. Le Panneau de configuration vous permet de con-
figurer les parameétres pour la plupart des fonctionnalités clés dans Windows (ex. alimentation, vidéo, réseau, audio etc.).
Windows Vista offre les panneaux de contrdles de base pour un grand nombre des fonctionnalités, cependant de nouveaux
panneaux de contrbles sont ajoutés (ou certains existants sont améliorés) quand vous installez les pilotes énumérés dans le
Tableau 5 a la page 114. Pour voir tous les contrdles il peut s'avérer nécessaire de basculer vers I'affichage classique.

.|
108 - Menu Démarrer & Panneau de configuration de Windows Vista
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Caractéristiques vidéo

Cet ordinateur présente deux options vidéo différentes (soit VIA pour le modéle A, soit NVIDIA pour les modeles B &
C). Vous trouverez le pilote approprié sur le CD-ROM Device Drivers & Utilities + User's Manual.

\Vous pouvez permuter les périphériques d'affichage depuis le panneau de contrle Paramétres d'affichage dans Windows,
a partir du moment ou le pilote vidéo est installé.

Pour accéder aux Parametres d'affichage dans Windows Vista:

1. Cliguez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramétres et cliquez sur Panneau de
configuration).

2. Cliquez sur Ajuster la résolution de I'écran dan le menu Apparence et personnalisation (ou double-cliquez sur T
Personnalisation > Parameétres d'affichage). 5

3. Déplacez le curseur sur le parameétre préféré dans Résolution: o (voir la Figure 11 a la page 110). >

4. Cliquez sur la fleche et faites défiler jusqu’au parametre préféré dans Couleurs: 9 (voir la Figure 11 a la page 110). ug

5. Cliquez sur Parameétres avancés e pour faire apparaitre les onglets Parameétres avancés (voir la Figure 11 a la page 110). 0

Pour VIA

1. Cliquez sur les onglets S3 e (voir la Figure 11 a la page 110) pour effectuer tous les ajustements vidéo qui sont nécessaires.

Pour NVIDIA

1. Cliquez sur GeForce 8400M G (onglet).

2. Cliguez sur Démarrer le Panneau de configuration NVIDIA 6 (voir la Figure 11 a la page 110) pour accéder au panneau de
configuration.

3. Vous pouvez aussi accéder au Panneau de configuration NVIDIA en cliquant avec le bouton droit de la souris sur le bureau et en

faisant défiler le menu vers le bas et en cliquant sur Panneau de configuration NVIDIA.

Caracteéristiques vidéo - 109
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Caractéristiques audio

\Vous pouvez configurer les options audio sur votre ordina-
teur a partir du panneau de configuration de Sons  dan
Windows, ou a partir de I'icone du VIA Audio Deck
dans la barre des taches, ou sur le bureau (cela fera ap-
paraitre le menu de VIA Audio Deck). Le volume peut aus-
si étre réglé a l'aide de la combinaison de touches Fn + F5/
F6.

Cliquez sur I'un des boutons (e.g. @) J) sur la gauche
pour étendre les sélections du menu audio.

w

‘o "o
- ®

Figure 12 - Menus de configuration de VIA Audio
Deck

Guide Utilisateur Concis

Enregistrement Audio (Modeles A & B)

Le bouton Hot-Key d'enregistrement audio [¢] vous permet
d'enregistrer de l'audio a partir d'un microphone intégré, ou
d'un microphone connecté a I'entrée jack micro.

1. Pressez le bouton Hot-Key d'enregistrement audio [¢] pour
commencer la session d'enregistrement (I'icone d'enre-
gistrement en haut a gauche de I'écran clignotera).

2. Pressez a nouveau le bouton Hot-Key d'enregistrement audio
[¢] pour arréter la session d'enregistrement (l'icone
d'enregistrement en haut a gauche de I'écran disparaitra).

3. Le fichier audio enregistré (au format .wav) apparaitra dans le
dossier Wav (Ordinateur > Disque local (C:) > Utilisateurs
> (Votre nom d'identifiant) > Wav).

4. Double-cliquez sur le fichier pour rejouer l'audio enregistré.

4

Réglages du Volume Sonore

Le niveau du volume sonore est réglé a l'aide du
contr6le de volume dans Windows (et les tou-

ches de fonctions de volume sur l'ordinateur).
Cliquez sur l'icéne Volume dans la barre des
taches pour vérifier le réglage.

Caractéristiques audio - 111
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Caractéristiques de gestion de 'alimentation

Le panneau de configuration Options d'alimentation de votre systeme Windows (voir la page 108) vous permet de con-
figurer la gestion d'alimentation de votre ordinateur. Vous pouvez économiser de I'énergie a l'aide de modes de gestion de
I'alimentation et configurer les options pour le bouton d‘alimentation, bouton de veille, couvercle de I'ordinateur
(lorsqu'il est ferme), mode Affichage et Veille dans le menu de gauche. Remarquez que le mode de gestion d'économie
d'énergie peut avoir un impact sur les performances de l'ordinateur.

Cliquez pour sélectionner I'un des modes existants, ou cliquez sur Créer un mode de gestion d'alimentation dans le menu gau-
che et sélectionnez les options pour créer un nouveau mode. Cliquez sur Modifier les parameétres du mode et cliquez sur Mo-
difier les paramétres d'alimentation avancés pour accéder a plus d'options de configuration.
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Remarque : Veille est I'état d'économie d'énergie par défaut dans Windows Vista
Figure 13 - Options d’alimentation
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Informations sur la batterie

. . . . . . . NN
Veuillez suivre ces consignes simples pour tirer le meilleur de votre batterie. 7£,l<
Signal de Batterie Faible
Rechargement de la batterie sur les ordinateurs Modele B & C Quand le niveau de la bat-

Remarquez que les ordinateurs Modeéle B & C fonctionnant sous une charge importante (.- BEIEERE S ERIEETNEE
a-d. utilisant des applications nécessitant de nombreux traitements vidéo), lorsqu'ils fonc- Zf't;que' tbfanclf'ej '{“:ne'
H Al H H Y - latemen adaptateur
tionnent sur I'alimentation par la batterie, p_rendrontl_du temps (3 a ?O mmu:ces avant que la EEEEEERE SRS
charge commence) pour recharger la batterie lorsqu'ils sont branchés dans I'adaptateur AC/ EEERESRE RS
DC. Ceci est dil a des considérations sur la sécurité qui stipule que la batterie doit commencer BEIRSTERNESClTEESE

a se recharger seulement quand I'ordinateur a atteint une température convenable. sauvegardées seront per-
dues lorsque la batterie

sera épuisée.

Prenez soin d'enregistrer votre travail quand la LED de la batterie clignote en orange, et bran-
chez l'adaptateur AC/ DC. La LED de la batterie passera du clignotement orange a I'orange
fixe quand la batterie commence a se recharger (3 a 20 minutes avant que le chargement ne
commence).
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Installation du pilote

Le CD-ROM Device Drivers & Utilities + User’s Manual
contient les pilotes et les utilitaires nécessaires pour un bon
fonctionnement de votre ordinateur. Insérez le CD-ROM et
cliquez sur Install Drivers (bouton) ou cliquez sur Option
Drivers (bouton) pour accéder au menu de pilote optionnel.

Installez les pilotes en respectant I'ordre indiqué dans le
Tableau 5. Aprés avoir installé chaque pilote il apparaitra
en grisé (si vous devez réinstaller un pilote, cliquez sur le
bouton Unlock).

Installation manuelle du pilote

Cliquez le bouton Browse CD (Parcourir le CD) dans I'ap-
plication Drivers Installer et naviguer jusqu'au fichier exé-
cutable dans le dossier de pilote approprié.

Windows Update

Apres avoir installé tous les pilotes vérifiez que vous avez
activé Windows Update afin d'obtenir toutes les derniéres
mises a jour de sécurité etc. (toutes les mises a jour inclu-
ront les derniers correctifs de Microsoft).

114 - Installation du pilote

Pilote (Windows Vista) Page #
Vidéo (VIA-Modéle A) page 115
Vidéo (NVIDIA-Modéles B & C) page 115
Son page 115
Modem page 115
Réseau page 115
Lecteur de carte page 115
Pavé tactile (TouchPad) page 115
Hot-Key page 116
Boutons rapides d'applications page 116
LAN sans fil (option) page 117
Caméra PC (option) page 118
Lecteur d'empreintes digitales (option) page 122

Bluetooth (option)

Remarque: Pas d'installation de pilote requise (voir la

page 124)

USB Advance AP (Modéle A)

page 116

Activer Windows Update (voir a gauche)

Tableau 5 - Procédure d'Installation




Procédure d'installation du pilote

Vidéo (VIA - Modéle A)

1. Cliquez sur Install Drivers.

2. Cliquez sur 1.Install Video Driver > Oui.

3. Cliquez sur Suivant > Suivant.

4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Vidéo (NVIDIA - Modéles B & C)

1. Cliquez sur Install Drivers.

2. Cliquez sur 1.Install Video Driver > Oui.

3. Cliquez sur Suivant.

4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Son

Cliquez sur Install Drivers.

Cliquez sur 2.Install Audio Driver > Oui.

Cliquez sur Suivant.

Cliquez sur le bouton J’accepte, puis cliquez sur Suivant.
Cliquez sur Suivant > Suivant > Suivant.

Cliquez sur Terminer pour redémarrer votre ordinateur.

o0k wnPE
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Modem

1. Cliquez sur Install Drivers.

2. Cliquez sur 3.Install Modem Driver > Oui.

3. Cliquez sur OK.

4. Le modem est prét pour la configuration de connexion.

Réseau

Cliquez sur Install Drivers.

Cliquez sur 4.Install LAN Driver > Oui.

Cliquez sur OK.

La carte réseau est maintenant préte a étre configurée.

=

pown

Lecteur de carte

1. Cliquez sur Install Drivers.

2. Cliquez sur 5.Install Cardreader Driver > Oui.

3. Cliquez sur Suivant > Suivant.

4. Cliquez sur Terminer pour redémarrer votre ordinateur.

Paveé tactile (TouchPad)

1. Cliquez sur Install Drivers.

2. Cliquez sur 6.Install Touchpad Driver > Oui.

3. Cliquez sur Suivant.

4. Cliquez sur Terminer > Redémarrer maintenant pour
redémarrer votre ordinateur.
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Guide Utilisateur Concis

Hot-Key

1. Cliquez sur Install Drivers.

2. Cliquez sur 7.Install Hotkey Driver > Oui.

3. Cliquez sur Next > Install.

4. Cliquez sur Finish > Finish pour redémarrer votre
ordinateur.

Boutons rapides d'applications

Si vous n'avez pas de module de caméra PC installé, vous
pouvez installer le pilote de bouton rapide (QButton) vous
permettant d'utiliser les touches de raccourci pour lancer les
applications de votre choix (reportez-vous a “Boutons
rapides d'applications” a la page 103 pour plus de détails).

Vous devrez installer le pilote de bouton rapide (QButton)
car il n'apparait pas dans le menu Drivers Installer.

1. Insérez le CD-ROM Device Drivers & Utilities + User’s
Manual dans le lecteur de CD/DVD et cliquez sur Browse
CD (bouton).

2. Double cliquez pour ouvrir les dossiers suivants Option >
QButton.

3. Double-cliquez sur Setup.exe.

4. Cliquez sur Suivant > Terminer pour redémarrer votre
ordinateur.

USB Advance AP (Modele A)

Installez ce pilote pour les ordinateurs de Modéle A seule-
ment. Cela permettra d'éviter que les claviers et/ou souris
USB 1.1 cessent de répondre aprés la sortie de I'état de
veille prolongée.

Cliquez sur Option Drivers (bouton).

Cliquez sur 4.USB Advance AP > Oui.

Cliquez sur Close pour terminer l'installation.

Prenez soin d'exécuter Windows Update (reportez-vous a
“Windows Update” a la page 114) pour rechercher les
mises a jour importantes.

PobdPE
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LAN sans fil
4

Actionner I'alimentation pour le module LAN sans fil

Allumer le module LAN sans fil a l'aide de la combinaison de
touches (Fn + F11). Quand le module LAN sans fil est sous
tension, la LED (g) sera vert et l'indicateur , _%? s'affichera
brievement.

Installation du pilote du LAN sans fil
Assurez-vous que le module est allumé.

Cliquez sur Option Drivers (bouton).

Cliquez sur 1.Install WLAN Driver > Oui.

Choisissez la langue que vous préférez, et cliquez Suivant.
Cliquez sur Suivant > Installer.

Cliquez sur Finish pour terminer l'installation.

SN

Remarque: Le systeme d'exploitation est le paramétre par dé-
faut pour le contréle LAN sans fil dans Windows Vista.

Guide Utilisateur Concis

Se connecter a un réseau sans fil
Assurez-vous que le module LAN sans fil est allumé.

1.

P

Cliquez sur l'icobne de WLAN dans la barre des taches, et
puis cliquez sur Connexion a un réseau (ou cliquez avec le
bouton droit de la souris sur l'icbne , et puis cliquez sur
Connexion & un réseau).

Dans la liste Afficher, cliguez pour choisir Sans fil dans le
menu déroulant.

Une liste des réseaux actuellement disponibles apparaitra.
Cliquez sur un réseau, et cliquez ensuite sur Connecter.

Si vous ne voyez pas de réseau auquel vous voulez vous
connecter, cliquez sur Configurer une connexion ou un
réseau (une liste d'options apparaitra permettant une
recherche manuelle, et créant un nouveau réseau).

Déplacez le curseur sur l'icbne E de la barre des taches pour
voir I'état de la connexion.

Pour vous déconnecter du réseau sans fil, vous pouvez
cliquer sur l'icdne E sans fil de la barre des taches, et
sélectionner ensuite Se connecter ou se déconnecter pour
accéder au menu réseau, et cliquez sur Déconnecter (ou
cliquez avec le bouton droit de la souris sur l'icone [Bd, et puis
cliquez sur Déconnexion de).

I
)
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Guide Utilisateur Concis

Caméra PC

Deux options de caméra sont disponibles pour cet ordina-
teur. Le module de caméra 1,3M pixels utilise I'application
BisonCap pour capturer les fichiers vidéo. Le module de
caméra 2,0M pixels utilise I'application VideoView pour
capturer les fichiers vidéo.

Installation du pilote de la caméra PC

Pour caméra PC 1,3M pixels:

1.

Activez le module a I'aide de Fn + F10 (I'indicateur , @
s'affichera brievement lors de I'activation du module).
Cliquez sur Option Drivers (bouton).

Cliquez sur 2.Install Camera Driver > Oui.

Choisissez la langue que vous préférez, et cliquez Suivant
> Suivant.

Cliquez sur Terminer pour redémarrer votre ordinateur.
Exécutez le programme d'application BisonCap a partir
du raccourci sur le bureau, ou a partir de I'élément
BisonCam dans le menu Démarrer > Programmes/Tous
les programmes (si le matériel est éteint utilisez la
combinaison de touches Fn + F10 pour le rallumer).

118 - Caméra PC

Pour caméra PC 2,0M pixels:

1.

aprwd

Activez le module a I'aide de Fn + F10 (I'indicateur , __ @
s'affichera briévement lors de I'activation du module).
Cliquez sur Option Drivers (bouton).

Cliquez sur 2.Install Camera Driver > Oui.

Cliquez sur Installer.

Cliquez sur sélectionner Oui ou Non pour répondre a la
question sur le systéme d'alimentation.

Cliquez sur Terminer > Terminer pour redémarrer votre
ordinateur.

Exécutez le programme d'application VideoView a partir
du raccourci sur le bureau, ou a partir de I'élément USB2.0
PC Camera dans le menu Démarrer > Programmes/
Tous les programmes (si le matériel est éteint utilisez la
combinaison de touches Fn + F10 pour le rallumer).

4

Paramétrage du Modele de couleurs

Avant d'utiliser l'application d'appareil photo PC (Bison-
Cap), assurez-vous que Modele de couleurs dans Win-
dows Vista est paramétré sur Windows Aero (Panneau de
configuration > Apparence et personnalisation > Person-
nalisation > Couleur et apparence des fenétres).
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Boutons Hot-Key de la Caméra PC Paramétrage audio de caméra PC
Vous pouvez utiliser les boutons Hot-Key & (@] de la  Si vous souhaitez capturer de la vidéo et du son avec votre
Caméra PC pour exécuter le programme BisonCap/Video- caméra, il est nécessaire de régler les options

View, pour prendre des images fixes et pour zoomer avant/  d'enregistrement du son dans Windows.

arriere avec la caméra (Modeles A & B seulement).

1. Cliquez sur le menu Démarrer, et cliquez sur Panneau de
. configuration (ou pointez sur Parametres et cliqguez sur
Bouton Hot-Key Function Panneau de configuration).

2. Cliquez sur Son ? (Matériel et audio).

Activer le Programme BisonCap/Video-

) ) . 3. Cliquez sur Enregistrement (onglet).
A View/Prendre une Image Fixe (voir la . . . o
page 121) 4. Cliquez avec le bouton droit de la souris sur “Microphone
(VIA High Definition Audio)” (microphone externe)/“Front I|
Modales Zoom avant de caméra (voir la M,|c_ _(VIA ng'rl [,)ef|n|t|or'1 Audio) (rplcrqphone interne)” et Q)
A&B page 121) vérifiez que I'élément n'est pas désactivé. 3
5. Double-cliquez sur Microphone/Front Mic (ou sélectionnez Q
Modéles Zoom arriére de caméra (voir la Propriétés dans le menu contextuel). n
A&B page 121) 6. Cliquez sur Niveaux (onglet), et réglez le curseur
Microphone au niveau requis.
Tableau 6 - Boutons Hot-Key de la Caméra PC 7. Cliquez sur OK et fermez les panneaux de contrdle.

8. Exécutez le programme d'application BisonCap/VideoView a
partir de I'élément BisonCam/USB2.0 PC Camera dans le
menu Démarrer > Programmes/Tous les programmes.

9. Allez aux en-tétes de menu des Périphériques/Devices et
sélectionnez Microphone/Front Mic (VIA High Definition
Audio) (il devrait y avoir une marque sur le c6té).

10. Allez aux en-tétes de menu des Capture et sélectionnez
Capture Audio (il devrait y avoir une marque sur le c6té).

Caméra PC - 119



2
@©
o
c
-
LL

Guide Utilisateur Concis

BisonCap/VideoView

Les applications BisonCap (pour la caméra de 1,3M pixels)
et VideoView (pour la caméra de 2,0M pixels) sont des vi-
sionneuses vidéo utiles pour les visualisations et les tests vi-
déo courants, et permettent de capturer des fichiers vidéo au
format .avi.

1. Démarrez le programme BisonCap/VideoView par le menu
Démarrer > Programmes/Tous les Programmes > Bison-
Cam/USB2.0 PC Camera (il est recommandé de Définir le
fichier de capture avant la capture - voir "Définir le fichier
de capture" ci-dessous).

2. Allez al'en-téte du menu Capture (si vous désirez capturer de
l'audio, reportez-vous a “Boutons Hot-Key de la Caméra
PC” ala page 119) et sélectionnez Démarrer la capture/
Start Capture.

3. Cliguez sur OK (I'emplacement du fichier s'affichera dans la
fenétre contextuelle) pour démarrer la capture, et appuyez sur
Echap pour arréter (vous pouvez visionner le fichier en
utilisant Windows Media Player).

Définir le fichier de capture

Avant de capturer des fichiers vidéo vous pouvez sélection-
ner I'option Définir le fichier de capture/Set Capture File
dans le menu Fichier/File et définir le nom et I'emplace-
ment du fichier avant de capturer (ceci permettra d'éviter
d'écraser accidentellement des fichiers). Définissez le nom

et I'emplacement puis cliquez sur Ouvrir, puis définissez la
"Taille du fichier de capture :" et cliquez sur OK. Vous pou-
vez alors lancer le processus de capture comme ci-dessus.

Eliminer le scintillement d'écran

Sivous trouvez que I'écran vidéo dans le programme Bison-
Cap/VideoView scintille, vous pouvez essayer d'ajuster le
paramétre dans les options Video Capture Filter... (Filtre
de capture vidéo).

Pour BisonCap:
1. Exécutez le programme d'application BisonCap.

2. Allez a I'en-téte du menu Options et sélectionnez Video
Capture Filter....

3. Cliquez sur 50Hz ou 60Hz sous Fréquence dans I'onglet
Page de propriétés.

Pour VideoView:

1. Exécutez le programme d'application VideoView.

2. Allez a I'en-téte du menu Options et sélectionnez Video
Capture Filter....

3. Cliquez sur 50Hz ou 60Hz sous Flickering Reduction dans
I'onglet Image.

120 - Caméra PC
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Prendre des images fixes
Les programmes BisonCap et VideoView vous permettent

. - \ A/
de prendre des images fixes. 2 &
1. Exécutez le programme d'application BisonCap/VideoView. Ajouter/Retirer une caméra PC
2. (BisonCap) Allez a I'en-téte du menu Options et Remarquez que les pilotes de boutons rapides et de caméra PC
sélectionnez Prendre une photo. ne peuvent coexister.
ou

Si vous désirez ajouter ultérieurement un module de caméra PC
a votre ordinateur, vous devez alors désinstaller le pilote de bou-
ton rapide (appelé pilote de clavier multimédia) avant d'instal-

(VideoView) Allez a I'en-téte du menu Capture et
sélectionnez SnapShot.

3. Limage (au format JPEG) sera Qlacée dans le dossier Snaps- ler le pilote de caméra PC. Vous pouvez désinstaller les pilotes
hPt & sur le bureau (ne pas déplacer ni renommer le dos- dans le panneau de contrdle Programmes et fonctionnalités Tm
sier). dans Windows. 5
Si vous désirez retirer ultérieurement un module de caméra PC >
Zoom de votre ordinateur, désinstallez alors le pilote de caméra PC 8
Les programmes BisonCap et VideoView vous permettent aprés avoir retiré le module de la caméra. Vous pouvez alors in- a
de faire un zoom avant et arriére avec la caméra. sérer le CD-ROM Device Drivers & Utilities + User's Manual
etinstaller le pilote de bouton rapide (QButton) a partir du menu
Pour BisonCap: Drivers Installer.

1. Exécutez le programme d'application BisonCap.

2. Allez al'en-téte du menu Zoom et sélectionnez Zoom avant/
Zoom arriére.

Pour VideoView:

1. Exécutez le programme d'application VideoView.

2. Allez a I'en-téte du menu Options et sélectionnez Setting
(utilisez le curseur pour ajuster le niveau du zoom, et cliquez
sur OK pour enregistrer le parametre).

. |
Caméra PC - 121
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Lecteur d'empreintes digitales

Si votre option d'achat comporte un lecteur d'empreintes di- 4
gitales (En option pour les ordinateurs de Modéle B & C Aide & Manuel
seulement) vous devrez installer le pilote en vous reportant

aux instructions ci-dessous. Faites un clic droit sur l'icbne [ de la barre des taches pour

faire apparaitre le menu afin de sélectionner Aide.

Vérifiez que vous avez les droits d'administrateur sur votre Insérez le CD-ROM Device Drivers & Utilities + User's Ma-
ordinateur, et que vous avez un mot de passe Windows acti- nual et cliquez sur Option Drivers (bouton). Cliquez sur Un-
p tection total lock (bouton) et puis cliquez sur 3.Install FingerPrint Driver
V€ pour une protection totale. > oui.
- Avant de commencer le processus d'enregistrement, il est Cliquez sur Documentation pour ouvrir le dossier contenant
= recommandé de prendre connaissance du didacticiel d'em- ERE e
o preintes digitales. Pour lancer le didacticiel cliquez sur Dé- e o e e e
(- marrer > Programmes/Tous les programmes > chier, msere_z le CD-ROM I?ewce Drivers & Ut|||t|es_+ User's
E Sui idacticiel de Fi . Manual et cliquez sur User's Manual (bouton), et cliquez sur
'C Protector Suite QL > Didacticiel de Fingerprint. Install Acrobat Reader (bouton).

Installation du pilote du lecteur d'em-

oreintes digitales Enregistrement de |'utilisateur

1. Cliquez sur Démarrer > Programmes/Tous les program-

1. Cliquez sur Option Drivers (bouton). mes > Protector Suite QL > Enregistrement d’utilisateurs,

2. Cliquez sur 3.Install FingerPrint Driver > Oui. ou double-cliquez sur 'icbne |ﬁ| dans la barre des taches.

3. Cliquez sur Installation du logiciel. 2. Lors du premier lancement du programme, vous serez invité a

4. Cliquez sur Suivant > Suivant > Suivant cliquer sur le bouton pour accepter la licence, et cliquer
C . . L ensuite sur OK.

5. Cliquez sur Terminer > Oui pour redémarrer votre

dinat 3. Cliquez sur Suivant et sélectionnez “Enregistrement sur le
ordinateur. disque dur”, et cliquez sur Oui.
.|
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10.

11.

12.
13.
14.

Si vous n'avez pas défini de mot de passe de Windows vous
serez invité a le faire (remarque: Si vous n'avez pas défini de
mot de passe, Protector Suite QL ne peut pas sécuriser
l'accés a votre ordinateur).

Cliquez sur Suivant et vous serez invité & entrer votre mot de
passe de Windows.

Cliguez sur Suivant > Suivant (cochez la case a cocher
“Lancer le didacticiel interactif” pour prendre connaissance
du didacticiel Fingerprint).

Cliguez sur Suivant pour chaque fenétre du didacticiel (vous
pouvez cliquer sur le bouton “Passer le didacticiel” a tout
moment).

Cliquez sur le bouton au-dessus I'un des doigts pour lancer
I'enregistrement de ce doigt.

Tapez trois fois le doigt pour enregistrer ce doigt.

Répétez le processus pour tous les doigts que vous voulez
enregistrer (voir ci-dessous), puis cliqguez sur Suivant >
Terminer.

Cliguez sur I'un des en-tétes “En savoir plus” pour obtenir
plus d'informations sur tous les sujets.

Cliguez sur Fermer.

Redémarrez l'ordinateur.

Faites un clic droit sur l'icbne li}f_ﬂ de la barre des taches pour
faire apparaitre le menu vous permettant d'Modifier les
empreintes digitales, Lancer le Centre de contrdle,
accéder au menu Aide etc. Vous pouvez aussi exécuter le
Centre de contrdle etc. a partir de I'élément Protector Suite

15.

16.

17.

Guide Utilisateur Concis

QL dans le menu Démarrer > Programmes/Tous les
programmes.

Reportez-vous a “Aide & Manuel” a la page 122 pour plus
de détails.

Si vous passez votre doigt sur le lecteur, a tout moment, vous
pouvez accéder au Biomenu pour Verrouiller I'ordinateur,
Enregistrer des sites web, Déverrouiller Mon coffre, ouvrir
le Centre de contrble et accéder au menu Aide.

Le Centre de contrdle vous permet de modifier les
Parameétres, enregistrement d'empreintes numériques et
d'obtenir de I'Aide.

(oo e =]

\ =/

7 \

Enregistrement de I'empreinte digitalet

Il est fortement recommandé d'enregistrer plus d'un doigt
en cas de blessure etc.

Figure 14 - Enregistrement de I'empreinte digitalet
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Guide Utilisateur Concis

Configuration Bluetooth dans
Windows Vista

Configurez votre périphérigue Blue-
tooth afin que votre ordinateur le trouve

1.

Allumez votre périphérique Bluetooth (ex. PDA, téléphone
mobile etc.).

Rendez le périphérique détectable (pour cela consultez la
documentation de votre périphérique).

Allumer le module Bluetooth

Activez le module Bluetooth a l'aide de Fn + F12.

Une icone f] Bluetooth apparaitra sur la barre des taches
(vous devrez peut-étre activer I'option a partir du panneau de
contrdle Bluetooth).

Vous pouvez alors procéder comme suit pour accéder au
panneau de contrble des périphériques Bluetooth.

 Double-cliquez sur I'icone g3 pour accéder au panneau de
contréle des périphériques Bluetooth.

* Cliquez sur le menu Démarrer et cliquez sur Panneau de
configuration (ou pointez sur Parametres et cliquez sur
Panneau de configuration), et puis cliquez sur Périphéri-
ques Bluetooth (Matériel et audio).

* Cliquez/Cliquez avec le bouton droit de la souris sur
I'icone (3 et sélectionnez une option dans le menu.

| O opirpi prceteeet [+

4

Transfert de données
Bluetooth

Remarquez que le trans-
fert de données entre I'or-
dinateur et un
périphérique  Bluetooth
est pris en charge dans
une direction seule-
ment (le transfert simul-
tané de données n'est
pas pris en charge).

Ajouter un périphérique Bluetooth

Afficher les périphériques Bluetooth

Envaoyer un fichier

Recevair un fichier
laindre un réseau personnel

Cuvrir les parametres Bluetocth

Supprimer l'icone Bluetooth E

Figure 15 - Périphériques Bluetooth et cliquer sur le Menu

d'icone

Ajouter un périphérique Bluetooth

1.
2.

Accédez au panneau de contrble des périphériques Bluetooth.
Cliquez sur Options (onglet), et assurez-vous que la case a
cocher Autoriser les périphériques Bluetooth a se
connecter a cet ordinateur (Connexions) est cochée.
Cliquez sur Périphériques (onglet), et puis cliquez sur
Ajouter.

.|
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4.
5.

L'Assistant Ajout de périphérique Bluetooth apparait.
Cliguez pour choisir “Mon périphérique est configuré et

prét a étre détecté.”, et puis cliquez sur Suivant.

T L e ——

]

e

=}

Assintant Ajout de paripharique et gt b ey bt 8 et 9

Bluetootn

Figure 16 - Assistant Ajout de périphérique Bluetooth

6.

L'Assistant recherchera alors tous les périphériques
Bluetooth disponibles a portée.

Sélectionnez le périphérique avec lequel vous souhaitez
communiquer et cliguez sur Suivant.

Sélectionnez une option de clé de sécurité appropriée et
cliquez sur Suivant > Terminer.

Acsatent Lpiodt dt prphrizan Bustocth Es

= -

Figure 17 - Option de clé de sécurité

Guide Utilisateur Concis

Changer les parametres du périphéri-
gue Bluetooth

1.
2.

Accédez au panneau de contrdle des périphériques Bluetooth.

Cliquez sur le périphérique que vous voulez modifier et

cliqguez sur Propriétés pour:

e Changer le nom du périphérique (cliquez sur Général,
tapez un nouveau nom et cliquez sur OK).

« Activer/Désactiver un service (cliquez sur Services,
cochez/décochez la case a cocher proche du service et cli-
quez sur OK).

Pour rendre votre ordinateur détectable
aux périphériques Bluetooth

1.
2.

3.

Accédez au panneau de contrble des périphériques Bluetooth.

Cliquez sur Options (onglet), et assurez-vous que la case a
cocher Autoriser les périphériques Bluetooth arechercher
cet ordinateur (Découverte) est cochée.

Assurez-vous que la case a cocher M'avertir lorsqu’un
nouveau périphérique Bluetooth souhaite se connecter
(Connexions) est cochée, si vous voulez étre averti quand un
périphérique Bluetooth veut se connecter.

=)
Figure 18
Périphériques
Bluetooth -
Options

Configuration Bluetooth dans Windows Vista - 125
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Dépannage

Probleme

Cause possible - résolution

Les modules LAN sans fil/
Bluetooth ne peuvent pas
étre détectés.

Le(s) module(s) est (sont) désactivé(s). Vérifiez lindicateur LED @ pour voir si le(s) module(s) est
(sont) activé(s) ou désactivé(s) (reportez-vous a “Indicateurs LED” a la page 99). Si l'indicateur
LED est désactivé, alors appuyez sur la (les) combinaison(s) de touches Fn + F11 (WLAN) ou Fn +
F12 (Bluetooth) pour activer le(s) module(s) (voir le Tableau 3 a la page 101).

Le module Bluetooth est
désactivé aprés la reprise
depuis Veille.

L'état par défaut du module Bluetooth sera désactivé aprés la reprise a partir de I'état Economie
d'énergie de veille. Utilisez la combinaison de touches (Fn + F12) pour activer le module Bluetooth
quand l'ordinateur reprend a partir de I'état de Veille.

Un fichier ne peut étre copié
sur/depuis un périphérique
Bluetooth connecté.

Le transfert de données entre l'ordinateur et un périphérique Bluetooth est pris en charge dans une
direction seulement (le transfert simultané de données n'est pas pris en charge). Si vous
copiez un fichier depuis votre ordinateur sur un périphérique Bluetooth, vous ne pourrez pas copier
un fichier & partir d'un périphérique Bluetooth sur votre ordinateur tant que le transfert de fichier
depuis l'ordinateur ne sera pas terminé.

Les fichiers vidéo capturés
depuis la caméra PC
prennent trop de place sur le
disque.

Notez que la capture de fichiers vidéo a haute résolution nécessite un espace substantiel sur le
disque pour chaque fichier.

Notez que le systeme Windows Vista nécessite un minimum de 15Go d'espace libre sur la
partition systeme du lecteur C:. Il vous est recommandé d'enregistrer le fichier vidéo capturé dans
un autre emplacement que le lecteur C:, limitez la taille du fichier de la vidéo capturée ou réduisez
la résolution vidéo (Options > Video Capture Pin... > Taille de sortie).
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Erreur de résolution d'écran (Modéles B & C)

Si vous rencontrez une diminution de la résolution de I'écran, ou un scintillement de I'écran, apreés étre sorti de I'état de
Veille dans Windows Vista seulement suivez alors les instructions ci-dessous pour résoudre ce probléme. Cette erreur se
produit conformément a la stratégie de Windows Vista, qui déclenche TMM (Transient Multimon Manager) quand le
couvercle du notebook (S3) est fermé. TMM déconnecte I'affichage LCD de I'OS et rajoute ensuite I'affichage LCD quand
le couvercle est ouvert. Cela peut déclencher le rétablissement des paramétres d'un ancien affichage par TMM qui peut
entrainer le scintillement de I'écran ou d'un changement de résolution d'écran.

1.

Cliquez sur le menu Démarrer, et cliquez sur Panneau de configuration (ou pointez sur Paramétres et cliquez sur Pan-
neau de configuration) et double-cliquez sur Outils d’administration (Systéme et maintenance).

Double-cliquez sur Planificateur de taches (Taches planifinées).

Double-cliquez sur Bibliotheque du Planificateur de taches > Microsoft > Windows, et cliquez sur MobilePC pour
ouvrir le panneau de configuration.

Cliquez avec le bouton droit de la souris sur TMM et sélectionnez Désactiver, et fermez tous les panneaux de contrdle.

Figure 19 - Systéme et maintenance (Panneau de configuration)
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Spécifications
Z

Derniéres informations de spécification

Les spécifications énumérées dans cet Appendice sont correctes a I'heure de la mise sous presse. Certains éléments (particu-
lierement les types de processeur/vitesse unique) peuvent étre modifiés ou mis a niveau en fonction du calendrier des parutions
du fabricant. Voyez auprés de votre service clientéle pour les détails.

Caractéristique Spécification
2 Types de Processeur Intel Core 2 Duo (65nm) Procédé de gravure en 65 nm
8 processeurs Micro-FCPGA package (478-broches) Cache L2 4Mo & Bus principal & 800MHz
c T7300/ T7500/ T7700/ T7800 2,0/ 2,2/ 2,4/ 2,6 GHz
E Processeur Intel Core 2 Duo (65nm) Procédé de gravure en 65 nm
Lo Micro-FCPGA package (478-broches) Cache L2 2Mo & Bus principal & 800MHz
T7100 1,8 GHz
Processeur Intel Celeron M (65nm) Procédé de gravure en 65 nm
Micro-FCPGA package (478-broches) Cache L2 1Mo & Bus principal & 533MHz
530/ 540/ 550 1,73/ 1,86/ 2,0 GHz
Core logic VIA VN896CE + VT8237A
Mémoire Deux emplacement SODIMM, supportant la mémoire DDRII 533/ 667
Mémoire extensible jusqu'a 2Go
Sécurité Fente de verrouillage de sécurité (type Kensington) Mot de Passe du BIOS
BIOS Phoenix BIOS (SPI Flash ROM de 8Mo) Phoenix™ BIOS
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Caractéristique

Spécification

Options d’écrans
LCD

Modeéelea A & B

15,4" - WXGA (1280 * 800) TFT LCD
15,4" - WXGA+ (1440 * 900) TFT LCD

Modéle C

17,0" - WXGA (1440 * 900) TFT LCD
17,1" - WSXGA+ (1680 * 1050) TFT LCD
17,1" - WUXGA (1920 * 1200) TFT LCD

Stockage de

Un lecteur de type unité optique (CD/DVD) 12,7mm(h) remplagable (reportez-vous a “Options” ala

données page 131 pour les options de lecteur)
Une disque dur SATA facilement échangeable de 2,5" 9,5 mm (H)
Son Interface conforme Intel HDA (Son Haute Définition) 2 haut-parleurs intégrés
Systéme sonore stéréo 3D amélioré Microphone intégré
Compatible avec Sound-Blaster PRO™
Affichage Modéle A Modeles B & C
Systéme vidéo intégré de VIA VN896CE Systéme vidéo discret NVIDIA GeForce 8400M G
(Interne sur puce) (NB8M-SE) (Externe sur carte)
Moteur Graphique 128-bit 2D/3D Intégré Mémoire graphique totale TurboCache™ jusqu'a
Supporte la résolution de pixels de moniteur 895Mo (avec mémoire systeme)
analogique jusqu'a 2048 * 1536 Mémoire Vidéo interne DDR-3 128Mo
Compatible avec MS DirectX® 9 Supporte l'affichage double et les vitesses de
rafraichissements ergonomiques jusqu'a 2048 *
1536
Compatible avec MS DirectX® 10
Clavier Clavier “Win Key”
Dls_posmf de TouchPad intégré (avec fonction de défilement)
pointage
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Caractéristique Spécification

Interface Trois ports USB 2.0 Une prise de sortie S/PDIF
Un port moniteur externe Une prise RJ-11 pour modem
Une prise de sortie haut-parleurs/casque Une prise RJ-45 pour réseau
Une prise d'entrée de microphone Une prise d’entrée en CC
Une prise d'entrée de Ligne

Lecteur de carte Lecteur de carte 7-en-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)

Remarque: Cartes MS Duo/ Mini SD/ RS MMC nécessitent un PC adaptateur

Logement .
" d'ExpressCard Logement d'ExpressCard/54(34)
' Communication 56K Plug & Play Fax/Modem (conforme V.90 & V.92)  Module Bluetooth 2.0 + EDR USB (Option d’usine)
g LAN 10Mo/100Mo Ethernet 1,3M ou 2,0M pixel caméra PC USB (Option
© Module 802.11b/g USB WLAN (Option) d'usine)
| -
LL
C’Ee'_stlon dg Supporte ACPI v2.0
I'alimentation
Mise en marche Modéles A & B Modéle C
Adaptateur CA/CC pleine bande Adaptateur CA/CC pleine bande
Entrée c.a.: 100-240V, 50-60Hz Entrée c.a.: 100-240V, 50-60Hz
Sortie c.c.: 19V, 3,42A Ou 18,5V, 3,5A (65W) Sortie c.c.: 19V, 4,74A (90W)

Batterie de Smart Lithium-lon (6-éléments), 4000mAH (Tous modéles)
ou
Batterie de Smart Lithium-lon (6-éléments), 4400mAH (Modéles B & C)

.|
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Caractéristique Spécification
Spécifications Température Humidité relative
environnementales | gn fonction : 5°C- 35°C En fonction : 20% - 80%
Eteint : -20°C - 60°C Eteint : 10% - 90%
Dimensions Modéles A & B Modéle C
physiques & Poids | 554 1) 4 267 (p) x 25,4-34 (h) mm 397 (1) x 280,5 (p) x 39 (h) mm
2,6 kg avec batterie & 6 éléments 2,98 kg +/- 3% avec batterie a 6 éléments et sans
modules en option
Options Options de module de lecteur optique : Lecteur d'empreintes digitales (Option d'usine -
Lecteur combo pour Modeles B & C seulement)
Lecteur DVD-Dual (Super Multi) 1,3M ou 2,0M pixel caméra PC USB (Option
d’usine)

Module 802.11b/g USB WLAN
Module Bluetooth 2.0 + EDR USB (Option d’usine)
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AViso

La compafiia se reserva el derecho a revisar esta publicacion o cambiar su contenido sin previo aviso. La informacion
contenida aqui sirve sélo como referencia y no constituye ninguna obligacion por parte del fabricante o cualquier vendedor.
No se asume responsabilidad o compromiso por cualquier error o inexactitud que pueda aparecer en esta publicacion ni nos
hacemos responsables de cualquier pérdida o dafio como resultado del uso (0 mal uso) de esta publicacion.

Esta publicacion y cualquier software que la acomparie no puede, en parte o en su totalidad, ser reproducida, traducida,
transmitida o reducida a cualquier forma legible sin el previo consentimiento del vendedor, fabricante o creadores de esta
publicacion, excepto para copias de seguridad guardadas por el propio usuario.

Los nombres de productos y marcas mencionados en esta publicacidn pueden ser 0 no marcas con derechos de copia y/o
marcas registradas de sus respectivas compafiias. Se mencionan aqui sélo para propdsitos de identificacion y no como
apoyo a ese producto o su fabricante.

© Noviembre de 2007

Marcas registradas

Este producto incorpora tecnologia de proteccidn de derechos de autor amparada por las exigencias de ciertas patentes de
EE.UU. y otros derechos de propiedad intelectual pertenecientes a Macrovision Corporation y otros propietarios de
derechos. El uso de esta tecnologia de proteccidn de derechos de copia debe ser autorizado por Macrovision Corporation
y esta limitado a uso exclusivo doméstico u otros usos de visualizacién limitados a menos que exista autorizacién previa
de Macrovision Corporation. Quedan prohibidas las modificaciones o el desmontaje.

Intel, Celeron e Intel Core son marcas/marcas registradas de Intel Corporation.
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Acerca de esta Guia del Usuario Concisa

Esta guia rapida es una breve introduccién para poner su sistema en funcionamiento. Es un suplemento y no un sustituto
del Manual del usuario completo en inglés en formato Adobe Acrobat del CD-ROM Device Drivers & Utilities + User's
Manual suministrado con el ordenador. En este CD-ROM también se encuentran los controladores y utilitarios necesarios
para utilizar el ordenador correctamente.

Algunas o todas las caracteristicas del ordenador pueden haberse configurado de antemano. Si no lo estan, o si desea
reconfigurar (o reinstalar) partes del sistema, consulte el Manual del usuario completo. EI CD-ROM Device Drivers &
Utilities + User’s Manual no contiene un sistema operativo.

Informacién de regulacion

Las notas de regulacion e informacion estan contenidas en el Manual del usuario completo en el CD-ROM Device Drivers
& Utilities + User’s Manual.

AN
I

Uso de dispositivos inalambricos a bordo de un avién

Normalmente se prohibe el uso de cualquier dispositivo de transmision electronica a bordo de
un avion. Compruebe que los médulos inalambricos estén DESCONECTADOS si va a
utilizar el ordenador en el avion.
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Instrucciones para el cuidado y funcionamiento

El ordenador portatil es muy robusto, pero puede dafarse. Para evitar esto, siga estas sugerencias:

Servicio

No intente arreglar el ordenador por su cuenta. Si lo hace, puede violar la garantia y exponerse usted y el ordenador a
descarga eléctrica. Encargue las reparaciones a personal técnico autorizado. Desenchufe el ordenador de la fuente de
alimentacién. Encargue las reparaciones a personal cualificado en los siguientes casos:

No lo deje caer ni lo exponga a golpes fuertes. Si el ordenador se cae, la carcasa y los componentes podrian dafiarse.
Manténgalo seco y no lo sobrecaliente. Mantenga el ordenador y fuente de alimentacidn alejados de cualquier tipo
de fuente de calor. Esto es un aparato eléctrico. Si se derrama agua u otro liquido en su interior, el ordenador podria
dafiarse seriamente.

Evite las interferencias. Mantenga el ordenador alejado de transformadores de alta capacidad, motores eléctricos y
otros campos magnéticos fuertes. Estos pueden dificultar el correcto funcionamiento y dafiar los datos.

Siga las instrucciones apropiadas de manejo del ordenador. Apague el ordenador correctamente y no olvide
guardar su trabajo. Recuerde guardar periédicamente sus datos, pues los datos pueden perderse si la bateria se
descarga.

Tenga cuidado cuando utilice dispositivos periféricos.

Cuando el cable de alimentacion esté dafiado o pelado.

Si el ordenador ha estado expuesto a la lluvia u otros liquidos.

Si el ordenador no funciona con normalidad tras seguir las instrucciones de uso.

Si el ordenador se ha caido o dafiado (no toque el liquido venenoso si el panel LCD se rompe).
Si hay un olor fuera de lo normal, calor o humo que sale del ordenador.
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Seguridad sobre la alimentacion
El ordenador tiene unos requisitos de alimentacion especificos:

» Utilice solamente un adaptador de alimentacion aprobado para su uso con este ordenador.

» Su adaptador de CA/CC puede estar disefiado para viajes internacionales, pero puede que necesite una fuente de alimentacion
continuada. Si no esta seguro de las especificaciones de alimentacion locales, consulte con el servicio de asistencia o compafiia de
electricidad del lugar.

» Eladaptador de alimentacion puede tener un enchufe de 2 dientes o un enchufe con tierra de 3 dientes. El tercer diente es una caracteristica
de seguridad; no lo elimine. Si no tiene acceso a un enchufe de pared compatible, haga que un electricista cualificado instale uno.

» Cuando desee desenchufar el cable de alimentacidn, asegUrese de desconectarlo por la cabeza del enchufe, no por su cable.

« Compruebe que la toma y cualquier alargadera que utilice puedan soportar la carga de corriente total de todos los dispositivos
conectados.

« Antes de limpiar el ordenador, asegurese de que esté desconectado de cualquier fuente de alimentacién externa.

G
s
Aviso de seguridad sobre la corriente

Antes de llevar a cabo cualquier procedimiento de actualizacion, asegurese de haber apagado la alimentacion y desconectado todos
los periféricos y cables (incluyendo las lineas telefonicas). También es aconsejable quitar su bateria para evitar que la maquina se
encienda por accidente.

Apéaguelo antes de viajar

Compruebe que su portatil esté completamente apagado antes de introducirlo en una bolsa de viaje (o en cualquier funda). Si introduce
un portatil encendido en una bolsa de viaje, puede que la(s) rejilla(s) se bloquee(n). Para evitar que el ordenador se sobrecaliente,
asegurese de que nada bloguea la(s) rejilla(s) con el ordenador encendido.

Limpieza
* No aplique limpiador directamente en el ordenador, utilice un trapo suave y limpio.
* No utilice limpiadores volatiles (derivados del petr6leo) o limpiadores abrasivos en ningtn lugar del ordenador.

.|
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Precauciones con la bateria

» Utilice solo baterias disefiadas para este ordenador. Una bateria inadecuada podria explotar, perder o dafar el equipo.

* Nunca utilice una bateria que se haya caido o que parezca dafiada (p. ej. doblada o retorcida). Incluso si el ordenador
sigue funcionando con una bateria dafiada, puede provocar dafios en el circuito que podrian causar fuego.

« Recargue la bateria con el sistema del ordenador. Una recarga incorrecta puede hacer que la bateria explote.

* No intente reparar baterias. Solicite la reparacion o la sustitucidn a su representante de servicio o a personal de
servicio cualificado.

» Mantenga las baterias dafiadas fuera del alcance de los nifios y deséchelas inmediatamente. La eliminacion de baterias
debe efectuarse con cuidado. Las baterias pueden explotar o perder si se exponen al fuego o si se manipulan o
desechan de manera inadecuada.

» Mantenga las baterias lejos de elementos metalicos.

» Cubra los contactos de la bateria con cinta adhesiva antes de desecharla.

» No toque los contactos de la bateria con las manos o con objetos metalicos.

\ L/
2§
Eliminacion de la bateria & Cuidado

El producto que usted ha comprado contiene una bateria recargable. La bateria es reciclable Terminada su vida util, segun las
leyes locales y estatales, puede ser ilegal desecharla junto con los residuos ordinarios. Verifiqgue con las autoridades locales
responsables de los desechos sélidos cuéles son las opciones de eliminacion y reciclado existentes en su zona.

Peligro de explosion si la bateria esta mal colocada. Sustitiyala con un tipo de bateria igual o equivalente al recomendado por
el fabricante. Elimine la bateria usada de conformidad con las instrucciones del fabricante.

.|
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Guiarapida para empezar

/ 1. Quite todos los materiales del embalaje.
Apagar 2. Coloque el ordenador en una superficie estable.
Por favor, tenga en cuenta 3. Conecte en los puertos correspondientes los periféricos que desee utilizar con el ordenador portétil

que deberia siempre apa- (p- €. teclado y raton).
gar el ordenador eligiendo 4. Conecte el adaptador de CA/CC al conector de entrada de CC que esté del lado posterior del

la opcién Apagar desde el ordenador, y luego conecte el cable de alimentacion CA en un eschufe y al adaptador.

menu del botén Bloquear | 5. Utilice una mano para levantar con cuidado la tapa/LCD a un angulo de visién cémodo, mientras
en Windows Vista. Esto le utiliza la otra mano (como se muestra en la Figura 1 siguiente) para sostener la base del ordenador
ayudara a evitar problemas (Nota: Nunca levante el ordenador por la tapa/LCD).

con el disco duro o el siste-

ma 6. Presione el botén de encendido para “encender”.

Modelo C

Tenga en cuenta que los
ordenadores Modelo C tie-
nen pestillos en la tapa/
LCD. Mueva el pestillo iz-
quierdo a la posicion de
abierto y deslice el pestillo
derecho (manteniéndolo en
su lugar) mientras levanta
la tapa.

Figura 1
Abrir la tapa/LCD/ordenador con el adaptador AC/DC enchufado
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Diferencias de modelos y disefos
Esta serie de portatiles incluye tres tipos de modelos distintos. Los modelos difieren segun se indica en la siguiente tabla.

Caracteristica Modelo A Modelo B Modelo C

Sistema de Video Integrado Sistema de video discreto NVIDIA GeForce 8400M G (NB8M-SE)

LRI AN VIA VN896CE (Chip Interno) (Externo Incorporado)

Windows Vistax Home Basic Edition (64-bit)
Windows Vista Home Premium Edition/Business Edition/Enterprise
Edition/Ultimate Edition (64-bit)

Version Windows Windows Vista Home Basic
Vista soportada Edition (64-bit)

Lector de huellas

digitales No opcion
Botones zoom y L.
i eala Tabla 4 en la pagina 146
grabacion de audio Si E] v pag! No

Alimentacion 65W (Salida CC 19V, 3,42A 0 18,5V, 3,5A) 90W (Salida CC 19V, 4,74A)
15,4" WXGA 17" WXGA
15,4" WXGA+ 17,1" WSXGA+

17,1" WUXGA
Tipo de LCD

Tabla 1 - Diferencias de modelos
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Software de sistema

Puede ser que su ordenador tenga instalado un software de
sistema. Si no es el caso, o si desea reconfigurarlo con otro
sistema, este manual se refiere a Microsoft Windows Vista.
Si desea mas informacion sobre cémo instalar controlado-
res y utilitarios consulte los capitulos 4 y 7 del Manual del
usuario completo, que se encuentra en el CD-ROM Device
Drivers & Utilities + User’s Manual.

4

Controladores

Si va a instalar o reinstalar un nuevo sistema, necesitara ins-
talar los controladores apropiados. Los controladores son pro-
gramas gue actian como una interfaz entre el ordenador y un
componente hardware, p. ej. un médulo de red inaldambrico. Es
muy importante que instale los controladores en el orden lista-
do en la Tabla 5 en la pagina 158. No puede utilizar los con-
troles mas avanzados hasta que tenga instalados los
controladores y utilidades apropiadas.

Sistemas operativos suportados

Sistema operativo
Nota

Modelo A Modelos B & C

*Windows XP (Home Edition o
Professional)

Windows Vista (64-bit) Home Basic
Editon

Para ejecutar Win-
dows Vista sin limi-
taciones ni menor
rendimiento, su
ordenador necesita
un minimo de 1GB
de memoria del sis-
tema (RAM).

Windows Vista (64-bit)
Home Premium Editon/
Business Editon/Enter-
prise Editon/Ultimate
Editon

*Para informacion sobre el SO Windows XP consulte el
CD-ROM Device Drivers & Utilities + User’s Manual.

No incluido

Sistemas operativos (p. ej. Windows Vista/Windows XP)
tienen sus propios manuales, al igual que las aplicaciones
(p. €j. procesadores de texto, planillas de calculo y bases de
datos), por favor, consulte los manuales apropiados.
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Mapa del sistema: Vista superior con panel LCD

abierto (Modelos A & B)

NG

LG
Uso de dispositivos
inalambricos a bordo

El uso de dispositivos
electronicos portatiles a bordo
de un avion suele estar
prohibido. Aseglrese de que
los modulos estén apagados
si esté utilizando el ordenador
a bordo de un avién.

Utilice las combinaciones de
teclas (vea

) para activar/
desactivar los maodulos
WLAN/Bluetooth y  haga
compruebe el icono indicador
de estado w para ver si los
maodulos estan encendidos o
no (vea

).

Figura 2 - Vista superior con panel LCD abierto (Modelos A & B)

No ok wbdR

©

10.

Céamara PC (opcional)
Panel LCD

Altavoces incorporados
Botén de encendido
Botones Hot-Key

Teclado

TouchPad (almohadilla
tactil) y botones
Micréfono incorporado
Indicadores LED

Lector de huellas digitales
(opcional sélo para
Modelo B)
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Mapa del sistema: Vista superior con panel LCD

1. Céamara PC (opcional) .
2. Panel LCD abierto (Modelo C)
3. Altavoces incorporados
4. Botén de encendido
5. Botones Hot-Key ;Z:l’;
6. Teclado Uso de dispositivos
7. ;I"OIf[.(?;P%dt(almohadilla inalambricos a bordo
actil) y botones
8. Micréfono incorporado El uso de dispositivos
9. Indicadores LED electrénicos portatiles a bordo

de un avibn suele estar
prohibido. Asegirese de que
los médulos estén apagados
si esta utilizando el ordenador
a bordo de un avién.

10. Lector de huellas digitales
(opcional)

Utilice las combinaciones de
teclas (vea

) para activar/
desactivar los madulos
WLAN/Bluetooth y  haga
compruebe el icono indicador
de estado w para ver si los
maodulos estan encendidos o
no (vea

).

Figura 3 - Vista superior con panel LCD abierto (Modelo C)
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Indicadores LED

Los indicadores LED en su ordenador muestran una valiosa informacién sobre el estado actual del ordenador.

Tabla 2 - Indicadores LED

Icono Color Descripcion
& Verde El teclado numérico esta activado
@ Verde El blogqueo de mayuUsculas esta activado
Eﬁ‘ Verde El bloqueo de desplazamiento esta activado
Verde El ordenador esta encendido
D/(D Verde parpadeante El ordenador esta en modo Suspension
Naranja El adaptador de CA/CC esta conectado & el ordenador esta apagado
Naranja El adaptador de CA/CC esta conectado & la bateria se esta cargando
m Naranja parpadeante La bateria ha alcanzado el estado critico de poca energia
Verde La bateria esta completamente cargada
% Verde El disco duro esta en uso
(((‘))) Verde Elllos médulo(s) (WLAN, Bluetooth) esta/estan activado/activados
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Teclado

El teclado tiene un teclado numérico para una entrada facil
de datos numéricos. En la parte inferior izquierda del
teclado se encuentra la tecla Fn. Esta tecla permite efectuar
operaciones al instante. Tenga en cuenta que los
ordenadores Modelo C tienen un teclado numérico a la
derecha del teclado principal.

Figura 4 - Teclado

R Teclas de funcion [EERGRIREIESIISSIENES
2 | . . . o) @ (=@ [
a A1 2e 38 4 5 ] L, . i
S SR | CClad0 nUMErico IS =

Sl Tecla Fn s ||| 8 ||ow !
- ) —
Modelos A & B
. B Teclas de funcion S
N 11 2@ 3w 4 5 TRk ] ] ] . i %
Q w E R T Y u 1 ] P

« 5 = 7| El "

L Tccla Blog Num/BlogDespl

z x c v B N ]

N Tcclado numeérico
TeclaFn | okl : =,

- v 3

Modelo C
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Caracteres especiales

Algunas aplicaciones de software le permiten usar las teclas
numéricas con Alt para producir caracteres especiales. Estos
caracteres especiales sélo pueden producirse utilizando el te-
clado numérico. Las teclas numéricas normales (en la fila
superior del teclado) no funcionaran. Asegurese de que el te-
clado numeérico (NumLKk) esté activado.

Otros teclados

Si su teclado esta dafiado o si desea cambiarlo, puede utilizar
un teclado estandar USB. El sistema lo detectara y lo habilita-
ra automaticamente. Sin embargo, las funciones especiales/
teclas directas del teclado normal del sistema puede que no
funcionen.
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Teclas de funcién & indicadores visuales

Las teclas de funcion (F1 - F12 etc.) actuaran como teclas directas (Hot-Key) cuando se pulsan junto con la tecla Fn.
Ademas de las combinaciones de teclas de funcion basicas los indicadores visuales estan disponibles cuando el controlador
de teclas directas (Hot-Key Driver) esta instalado (vea la pagina 160). Después de instalar el controlador aparecera un
icono [ en la barra de tareas.

Teclas Funcién Teclas Funcién
Fi+ - Reproducir/Pausar (gn los programas Audio/ En + F8/F9 Reducc_lon/Aumento
Video) brillo LCD
Activar/desacti- — — = Activar/desactivar el
Fn+Fl var el TouchPad = - - Fn+F10 moédulo Camara PC R - e _:3 |
Apagar luz de fondo del LCD Activar/desactivar el
Fn + F2 (presione una tecla o utilice el TouchPad para Fn + F11 médulo LAN Wire- @ @
encenderlo) less 6 Rucor | @ s~ |
Conmutacion Activar/desactivar el
+ +
e Fs mudo Valume '-I On  Valume * Muic Fn+Fl2 madulo Bluetooth L h__-ea Ig '____J!_
Fn+F4 Conmutacién dormir Fn + Scrlk/ Cambiar el bloqueo de desplazamiento
BlogDespl
Fn + F5/ Reduccion/ Activar/disactivar el teclado numérico (NumLKk)
Aumentovolumen Fn + NumLk
F6 - Salpiatiiaiaiaks (Modelos A & B)
de sonido
Fn+ F7 Conmutacion pantalla Blog Num Activar/disactivar el teclado numérico (NumLk)
(Modelo C)

Tabla 3 - Teclas de funcién & indicadores visuales

Teclado - 145
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Botones Hot-Key

Los botones Hot-Key ofrecen un acceso rapido al explorador de Internet v y al programa de correo electrénico =&
predeterminados. Los botones Hot-Key para camara PC & (@] (&) pueden usarse para ejecutar la aplicacion de la camara,
para tomar fotos instantaneas y para acercar o alejar la camara si tiene instalado el médulo camara PC. Si su opcion de
compra no incluye un modulo cdmara PC, puede instalar el controlador de botones rapidos (QButton) para poder utilizar
los botones Hot-Key para abrir las aplicaciones elegidas (consulte “Botones rapidos de aplicaciones” en la pagina 147
para mas detalles). Tenga en cuenta que los ordenadores Modelo C no soportan las funciones de los botones Hot-Key zoom
de camara y grabacion de audio.

Tabla 4 - Botones Hot-Key

Boton Hot-Key Funcion
w Activar el buscador de Internet predeterminado
“' Activar el programa de correo electrénico predeterminado

Camara PC instalada Activar programa BisonCap/VideoView/tomar imagen instantanea (vea la

- pagina 165)

Céamara PC no instalada Activar botén rapido de aplicacion 1 (vea la pagina 147)
Modelos Camara PC instalada Aumentar zoom de camara (vea la pagina 165)
A&B Cémara PC no instalada Activar botén rapido de aplicacion 2 (vea la pagina 147)
Modelos Céamara PC instalada Disminuir zoom de camara (vea la pagina 165)
A&B Cémara PC no instalada Activar botén rapido de aplicacion 3 (vea la pagina 147)
B 2{"3{’;'05 Iniciar/detener grabacion de audio (vea la pagina 155)

146 - Botones Hot-Key
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Botones répidos de ap| icaciones 3. Aparecera un cuadro de dialogo Abrir en la pantalla.

Tenga en cuenta que el controlador de botones rapidos 4 Busdue el directorio donde esta el programa de la
A ... aplicacion.exe deseada (ver bajo).
(QButton) esta disefiado para permitir el uso de los botones . . ; .
) L, . L. 5. Haga doble clic en el archivo del programa o elija Abrir.
Hot-Key «&[@ @ como botones rapidos de aplicaciones en
ausencia de la camara PC opcional (instale el controlador A
de botones rapidos solo si cAmara PC no esta instalada). 1
Necesitara instalar el controlador de botones rapidos i
(QButton) para habilitar las funciones (consulte “Botones
répidos de aplicaciones” en la pagina 160).

Lonfiguracién 3

Salir

Los botones réapidos de aplicaciones ofrecen un acceso
instantaneo a las aplicaciones definidas por el usuario, con
una pulsacién rapida de boton. Para configurar un programa
para que se abra al pulsar los botones rapidos de

aplicaciones &[@ @ (consulte la Tabla 4 en la pagina 146) Z

siga las instrucciones siguientes. Los botones rapidos de

aplicaciones funcionaran siempre que el programa se esté Aplicacion.exe

ejecutando (el icono B aparecera en la barra de tareas). Si Necesitara localizar archivo ejecutable (.exe) de la apli-
el programa no se esta ejecutando, necesitara reiniciar el cacion, y no solo el acceso directo. Para encontrar la

aplicacién, haga clic con el boton derecho en el acceso di-
recto en el escritorio y haga clic en Propiedades. Haga
clic en Acceso directo (ficha) y vea donde esta el archivo
ejecutable haciendo clic en Abrir ubicacion (botén).

ordenador.

1. Pulse un botén &[&][&] o haga clic con el boton derecho en el
icono [ en la barra de tareas.

2. Seleccione Configuracion en el mend, desplacese a AP1/2/3
(o simplemente Applicationl para ordenadores Modelo C) y Figura 5 - Pantallas de configuracién de los botones
seleccione Custom. rapidos de aplicaciones

|
Botones Hot-Key - 147



Guia del Usuario Concisa

Mapa del sistema: Vistas frontal y posterior

1. Indicadores LED

2. Puerto USB 2.0

3. Conector de entrada
de CC

4. Bateria

5. Pestillos del LCD
(Modelo C)

Parte posterior

Modelos A & B

Parte frontal

Parte posterior 4

Modelo C

Figura 6 - Vistas frontal y posterior

148 - Mapa del sistema: Vistas frontal y posterior
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Mapa del sistema: Vista izquierda

1. Ranura del cierre de
seguridad

2. Bahia de dispositivo
Optico (para el dispositivo
CD/DVD)

3. Oirificio de expulsion de
emergencia

4. Conector de teléfono RJ-
11

5. Conector de salida S/
PDIF

6. Conector de entrada
para micréfono

7. Conector de salida de
auriculares

Expulsion de emergencia de CD 8. Conector de entrada de

linea

Modelos A & B

Si necesita expulsar un CD/DVD manualmente (p. €j. por un corte de corriente inesperado) puede in-
troducir la punta de un clip en el orificio de expulsién de emergencia. No utilice la punta de un lapiz u
otros objetos que puedan romperse y quedar atrapados en el orificio.

Figura 7 - Vista izquierda

.|
Mapa del sistema: Vista izquierda - 149
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Mapa del sistema: Vista derecha

1. Ranura ExpressCard/
54(34) Modelos A & B
Lector de tarjetas 7 en 1 - -

2 Puertos USB 2.0
Conector LAN RJ-45
Puerto para monitor
externo

aprwn

Ranura ExpressCard

La ranura ExpressCard acepta los formatos ExpressCard/34 o ExpressCard/54.

Lector de tarjetas 7 en 1

El lector de tarjetas le permite usar algunas de las Ultimas tarjetas de almacenamiento digital.

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS
Duo (requiere PC adaptador) / Mini SD (requiere PC adaptador) / RS MMC (requiere PC adaptador)

Figura 8 - Vista derecha

.|
150 - Mapa del sistema: Vista derecha
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Modelos A & B

Siempre complete la descarga de una bateria nueva y luego carguela por completo antes de usarla.
Descéarguela por completo y vuelva a cargarla al menos una vez cada 30 dias o tras unas 20 des-
cargas parciales.

1

Informacion de la bateria

Figura 9 - Vista inferior

2
Modelo C

Guia del Usuario Concisa

Rejilla

Bateria

Tapa de la bahia para el
disco duro

Tapa de la bahia para
CPU/RAM

2N\Z
A

CPU

El usuario no debe
manipular la CPU. El
acceso a la CPU de
cualquier modo puede
anular su garantia.

Recalentamiento

Para evitar que su
ordenador se recaliente
compruebe que nada
bloquea la(s) rejilla(s) con
el equipo encendido.

.|
Mapa del sistema: Vista inferior - 151
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Menu Inicio y Panel de control de Windows Vista

La mayoria de paneles de control, utilidades y programas en Windows Vista (y la mayoria de versiones de Windows)
pueden accederse a través del menu Inicio. Cuando instala programas y utilidades, se instalaran en su unidad de disco duro
y normalmente aparecera un acceso directo en el menu Inicio y/o escritorio. Haga clic con el bot6n derecho en el icono del
menu Inicio 3, luego seleccione Propiedades si desea personalizar la apariencia del menu Inicio.

Abrir (@ Programas predeterminados |8 ? . —
Expl —~
Rovt £ It 20 Windows Update = , -
Buscar. 1B et - =
Propiedades ) G
@ Pragramas *
Abrir todos los usuarios T -
9%  Explorartodos los usuarios sy Documentos .
B corqumiin ‘ Panel de control &
= : E ek p 0 B Conoiones dred :
| Impresoras B
' B ; @ Ayuday soporte técnico L Borrade tareasy mendi nicio -a
= 3
gl e Ngl =
.'I".: e " .. +
g p’
£l imsee . z H H
Haga clic aqui para cambiar a la vista
e
clasica
b Todes ko pragrnas . , -
e Figura 10 - Menu Inicio y Panel de control

En muchos ejemplos a lo largo de este manual vera una ilustracién para abrir Panel de control. EI Panel de control se
accede desde el menu Inicio. EI Panel de control le permite establecer la configuracién de la mayoria de caracteristicas
principales en Windows (p. ej. energia, video, redes, audio, etc.). Windows Vista ofrece paneles de control basicos para
muchas de las caracteristicas, sin embargo, se afladen muchos paneles de control nuevos (o mejoran los existentes) cuando
instale los controladores listados en la Tabla 5 en la pagina 158. Para ver todos los controles puede que sea necesario
activar la vista Clasica.

152 - Menu Inicio y Panel de control de Windows Vista
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Parametros de video

Este ordenador incluye dos opciones de video diferentes (VIA para el Modelo A o NVIDIA para los Modelos B & C). Se
le facilitara un controlador apropiado en el CD-ROM Device Drivers & Utilities + User’s Manual.

Puede cambiar los dispositivos de pantalla y configurar las opciones de pantalla desde el panel de control Configuracion
de Pantalla (en Personalizacion) en Windows Vista.

Para acceder a la Configuracion de pantalla en Windows Vista:

1. Hagaclic en Inicio (menu), y haga clic en Panel de control (o vaya a Configuracion y haga clic en Panel de control).

2. Haga clic en Ajustar resolucién de pantalla en el menl Apariencia y personalizacidn (o haga doble clic en Personalizacién >
Configuracion de pantalla).

3. En Resolucion, mueva el control deslizante a la configuracién preferida para resolucion o (ver la Figura 11 en la pagina 154).

4. En Calidad de color, haga clic en la flecha y desplace hasta la configuracion preferida para la profundidad del color 9 (ver la
Figura 11 en la pagina 154).

5. Haga clic en Configuracion avanzada... (botén) e (ver la Figura 11 en la pagina 154) para abrir las fichas de Configuracion
avanzada.

Para VIA

1. Hagaclic en las fichas S3 e (ver la Figura 11 en la pagina 154) para realizar cualquier ajuste de video necesario.

Para NVIDIA
1. Haga clic en GeForce 8400M G (ficha).
2. Hagaclic en Iniciar el panel de control de NVIDIA e (ver la Figura 11 en la pagina 154) para acceder al panel de control.

3. También podré acceder al Panel de control de NVIDIA haciendo clic con el botén derecho en el escritorio y haciendo clic en Panel
de control de NVIDIA.

Parametros de video - 153
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pacs cenlos

e hate =TT
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n' ¢£Esta buscando el panel de control de pantalla NVIDIA?

Todos los paneles de control de NVIDIA se han consolidado en una sola
aplicacisn. el pans! de control de NVIDIA. Pusds iniciarse en &l pansl de
cantrol de Windows o hacienda ciic con el boton derecho en el escritorio de
Windows:
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Figura 11 - Configuracion de Pantalla
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Caracteristicas de audio Grabacion de audio (Modelos A & B)

Puede configurar las opciones de audio de su ordenador en ~ El boton Hot-Key de grabacion de audio (<] le permite
el panel de control de Sonido “?, o desde el icono de VIA  grabar audio del micréfono incorporado o de un micréfono
Audio Deck & en la barra de tareas o en el escritorio conectado al conector de entrada para micréfono.

(esto abrira el menl de VIA Audio Deck). El volumen

también puede ajustarse con la combinacion de teclas Fn + 1. Pulse el boton Hot-Key de grabacion de audio [#] para iniciar
F5/F6 el proceso de grabacion (el icono de grabacion W=

parpadeara en la parte superior izquierda de la pantalla).

Haga clic en cualquiera de los botones (p.ej. (@@ )) de la 2. Pulse el boton Hot-Key de grabacién de audio (] de nuevo

izquierda para expandir las selecciones del ment de audio. para detener el proceso de grabacion (el icono de grabacion
desaparecera en la parte superior izquierda de la pantalla).
3. Elarchivo de audio grabado (en formato .wav) aparecera en
la carpeta Wav (Equipo > Disco local (C:) > Usuarios > (Su
nombre de inicio de sesion) > Wav).

4. Haga doble clic en el archivo para reproducir el audio
grabado.

4

Ajuste del volumen del sonido

El nivel del volumen del sonido se ajusta utili-

zando el control dentro de Windows (y las te-
clas de funcion del volumen en el ordenador).
Haga clic en el icono del Volumen de la barra
Figura 12 - MenUs de Configuracion de VIA Audio de tareas para comprobar la configuracion.

Deck

Caracteristicas de audio - 155
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Funciones de administracion de energia

El panel de control de las opciones de energia (meni Hardware y sonido) de Windows (ver la pagina 152) permite
configurar las funciones de administracion de energia del ordenador. Puede ahorrar energia con los planes de energia y
configurar las opciones para el botdn de encendido, botén de suspensién, tapa del ordenador (al cerrarla), pantalla y

modo de suspensidn en el menl de la izquierda. Tenga en cuenta que el plan economizador puede afectar al rendimiento
del ordenador.

Haga clic para seleccionar uno de los planes existentes o haga clic en Crear un plan de energia en el menl izquierdo y
seleccione las opciones para crear un plan nuevo. Haga clic en Cambiar la configuracion del plan y haga clic en Cambiar
la configuracion avanzada de energia para acceder a mas opciones de configuracion.

See ==
o f} J| @ = Cpuones de mergla » Configeracién del satema | 45 I Acsear )
L
Definir bos botones de encendida y activar la proteccidn con contraseda
o darle § i del egraipe 1 Ui e plan e energia deseado en € equips. Los camibios resiSades en b contiuiacién St esta pagina st
e el empertarmarts 4 " g cerd: ntigha aplacan # becks ben planes de trers
ko1 botones de encandido. i s planes S
A - @ Cambiar ks configunacién sciusimente no daporsbie

b el st e %

e e la taps ’ Configuracion de los botones y i tapa de encendido y de suspenuion

Creae un plan de energia Con comente

it b congars o e e I

0 ey cutnde s 1paga Randimiaree: 9

astsls Al presionar e boton de
i . Q= P— 2

caenca con wasa

by okl C i i conbquracion del pies i Al prrsiorias o betin de Eﬁ'.&_kmm

‘B¢ nnpenucn 6 spenaitn | Spemter. =
O Ajuste o beills de bn pardaly ‘zi'_

‘ﬁ Al el tap Sangender = | Sowpnder )

Resciivacion protegeda con contrasei

Cusnda ol equips 1e reactive despuds de eikar en nespensian, nadie padii tenes acy xese s o detes
8 pearrs e ecriba s centrieis cameas pars desbloguesr o equipo. Lt

Cunnn o agreipes e rebemive & st b end tucpeniibn, cuslquats parssas paded sbtanar accass »
le datos perque ol emupes ne et Blzquesds

Nota: Suspension es el estado de ahorro de energia predeterminado en Windows Vista

Figura 13 - Opciones de energia
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Informacién de la bateria
Por favor, siga estas sencillas indicaciones para conseguir el mejor resultado al usar su
bateria.

Carga de la bateria en ordenadores Modelos By C

Tenga en cuenta que los ordenadores Modelos B y C con mucha carga (p. ej. utilizando
aplicaciones que requieren mucho procesamiento de video), mientras funcionan con bateria,
tardaran tiempo (3 a 20 minutos antes de comenzar la carga) en comenzar a recargar la bateria
cuando se enchufen al adaptador AC/DC. Esto sucede por seguridad de manera que la carga
de la bateria s6lo debe comenzar cuando el ordenador ha alcanzado una temperatura segura
para hacerlo.

Asegurese de guardar su trabajo cuando el LED de la bateria parpadee en naranja y enchufar
el adaptador AC/DC. El LED de la bateria cambiara de parpadear en naranja a naranja fijo
cuando comience la carga (3 a 20 minutos antes de iniciar la carga).

.|
Funciones de administracion de energia - 157

\ A/
26
Aviso de bateria baja

Cuando la bateria esté
critica, conecte
inmediatamente =]

adaptador (07: Ell
ordenador o guarde su
trabajo, si no, los datos no
guardados se perderan
cuando se quede sin
energia.
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Instalacion de controladores

El CD-ROM Device Drivers & Utilities + User’s Manual
contiene los controladores y utilitarios necesarios para
utilizar el ordenador correctamente. Inserte el CD-ROM y
haga clic en Install Drivers (boton), u Option Drivers
(boton) para acceder al menu de controladores opcional.

Instale los controladores en el orden indicado en la Tabla 5.
Tras instalar cada controlador, quedara en gris (si necesita
volver a instalar un controlador, haga clic en el botén
Unlock).

Instalacion manual del controlador
Haga clic en el botén Browse CD en la aplicacion Drivers
Installer y busque el archivo ejecutable en la carpeta de
controladores apropiada

Windows Update

Tras instalar todos los controladores asegurese de haber
habilitado Windows Update para obtener las ultimas
actualizaciones de seguridad, etc. (todas las actualizaciones
incluiran los ultimos parches de Microsoft).

158 - Instalacion de controladores

Controlador (Windows Vista) Péagina #
Video (VIA-Modelo A) pagina 159
Video (NVIDIA-Modelos B & C) pagina 159
Sonido pagina 159
Moédem pagina 159
Red (LAN) pagina 159
TouchPad (almohadilla tactil) pagina 159
Lector de tarjetas pagina 159
Hot-Key pagina 160
Botones rapidos de aplicaciones pagina 160
LAN Wireless (opcion) pagina 161
Céamara PC (opcioén) pagina 162
Lector de huellas digitales (opcion) pagina 166

Bluetooth (opcion)

Nota: No se requiere instalacion de controladores (vea la

pégina 168)

USB Advance AP (Modelo A)

pagina 160

Activar Windows Update (ver a la izquierda)

Tabla 5 - Procedimiento de instalacién




Procedimiento de instalacion de los
controladores

Video (VIA - Modelo A)

1. Hagaclic en Install Drivers.

2. Hagaclic en 1.Install Video Driver > Si.

3. Haga clic en Siguiente > Siguiente.

4. Haga clic en Finalizar para reiniciar el sistema.

Video (NVIDIA - Modelos B & C)

1. Hagaclic en Install Drivers.

2. Hagaclic en 1.Install Video Driver > Si.

3. Haga clic en Siguiente.

4. Haga clic en Finalizar para reiniciar el sistema.

Sonido

1. Hagaclic en Install Drivers.

2. Haga clic en 2.Install Audio Driver > Si.

3. Haga clic en Siguiente.

4. Haga clic en el boton Acepto, luego haga clic en
Siguiente.

Haga clic en Siguiente > Siguiente > Siguiente.
6. Haga clic en Terminar para reiniciar el sistema.

o
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Modem

1.

2
3.
4

Haga clic en Install Drivers.

. Haga clic en 3.Install Modem Driver > Si.

Haga clic en Aceptar.

. EI modem esta listo para la configuracion del acceso

telefénico.

Red (LAN)

1.

2
3.
4

Haga clic en Install Drivers.

. Haga clic en 4.Install LAN Driver > Si.

Haga clic en Aceptar.

. Ahora se pueden configurar los pardmetros de red.

Lector de tarjetas

1.

2.
3.
4.

Haga clic en Install Drivers.

Haga clic en 5.Install Cardreader Driver > Si.
Haga clic en Siguiente > Siguiente.

Haga clic en Terminar para reiniciar el sistema.

TouchPad

1.

2
3.
4

Haga clic en Install Drivers.

. Haga clic en 6.Install Touchpad Driver > Si.

Haga clic en Siguiente.

. Haga clic en Finalizar > Reinicar ahora para reiniciar el

sistema.

Instalacion de controladores - 159
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Hot-Key

1. Hagaclic en Install Drivers.

2. Haga clic en 7.Install Hotkey Driver > Si.

3. Haga clic en Next > Install.

4. Haga clic en Finish > Finish para reiniciar el sistema.

Botones rapidos de aplicaciones

Si no tiene un modulo de Camara PC instalado, puede
instalar el controlador de botones rapidos (QButton) para
poder utilizar los botones Hot-Key para abrir las aplicaciones
elegidas (consulte “Botones rapidos de aplicaciones” en la
pagina 147 para mas detalles).

Deberd instalar el controlador de Botones rapidos
(QButton) manualmente, pues no aparece en el mend
Drivers Installer.

1. Inserte el CD-ROM en la unidad de CD/DVD y haga clic
en Browse CD (boton).

2. Haga doble clic para abrir las siguientes carpetas Option >
QButton.

3. Haga doble clic en Setup.exe.

4. Haga clic en Siguiente > Finalizar para reiniciar el
sistema.

USB Advance AP (Modelo A)

Instale este controlador sélo para los ordenadores Modelo
A. Esto ayudard a prevenir que los teclados y/o ratones
USB 1.1 dejen de responder tras reanudar desde el estado de
ahorro de energia Hibernacion.

Haga clic en Option Drivers (boton).

Haga clic en 4.USB Advance AP > Si.

Haga clic en Close para completar la instalacion.
Asegurese de ejecutar Windows Update (consulte
“Windows Update” en la pagina 158) para comprobar las
actualizaciones necesarias.

PO
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LAN Wireless Conectar aunared inalambrica
Compruebe que el mddulo WLAN esté activado.
/ 1. Hagaclic en el icono WLAN en la barra de tareas, y luego
i ) i haga clic en Conectarse a una red (o haga clic con el boton
Bot6n de encendido para el médulo WLAN derecho en el icono [, y luego haga clic en Conectarse a
Active la alimentacién al médulo WLAN utilizando la combina- unared).
cion de teclas (Fn + F11). Cuando el médulo WLAN esta encen- 2. Enlalista Mostrar, haga clic en Inaldmbrico en el menu
dido, el LED ) estara en verde y el indicador  _&) desplegable.
aparecera brevemente. 3. Aparecera una lista con las redes disponibles.
4. Haga clic en unared y luego en Conectar.
. 5. Sinove lared a la que quiere conectarse, haga clic en
Instalacidén del controlador del médulo Configurar una conexién o red (apareceré una lista con
opciones permitiendo la busqueda manual y creando una
WLAN nueva red).
1. Compruebe que el mddulo esté activado. 6. Mueva el cursor sobre el icono [E4 de la barra de tareas para
2. Haga clic en Option Drivers (botén). ver el estado de la conexion.
3. Haga clic en 1.Install WLAN Driver > Si. 7. Para desconectarse de la red inalambrica puede hacer clic en el
4. Elija el idioma que prefiera y haga clic en Siguiente. icono E inalambrico de la barra de tareas y Iuegq seleccionar
) . Conectar o desconectar para acceder al ment de lared y
5. Haga CI!C en Slgm_ente > Installer. ) ) hacer clic en Desconectar (o haga clic con el botdén derecho
6. Haga clic en Terminar para completar la instalacién. en el icono [, y luego haga clic en Desconectar de).

Nota: EI sistema operativo es la configuracion
predeterminada para el control de LAN inaldmbrica en
Windows Vista.

. |
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Camara PC

Hay 2 opciones de camara disponibles para este ordenador.
El modulo camara de 1,3M pixeles utiliza la aplicacion
BisonCap para capturar archivos de video. EI médulo
camara de 2,0M pixeles utiliza la aplicacion VideoView
para capturar archivos de video.

Instalacion del controlador de la
camara PC

Para modulo de camara PC 1,3M pixeles:
1. Encienda el médulo utilizando Fn + F10 (el indicador
__@ aparecera brevemente cuando se encienda el
modulo).

2. Haga clic en Option Drivers (boton).

3. Haga clic en 2.Install Camera Driver > Si.

4. Elija el idioma que prefiera y haga clic en Siguiente >
Siguiente.

5. Haga clic en Finalizar para reiniciar el sistema.

6. Ejecute el programa de la aplicacion BisonCap desde el
acceso directo (BisonCam) en el escritorio o desde la
opcioén BisonCam en el mend Inicio > Programas/Todos
los programas (si el hardware esta apagado utilice la
combinacion de teclas Fn + F10 para volver a
encenderlo).

Para modulo de camara PC 2,0M pixeles:
1. Encienda el mddulo utilizando Fn + F10 (el indicador
__ aparecerd brevemente cuando se encienda el

modulo).

Haga clic en Option Drivers (boton).

Haga clic en 2.Install Camera Driver > Si.

Haga clic en Installer.

Haga clic para seleccionar Si o No para responder a la

pregunta de energia del sistema.

6. Haga clic en Finalizar > Finalizar para reiniciar el
sistema.

7. Ejecute el programa de la aplicacion VideoView desde el
acceso directo (VideoView) en el escritorio o desde la
opcién USB2.0 PC Camera en el menu Inicio >
Programas/Todos los programas (si el hardware esta
apagado utilice la combinacion de teclas Fn + F10 para
volver a encenderlo).

ok wn

4

Configuracion de la Combinacién de colores

Antes de ejecutar la aplicacion de la camara PC, compruebe
que la Combinacion de colores en Windows Vista esté ajus-
tada a Aero de Windows (Panel de control > Aparienciay
personalizacion > personalizacién > Color y apariencia
de las ventanas).
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Botones Hot-Key para Camara PC Configuracion del audio de la camara
Puede usar los botones Hot-Key para Cdmara PC & (& PC

para ejecutar el programa BisonCap/VideoView y tomar  configure las opciones de grabacion de audio en Windows
imégenes instantaneas y aumentar y alejar con la cmara  para capturar video & audio con su camara

(Modelos A & B solamente).

1. Hagaclic en Inicio (menu), y haga clic en Panel de control
Boton Hot-Key Funcion (o vaya a Configuracion y haga clic en Panel de control).
2. Haga clic en Sonido “** (Hardware y sonido).
Activar programa BisonCap/VideoView/ 3. Haga clic en Grabar (ficha).
(.Q tomar imagen instantanea (vea la 4. Haga clic con el botén derecho en “Micréfono (VIA High
pagina 165) Definition Audio)” (micréfono externo)/“Front Mic (VIA High
Definition Audio)” (micr6fono interno)”y compruebe que el
Modelos Aumentar zoom de camara (vea la ftem esté deshabilitado.
A&B pagina 165) 5. Haga doble clic en Micréfono/Front Mic (o seleccione
. - Propiedades en el menu contextual).
Modelos Disminuir zogm de camara (vea la 6. Haga clic en Niveles (ficha) y ajuste el control deslizante de
A&B pagina 165) Micréfono hasta el nivel deseado.
] ] 7. Haga clic en Aceptar y cierre los paneles de control.
Figura 14 - Botones Hot-Key para Camara PC 8. Ejecute el programa BisonCap/VideoView en el mena Inicio
> Programas/Todos los programas > BisonCam/USB2.0
PC Camera.

9. Vaya al menu Devices (Dispositivos) y seleccione
Micréfono/Front Mic (VIA High Definition Audio) (deberia
tener una marca al lado).

10. Vaya al menu Capture (Capturar) y seleccione Capture
Audio (deberia tener una marca al lado).

. |
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BisonCap/VideoView

Las aplicaciones BisonCap (para la cdmara de 1,3M pixeles)
y VideoView (para la cdmara de 2,0M pixeles) son visores de
video Utiles para el propésito general de visualizacion y
comprobacion de video y pueden capturar archivos de video en
formato .avi.

1. Ejecute el programa BisonCap/VideoView en el menu Inicio
> Programas/Todos los programas > BisonCam/USB2.0
PC Camera (se recomienda que Ajuste el archivo de
captura antes del proceso de captura - ver “ Ajustar archivo
de captura” a continuacion).

2. Vaya al menu de Capture (Capturar) (si desea capturar audio
consulte “Configuraciéon del audio de la camara PC” en la
pagina 163) y seleccione Start Capture (Iniciar captura).

3. Haga clic en OK (Aceptar) (la ubicacion del archivo aparecera
en el cuadro emergente) para iniciar la captura y pulse Esc
para detenerla (puede ver el archivo usando Windows
Media Player).

Ajustar archivo de captura

Antes de capturar archivos de video puede seleccionar la
opcion Set Capture File... (Ajustar archivo de captura...) en el
menu File (Archivo) y ajuste el nombre del archivo y la
ubicacion antes de capturar (esto ayudara a evitar sobrescribir
archivos accidentalmente). Ajuste el nombre y la ubicacién y
luego haga clic en Abrir, luego ajuste el "Tamafio del archivo
de captura": y haga clic en OK (Aceptar). Luego podra iniciar
el proceso de captura como arriba.

Eliminar el parpadeo de pantalla

Si la pantalla de video del programa BisonCap/ VideoView
parpadea, puede intentar ajustar la configuracion en las
opciones Video Capture Filter.

Para BisonCap:
1. Ejecute el programa BisonCap.

2. Vaya al menu de Options y seleccione Video Capture
Filter....

3. Haga clic en 50Hz o0 60Hz bajo Frecuencia en Pagina de
propiedades (ficha).

Para VideoView:

1. Ejecute el programa VideoView.

2. Vaya al menl de Options y seleccione Video Capture
Filter....

3. Haga clic en 50Hz o0 60Hz bajo Flickering Reduction en
Image (ficha).
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Tomar imagenes instantaneas
Los programas BisonCap y VideoView le permiten tomar
fotos instantaneas.

1. Ejecute el programa BisonCap/VideoView.

2. (BisonCap) Vaya al menu de Options y seleccione Take
Picture.
o
(VideoView) Vaya al menu de Capture y seleccione
SnapShot.

3. Laimagen (en formato JPEG) sera colocada en la carpeta
Snapshot _l:| en el escritorio (no mueva ni cambie el
nombre de la carpeta).

Zoom
Los programas BisonCap y VideoView le permiten acercar
y alejar con la cAmara.

Para BisonCap:
1. Ejecute el programa BisonCap.
2. Vaya al menl de Zoom y seleccione ZoomOut/Zoom In.

Para VideoView:
1. Ejecute el programa VideoView.

2. Vaya al menl de Options y seleccione Setting (utilice el
control deslizante para ajustar el nivel del zoom y haga clic en
OK para guardar la configuracion).
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Agregar o Quitar una Camara PC

Tenga en cuenta que los controladores de los botones rapidos
y Camara PC no pueden estar instalados a la vez.

Si desea afiadir un médulo de camara PC a su ordenador méas
tarde, desinstale el controlador de Botones rapidos (llamado
Multimedia Keyboard Driver) antes de instalar PC camara y
el controlador. Los controladores pueden desinstalarse desde
el panel de control Programas y caracteristicas en Windows.

Si desea quitar un mddulo de Camara PC de su ordenador
mas tarde, desinstale el Controlador de Camara PC tras quitar
el médulo de la camara. Entonces podra insertar el CD-ROM
Device Drivers & Utilities + User's Manual e instalar el
controlador de botones rapidos (QButton) desde el menu
Drivers Installer.
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Lector de huellas digitales

Si su opcién de compra incluye un lector de huellas
digitales (opcional sélo para ordenadores Modelos B y C)
necesitara instalar el controlador como se indica a
continuacion.

Aseglrese de tener derechos de administrador en su
ordenador y de tener una contrasefia Windows habilitada
para una proteccioén de seguridad completa.

Antes de comenzar el proceso de inscripcion, se
recomienda que siga el tutorial de huellas digitales. Para
ejecutar el tutorial, haga clic en Inicio > Programas/Todos
los programas > Protector Suite QL > Tutorial de
huellas digitales.

Instalacion del controlador para

huellas digitales

1. Haga clic en Option Drivers (boton).

Haga clic en 3.Install FingerPrint Driver > Si.
Haga clic en Instalacion del software.

Haga clic en Siguiente > Siguiente > Siguiente.
Haga clic en Finalizar > Si para reiniciar el sistema.

armDN
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Ayuda & Manual

Haga clic con el botén derecho en el icono de la barra de ta-
reas [ para abrir el menu y seleccionar Ayuda.

Inserte el CD-ROM Device Drivers & Utilities + User's Ma-
nual y haga clic en Option Drivers (botén). Haga clic en Un-
lock (boton) y luego haga clic en 3.Install FingerPrint
Driver > Si.

Haga clic en Documentacion para abrir la carpeta que contiene
el manual en formato .pdf.

Para instalar el Adobe Acrobat Reader para leer el archivo, inserte
el CD-ROM Device Drivers & Utilities + User's Manual y haga clic
en User’s Manual (botén) y haga clic en Install Acrobat Reader
(botén).

Inclusion de usuarios

1.

Haga clic en Inicio > Programas/Todos los programas >
Protector Suite QL > Inclusién de usuario, o haga doble
clic en el icono [f£] en la barra de tareas.

La primera vez que ejecute el programa se le pedira que haga

clic en el boton para aceptar la licencia, luego haga clic en
Aceptar.

Haga clic en Siguiente y seleccione “Registro en el disco
duro”, y haga clic en Finalizar.



10.

11.

12.
13.
14.

Si no ha configurado una contrasefia de Windows se le
pedira que lo haga (nota: Si no ha configurado una
contrasefia Protector Suite QL no puede asegurar el acceso
a su ordenador).

Haga clic en Siguiente y se le pedira que escriba su
contrasefia de Windows.

Haga clic en Siguiente > Siguiente (puntee en el cuadro
“Ejecute el tutorial interactivo” para ejecutar el Tutorial de
huellas digitales).

Haga clic en Siguiente en cada ventana del tutorial (puede
hacer clic en el botén “Omitir el tutorial” en cualquier
momento).

Haga clic en el bot6n sobre cualquiera de las huellas digitales
para iniciar el proceso de inclusion de ese dedo.

Coloque el dedo tres veces para incluirlo.

Repita el proceso para todos los dedos que desee incluir (ver
abajo), y luego haga clic en Siguiente > Finalizar.

Haga clic en cualquiera de los titulos en “Obtener mas
informacion:” para obtener mas informacion sobre un tema.
Haga clic en Cerrar.

Reinicie el ordenador.

Haga clic con el boton derecho en el icono E| de la barra de
tareas para abrir el menu que le permitird Editar huellas
digitales, iniciar el Centro de control, acceder al menu
Ayuda, etc. También puede ejecutar el Centro de control
etc. desde la opcion Protector Suite QL en el menu Inicio >
Programas/Todos los programas.
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15. Consulte “Ayuda & Manual” en la pagina 166 para mas
detallas.

16. Si coloca su dedo sobre el lector en cualquier momento,
podra acceder al BiomenU para bloquear el ordenador,
registrar sitios de la web, Desbloquear Mi seguridad, abrir
el Centro de control y acceder al mend Ayuda

17. El Centro de control le permite cambiar la Configuracién,
registrar huellas digitales y obtener Ayuda.

f T ]

Introduccidn a Protector Suite QL

-
| .

AN
I

Inclusién de huellas digitales

Tenga en cuenta que se recomienda encarecidamente que
incluya mas de un dedo en caso de lesidn, etc.

Figura 15 - Inclusién de huellas digitales
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Configuracion de Bluetooth en
Windows Vista

Configurar su dispositivo Bluetooth para
gue el ordenador pueda encontrarlo

1.

Encienda su dispositivo Bluetooth (p. ej. PDA, teléfono movil,
etc.).

Deje al dispositivo accesible (para hacerlo consulte la
documentacion del dispositivo).

Para encender el médulo Bluetooth

1.

Utilice la combinacién Fn + F12 para activar el médulo
Bluetooth.

Aparecera un icono de Bluetooth [J en la barra de tareas
(puede que necesite activar la opcion del panel de control
Bluetooth).

Luego podra hacer lo siguiente para acceder al panel de
control Dispositivos Bluetooth.

» Haga doble clic en el icono 3 para acceder al panel de
control Dispositivos Bluetooth.

» Hagaclic en Inicio (men0) y haga clic en Panel de control
(o vaya a Configuracion y haga clic en Panel de control),
y luego haga clic en Dispositivos Bluetooth (Hardware y
sonido).

« Haga clic en/Haga clic con el bot6n derecho en el icono 3
y elija una opcion desde el mena.

D Cupoukives B =

4

Transferenciade datos
Bluetooth

Tenga en cuenta que la
transferencia de datos
e entre el ordenador y un

= dispositivo con Bluetooth
se realiza sélo en una
direccién (no soporta
la transferencia de da-
tos simultanea).

Agregar un dispositive Bluetooth

PMostrar dispositivos Bluetooth

Enviar un archive

Recibir un archivo
Unirse a una red de drea personal

Abrir la configuracién Bluetooth

Quitar el icono Bluetooth

Figura 16 - Dispositivos Bluetooth y menu contextual

del icono

Para agregar un dispositivo Bluetooth

1.
2.

Acceda al panel de control Dispositivos Bluetooth.

Haga clic en Opciones (ficha), y asegurese de que la casilla
de verificacion Permitir que los dispositivos Bluetooth se
conecten a este equipo (Conexiones) esta marcada.

Haga clic en Dispositivos (ficha), luego haga clic en Agregar.
El Asistente para agregar dispositivos Bluetooth aparecera.

.|
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5. Haga clic para seleccionar “Mi dispositivo esta configurado
y listo para ser detectado”, luego haga clic en Siguiente.

| 0 sotiomis pame rgrrg dupmnirni Moo ELE | | 0 sstrote pa sgevam scmcanens Barcom
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Figura 17 - Asistente para agregar dispositivos Blue-
tooth

6. El Asistente buscara los dispositivos Bluetooth dentro del
alcance.

7. Seleccione la unidad con la que se desea comunicar y haga
clic en Siguiente.

8. Seleccione una opcion de clave de paso apropiada y haga clic
en Siguiente > Finalizar.

10 famirns pac wpuger srgatrs s =
Mecesn una cheve e s s agreg s dapostiva T B

Figura 18 - Opciones de clave de paso
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Para cambiar la configuracion del
dispositivo Bluetooth

1. Acceda al panel de control Dispositivos Bluetooth.

2. Haga clic en el dispositivo que desea cambiar y haga clic en
Propiedades para:

¢ Cambie el nombre del dispositivo (haga clic en General,
escriba un nuevo nombre y haga clic en Aceptar).

¢ Activar/desactivar un servicio (haga clic en Servicios,
marque/quite la casilla de verificacion junto al servicio y
haga clic en Aceptar).

Para hacer su ordenador accesible a
dispositivos Bluetooth

1. Acceda al panel de control Dispositivos Bluetooth.

2. Haga clic en Opciones (ficha), y asegurese de que la casilla
de verificacion Permitir que los dispositivos Bluetooth
encuentren este equipo (Descubrimiento) esta marcada.

3. Asegurese de que la casilla de verificacion Alertarme
cuando un nuevo dispositivo Bluetooth desee conectarse
(Conexiones) esta marcada si desea que se le avise cuando
un dispositivo Bluetooth quiera conectarse.

[T Compamiiens Biesrestn =

[ T

Figura 19
Dispositivos
Bluetooth -

Opciones

.|
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Solucidon de problemas

Problema

Posible causa - Solucion

Los médulos WLAN y
Bluetooth no pueden
detectarse.

El (Los) médulo(s) esta(n) desactivado(s). Compruebe el indicador LED ) para ver si el médulo
esté activado o desactivado (consulte “Indicadores LED” en la pagina 143). Si el indicador LED
esta apagado, entonces pulse la(s) combinacion(es) Fn + F11 (WLAN) o Fn + F12 (Bluetooth) para
activar el modulo(s) (vea la Tabla 3 en la pagina 145).

El médulo Bluetooth esta
apagado tras reanudar desde
la Suspension.

El estado predeterminado del médulo Bluetooth sera apagado tras reanudar desde el estado de
ahorro de energia Suspension. Utilice la combinacion de teclas (Fn + F12) para encender el modulo
Bluetooth tras reanudar el ordenador desde Suspensién.

Un archivo no puede copiarse
a o desde un dispositivo
conectado con Bluetooth.

La transferencia de datos entre el ordenador y un dispositivo con Bluetooth se realiza s6lo en una
direccién (no soporta la transferencia de datos simultanea). Si copia un archivo de su ordenador a un
dispositivo con Bluetooth, no podra copiar un archivo del dispositivo Bluetooth a su ordenador hasta
gue se haya completado el proceso de transferencia del ordenador.

Los archivos de video
capturados de la camara PC
ocupan demasiado espacio
en el disco.

Tenga en cuenta que capturar archivos de video de alta resolucion requiere una cantidad sustancial
de espacio en el disco para cada archivo.

Tenga en cuenta que el sistema Windows Vista requiere un minimo de 15GB de espacio libre en la
particion del sistema unidad C:. Se recomienda que guarde el archivo de video capturado en una
ubicacién distinta a la unidad C:, limite el tamafio de archivo del video capturado o reduzca la
resolucion del video (Options > Video Capture Pin... > Tamafio de salida).
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Error de resolucién de pantalla (Modelos B & C)

Si experimenta una reduccion de la resolucion en pantalla o si la pantalla parpadea tras reiniciar desde el estado de

Suspension en Windows Vista solamente, siga estas instrucciones para solucionar el problema. Este error surge por el

funcionamiento interno de Windows Vista, que activa TMM (Transient Multimon Manager) cuando la tapa del portétil

(S3) se cierra. TMM desconecta la pantalla LCD del SO y luego vuelve a encenderla cuando la tapa se abre. Esto puede

hacer que TMM cambie a una configuracion de pantalla antigua y puede provocar que la pantalla parpadee o un cambio

en la resolucion.

1. Hagaclic en Inicio (menu), y haga clic en Panel de control (o vaya a Configuracion y haga clic en Panel de control) y haga
doble clic en Herramientas administrativas (Sistemay Mantenimiento).

2. Haga doble clic en Programador de tareas (Programar tareas).

3. Haga doble clic en Biblioteca del Programador de tareas > Microsoft > Windows, y haga clic en MobilePC para abrir el panel de
control.

4. Haga clic con el boton derecho en TMM y seleccione Deshabilitar, y luego cierre todos los paneles de control.

. 4
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Especificaciones
4

Informacién actualizada de especificaciones

Las especificaciones listadas en este Apéndice son correctas en el momento de publicacion. Ciertas opciones (particularmente tipos/
velocidades de procesadores) pueden cambiar o actualizarse segun la fecha de lanzamiento del fabricante. Dirfjase a su centro de
servicios para mas detalles.

Caracteristica Especificacion

Tipos de Procesador Intel Core 2 Duo (65nm) tecnologia de proceso de 65 nm

procesadores Micro-FCPGA package (478 contactos) Caché de nivel 2 de 4MB & bus de sistema de 800MHz
T7300/ T7500/ T7700/ T7800 2,0/2,2/ 2,4/ 2,6 GHz
Procesador Intel Core 2 Duo (65nm) tecnologia de proceso de 65 nm
Micro-FCPGA package (478 contactos) Caché de nivel 2 de 2MB & bus de sistema de 800MHz
T7100 1,8 GHz
Procesador Intel Celeron M (65nm) tecnologia de proceso de 65 nm
Micro-FCPGA package (478 contactos) Caché de nivel 2 de 1MB & bus de sistema de 533MHz
530/ 540/ 550 1,73/ 1,86/ 2,0 GHz

Nucleo Logic VIA VN896CE + VT8237A

Memoria Dos zécalos de 200 pins SODIMM, para memoria DDRII (DDR2) 533/ 667
Memoria expansible hasta 2GB

Seguridad Ranura para cierre de seguridad (tipo Kensington®) Contrasefia de BIOS

.|
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Caracteristica

Especificacién

BIOS

Phoenix BIOS (SPI Flash ROM de 8Mb)

Phoenix BIOS

Opciones del
LCD

Modelos A & B

15,4" - WXGA (1280 * 800) TFT LCD
15,4" - WXGA+ (1440 * 900) TFT LCD

Modelo C

17,0" - WXGA (1440 * 900) TFT LCD
17,1" - WSXGA+ (1680 * 1050) TFT LCD
17,1" - WUXGA (1920 * 1200) TFT LCD

Dispositivos de
almacenamiento

Una unidad de dispositivo 6ptico (CD/DVD) de 12,7mm(h) intercambiable (consulte “Opciones” en la
pagina 175 para las opciones del médulo de unidad éptica)

Un HDD SATA facil de cambiar de 2,5" 9,5 mm (h)

Audio Interfaz compatible AZALIA integrada 2 altavoces incorporados
Sistema de sonido estéreo 3D Micréfono incorporado
Compatible con Sound-Blaster PRO™
Pantalla Modelo A Modelos B & C
Sistema de Video Integrado VIA VN896CE Sistema de video discreto NVIDIA GeForce 8400M
(Chip Interno) G (NB8M-SE) (Externo Incorporado)
Motor para gréficos 128-bit 2D/3D de integrado TurboCache™ Total Graphics Memory hasta 895MB
Soporta la resolucién de pixel de monitor analégico (con memoria del sistema)
hasta 2048 * 1536 128MB de RAM de video DDR-3 incorporada
Compatible con DirectX® 9 Soporta pantalla dual y frecuencias de refresco ergo-
némicas hasta 2048 * 1536
Compatible con DirectX® 10
Teclado Teclado “Win Key”

Especificaciones - 173




Guia del Usuario Concisa

Caracteristica Especificacién

Dispositivo TouchPad incorporado (funcionalidad de tecla de desplazamiento integrada)

puntero

Interfaz Tres puertos USB 2.0 Un conector de salida S/PDIF
Un puerto para monitor externo Un conector RJ-11 para médem
Un conector de salida de altavoces/auriculares Un conector RJ-45 para LAN
Un conector de entrada para micr6fono Un conector de entrada de CC
Un conector de entrada de linea

Lector de Mdodulo lector de tarjetas 7 en 1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)

tarjetas Nota: Tarjetas MS Duo/ Mini SD/ RS MMC requieren PC adaptador

Comunicaciones | Fax/M6dem de 56K Plug & Play (compatible con V.90  Médulo camara PC USB del1,3M o 2,0M pixeles
y V.92) (opcion de fabrica)

LAfN Ethernet de 10Mb/100Mb ) Médulo Bluetooth USB + EDR - V2.0 (opcién de
Médulo WLAN USB 802.11b/g (opcién) fabrica)

Ranura RanuraExpressCard/54(34)
ExpressCard

Administracion Soporta ACPI v2.0
de energia
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Caracteristica Especificacién

Alimentacion Modelos A & B Modelo C
Adaptador de CA/CC autodetector de corriente Adaptador de CA/CC autodetector de corriente
Entrada CA: 100-240V, 50-60Hz Entrada CA: 100-240V, 50-60Hz
Salida CC: 19V, 3,42A O 18,5V, 3,5A (65W) Salida CC: 19V, 4,74A (90W)

Bateria de Smart Lithium-lon (6 elementos), 4000mAH (Todos modelos)
o}
Bateria de Smart Lithium-lon (6 elementos), 4400mAH (Modelos B & C)

Especificaciones | Temperatura Humedad relativa
del ambiente En funcionamiento: 5°C - 35°C En funcionamiento: 20% - 80%
Apagado: -20°C - 60°C Apagado: 10% - 90%
Dimensiones y Modelos A & B Modelo C
Peso 360 (a) x 267 () x 25,4 - 34 (h) mm 397 (a) x 280,5 (I) x 39 (h) mm
2,6 kgs con bateria de 6 elementos 2,98 kgs +/- 3% con bateria de 6 elementos y sin
maédulos opcionales

Opciones Opciones del médulo de unidad 6ptica: Lector de huellas digitales

Unidad combinada (opcion de fabrica - s6lo para Modelos B & C)

Unidad de DVD-Dual (S Multi
nidad de ual (Super Mult) Médulo camara PC USB del,3M o 2,0M pixeles
Modulo WLAN USB 802.11b/g (opcidn de fabrica)

Modulo Bluetooth USB + EDR - V2.0 (opcion de
fabrica)
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AVVisO

La societa si riserva il diritto di revisionare la presente pubblicazione o di modificarne il contenuto senza preavviso. Le
informazioni qui contenute sono per solo riferimento e non costituiscono obbligo sulle parti del produttore o di qualsiasi
venditore successivo. Essi non si assumono alcuna responsabilita o obbligo per qualsiasi errore o imprecisione presente in
questa pubblicazione, né sono responsabili per qualsiasi perdita o danno risultante dall'uso (o cattivo uso) della presente
pubblicazione.

Questa pubblicazione e ogni software fornito a corredo non puo, in parte o per intero, essere riprodotta, tradotta, trasmessa
o ridotta in una forma leggibile da macchine senza previo consenso dei venditori, produttori e creatori della pubblicazione
stessa, eccetto per le copie tenute dall'utente a scopo di backup.

I marchi e i nomi dei prodotti menzionati in questa pubblicazione possono 0 meno costituire copyright e/o marchi registrati
delle rispettive societa. Essi sono menzionati per solo scopo identificativo e non sono intesi come avallo di tale prodotto o
del suo produttore.

© Novembre del 2007

Marchi registrati

Il presente prodotto incorpora una tecnologia di protezione di copyright protetta dalle rivendicazioni di metodo di alcuni
brevetti degli Stati Uniti o di altri diritti di proprieta intellettuale posseduti da Macrovision Corporation e altri possessori
di diritti. L'uso di questa tecnologia di protezione di copyright deve essere autorizzata da Macrovision Corporation, ed &
intesa per I'uso domestico o altri usi di visualizzazione limitata solo se non diversamente autorizzato da Macrovision
Corporation. La decodifica, la decompilazione e il disassemblaggio sono proibiti.

Intel, Celeron, ed Intel Core sono marchi/marchi registrati della Intel Corporation.

Avviso - 177
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Informazioni sulla Guida Rapida per I'Utente

Questo manuale rappresenta un’introduzione rapida all’avvio del sistema. Si tratta di un supplemento e non di una
sostituzione del Manuale per I'utente completo in lingua inglese nel formato Adobe Acrobat, memorizzato sul CD-ROM
Device Drivers & Utilities + User's Manual fornito a corredo del computer. Inoltre, questo CD-ROM contiene i driver e
le utilita necessari per il corretto uso del computer.

E possibile che alcune o tutte le funzionalita del computer siano gia state configurate. In caso contrario, o se si sta
pianificando di riconfigurare (o reinstallare) componenti del sistema, fare riferimento al Manuale utente completo. Il CD-
ROM Device Drivers & Utilities + User’s Manual non contiene il sistema operativo.

Informazioni di regolamentazione

Le informazioni e le comunicazioni di regolamentazione sono contenute nel Manuale utente completo memorizzato sul
CD-ROM Device Drivers & Utilities + User’s Manual.

2N\
I

Funzionamento delle periferiche wireless in aereo

In genere, l'utilizzo di dispositivi di trasmissione elettronici portatili & proibito a bordo degli aerei.
Accertarsi che i moduli wireless siano spenti quando si utilizza il computer in aereo.
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Istruzioni per la custodia e il funzionamento

Il computer notebook & abbastanza rigido, ma & possibile che possa essere danneggiato. Per evitare qualsiasi danno,
attenersi ai seguenti suggerimenti:

« Non lasciarlo cadere ed evitare urti. Se il computer cade, & possibile che il telaio e i componenti possano esserne
danneggiati.

« Tenerlo all'asciutto e non provocarne il surriscaldamento. Tenere il computer e lI'alimentazione lontani da ogni tipo di
impianto di riscaldamento. Si tratta di un apparato elettrico. Se acqua o altri liquidi dovessero penetrarvi, esso potrebbe
risultarne seriamente danneggiato.

« Evitare le interferenze. Tenere il computer lontano da trasformatori ad alta capacita, motori elettrici e altri intensi campi
magnetici. Cio ne pud impedire il corretto funzionamento e danneggiare i dati.

» Attenersi alle corrette procedure di lavoro con il computer. Spegnere il computer correttamente e non dimenticare di
salvare il proprio lavoro. Ricordare di salvare frequentemente i propri dati poiché essi potrebbero essere persi nel caso in cui
la batteria si esaurisse.

» Porre particolare cura nell'utilizzo delle periferiche.

Assistenza

Non provare a riparare il computer da soli. Una tale azione invaliderebbe la garanzia ed esporrebbe I'utente del computer
al pericolo di una scossa elettrica. Fare riferimento al personale dell'assistenza autorizzata. Scollegare il computer
dall'alimentazione. Fare riferimento all'assistenza di personale qualificato nei seguenti casi:

e Quando il cavo di alimentazione & danneggiato o logorato.

e Seil computer ¢ stato esposto alla pioggia o ad altri liquidi.

e Se il computer non funziona normalmente dopo aver seguito correttamente le istruzioni operative.

« Seil computer ¢ caduto o si & danneggiato (non toccare il liquido velenoso in caso di rottura dello schermo LCD).
e Sec'e un odore non usuale, calore o fumo che fuoriesce dal computer.

.|
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Guida Rapida per I'Utente

Sicurezza relativa all'alimentazione
Il computer presenta specifici requisiti di alimentazione:

»  Utilizzare esclusivamente un adattatore approvato per I'utilizzo di questo computer.

e L'adattatore CA/CC potrebbe essere stato progettato per viaggi all'estero, ma richiede ugualmente un'alimentazione stabile e
continua. Se non si & certi delle specifiche elettriche locali, consultare I'assistenza tecnica o la societa locale di fornitura elettrica.

» L'adattatore di alimentazione deve avere una spina dotata di messa a terra a due o tre poli. Il terzo polo costituisce un'importante
funzionalita di sicurezza. Non rinunciare al suo impiego. Se non € disponibile una presa compatibile, farne installare una da un
elettricista qualificato.

* Quando si desidera scollegare il cavo dell'alimentazione, accertarsi di scollegarlo toccando la testa della spina, non il suo cavo.

»  Accertarsi che la presa e ogni prolunga utilizzata siano in grado di supportare il carico di corrente totale risultante da tutte le
periferiche collegate.

«  Primadi pulire il computer, assicurarsi di scollegarlo da qualsiasi sorgente di alimentazione esterna.

SN
2L &

Avviso Sicurezza Alimentazione

Prima di effettuare qualsiasi procedura di aggiornamento, accertarsi di aver spento il computer e di aver scollegato tutti i cavi e le
periferiche (incluse le linee telefoniche). E inoltre consigliabile rimuovere la batteria al fine di evitare I'accensione accidentale del

computer.
Spegnimento prima di un viaggio
Assicurarsi che il notebook sia completamente spento prima di inserirlo in una borsa da viaggio (o in un contenitore simile). Inserendo

un computer ancora acceso in una borsa da viaggio, la (le) ventola (ventole) ne saranno ostruite. Per evitare il surriscaldamento del
computer, accertarsi di non ostruire la (le) ventola (ventole) quando il computer & in uso.

Pulizia
Non applicare alcun detergente direttamente sul computer, utilizzare solo un panno morbido e pulito. Non utilizzare
detergenti volatili (distillati di petrolio) o abrasivi su qualsiasi parte del computer.

.|
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Precauzioni relative alla batteria

Utilizza unicamente batterie progettate per questo computer. Un tipo di batteria errato potrebbe esplodere, avere perdite o
danneggiare il computer.

Non continuare a usare in alcun modo una batteria che sia caduta in terra o che sembri danneggiata (es. piegata o torta).
Anche se il computer continua a funzionare con una batteria danneggiata, questa pud provocare danni ai circuiti risultanti in
pericolo di incendio.

Ricaricare le batterie utilizzando il sistema del notebook. Un'operazione di ricarica non corretta puo far esplodere la
batteria.

Non provare a riparare il pacco batteria. Fare riferimento sempre all'assistenza tecnica o a personale qualificato per la
riparazione o la sostituzione del pacco batteria.

Tenere i bambini lontani da una batteria danneggiata e provvedere tempestivamente al suo smaltimento. Smaltire sempre
con cura le batterie. Le batterie possono esplodere o presentare perdite se esposte a fuoco oppure se manipolate o smaltite
impropriamente.

Tenere la batteria lontana da qualsiasi apparecchio di metallo.

Apporre del nastro adesivo sui contatti della batteria prima di smaltirla.

Non toccare i contatti della batteria con le mani o con oggetti metallici.

N A
Z S

Smaltimento della batteria & Attenzione

Il prodotto acquistato contiene una batteria ricaricabile. La batteria € riciclabile. Al termine della durata di uso, in base alle diverse
leggi locali e statali, puo essere illegale smaltire questa batteria insieme ai rifiuti comuni. Controllare i requisiti previsti nella propria

zona consultando i funzionari locali addetti allo smaltimento dei rifiuti solidi per le opzioni di riciclo o lo smaltimento corretto.

=
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Pericolo di esplosione in caso sostituzione errata della batteria. Sostituire solamente con lo stesso tipo o con uno analogo
raccomandato dal produttore. Eliminare la batteria usata seguendo le istruzioni del produttore.
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Guida di avvio rapido

/ 1. Eliminare tutti i materiali di imballo.
Spegnimento 2. Appoggiare il computer su una superficie stabile.

3. Collegare bene le periferiche che si desidera usare con il notebook (per esempio tastiera e mouse)

E importante tenere pre- ) :
alle porte corrispondenti.

sente che & sempre ne-

cessario  spegnere il 4. Collegare I'adattatore CA/CC al jack di ingresso CC situato sul retro del computer, quindi inserire il
computer scegliendo il co- cavo di alimentazione CA in una presa e collegare il cavo di alimentazione CA all'adattatore CA/CC.
mando Arresta il sistema 5. Con una mano sollevare con cautela il coperchio/LCD fino a un angolo di visione comodo, mentre
disponibile dal menu del con l'altra mano (come illustrato nella seguente Figura 1) si mantiene la base del computer (nota:
pulsante Blocca di Win- non sollevare mai il computer tenendolo dal coperchio/LCD).

dows Vista. In questo
modo si evitano problemi
al sistema o al disco rigido.

6. Premere il pulsante di alimentazione per accendere.

Modello C

Si noti che i computer Mo-
dello C sono dotati di di-
spositivi di chiusura sul
coperchio/LCD. Spostare il
dispositivo di chiusura sini-
stro per sbloccare la posi-
zione e far scorrere |l
dispositivo di chiusura di
destra (tenendolo in posi-
zione) mentre si solleva il Figura 1

coperchio. Apertura del coperchio/LCD/Computer con alimentatore AC/DC collegato

o
c
&
'
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Differenze dei modelli
Questa serie di notebook comprende tre tipi di modelli differenti. Le differenze tra i modelli sono riportate nella tabella
seguente.

Funzionalita Modello A Modello B Modello C

Video sistema integrato VIA Sistema video NVIDIA GeForce 8400M G (NB8M-SE) Discrete
VNB896CE (interno sul chip) (esterno su scheda)

Windows Vista Home Basic Edition (64-bit)

Visualizzazione

Ve\r/TSI?:'SS' W(l)rr\g(t);/vs W'ndogjn\i/o'it%j?g?s Basic Windows Vista Home Premium Edition/Business Edition/Enterprise
PP Edition/Ultimate Edition (64-bit)
Lettore d’'impronte :
digitali No opzione
Pulsanti di Zoom e .
i vedere la Tabella 4 a pagina 190
registrazione audio Si E] pag No
Alimentzione 65W (Uscita CC 19V, 3,42A o 18,5V, 3,5A) 90W (Uscita CC 19V, 4,74A)

o

17" WXGA
17,1" WSXGA+
17,1" WUXGA

Tipo di schermo LCD

=
Q
Q
>
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Tabella 1 - Differenze dei modelli
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Software del sistema

E possibile che il software sia gia pre-installato sul
computer. In caso contrario, oppure in casi di
riconfigurazione del computer per un sistema diverso,
questo manuale si riferisce al sistema operativo Microsoft
Windows Vista. Ulteriori informazioni sull’installazione di
driver e utilitd sono disponibili nei Capitoli 4 & 7 del
Manuale per I’utente esteso oppure nel CD-ROM Device
Drivers & Utilities + User’s Manual.

4

Driver

Se si sta installando/disinstallando un nuovo software di siste-
ma, sara necessario installare i driver appropriati. | driver sono
programmi che agiscono da interfaccia tra il computer e il com-
ponente hardware (ad es. il modulo di rete wireless). E molto
importante installare i driver nell'ordine elencato nella
Tabella 5 a pagina 202. Non sara possibile utilizzare la mag-
gior parte dei controlli avanzati finché i driver e le utilitd neces-
sarie non sono state correttamente installate.

Sistemi operativi supportati

Sistema operativo

Nota

Modello A Modelli B & C

*Windows XP (Home Edition o Profes-
sional)

Per avviare Win-
dows Vista senza
limitazioni o presta-

zioni inferiori, &

necessario che il
computer disponga

di almeno 1GB di
memoria di sistema

(RAM).

Windows Vista (64-bit) Home Basic
Editon

Windows Vista (64-bit)
Home Premium Edi-
ton/Business Edition/

Enterprise Edition/Ulti-

mate Editon

*Per informazioni sul SO Windows XP consultare il CD-
ROM Device Drivers & Utilities + User’s Manual.

Non incluso

| sistemi operativi (per esempio Windows Vista/Windows
XP) sono dotati di manuali propri, come pure le
applicazioni (per esempio, programmi di elaborazione
testo, fogli di calcolo e database), quindi consultare i
manuali specifici.
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Descrizione del sistema: Vista superiore con

pannello LCD aperto (Modelli A & B)

2N
LG
Funzionamento del

dispositivo senza fili a
bordo di un aereo

Solitamente I'uso di qualsiasi
dispositivo di trasmissione
elettronica e proibito a bordo
di un aereo. Verificare che i
moduli siano spenti (OFF)
se state usando il

computer a bordo di un
aereo.

Utilizzare la combinazione di
tasti appropriata (vedere

) per
disattivare i moduli WLAN/
Bluetooth e verificare
lindicatore di stato &g per
accertarsi che i moduli siano
spenti (vedere

).

Figura 2 - Vista superiore con pannello LCD aperto (Modelli A & B)

PwbdbPE

BOX® NGO

Camera PC opzionale
Schermo LCD
Altoparlanti incorporati
Pulsante di
alimentazione
Pulsanti Hot-Key
Tastiera

TouchPad e pulsanti
Microfono incorporato
Indicatori LED

. Lettore d'impronte

digitali (opzionale solo
per il Modello B)

ouelfe)|
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Camera PC opzionale
Schermo LCD
Altoparlanti incorporati
Pulsante di
alimentazione
Pulsanti Hot-Key
Tastiera

TouchPad e pulsanti
Microfono incorporato
Indicatori LED

0. Lettore d’impronte
digitali (opzion)

NSNS

BOx® N0

186 - Descrizione del sistema: Vista superiore con pannello LCD aperto (Modello C)

Descrizione del sistema: Vista superiore con
pannello LCD aperto (Modello C)

2N
PG
Funzionamento del

dispositivo senza fili a
bordo di un aereo

Solitamente I'uso di qualsiasi
dispositivo di trasmissione
elettronica é proibito a bordo
di un aereo. Verificare che i
moduli siano spenti (OFF)
se state usando il

computer a bordo di un
aereo.

Utilizzare la combinazione di
tasti appropriata (vedere

) per
disattivare i moduli WLAN/
Bluetooth e verificare
lindicatore di stato Q)] per
accertarsi che i moduli siano
spenti (vedere

).

Figura 3 - Vista superiore con pannello LCD aperto (Modello C)
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Indicatori LED

Gli indicatori LED sul computer segnalano importanti informazioni relative allo stato corrente del computer.

Tabella 2 - Indicatori LED

Icona Colore Descrizione
& Verde La funzione Blocco numerico (tastierino numerico) e attivata
@ Verde Bloc Maiusc & attivato
Eﬁ Verde Bloc Scorr & attivato
Verde Il computer € acceso
D/Q) Verde lampeggiante Il computer € in modalita Sospensione
Arancione L'alimentatore € collegato e il computer & spento
Arancione L'alimentatore & collegato e la batteria € in carica
[T Arancione lampeggiante La batteria ha raggiunto lo stato critico di carica bassa
Verde Batteria completamente carica
e
% Verde Il disco rigido & in uso Q
QD
(((‘1)) Verde Il modulo o i moduli (WLAN, Bluetooth) sono attivi 8
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Tastiera

Nella tastiera & stato integrato un tastierino numerico per un
facile inserimento dei numeri. Il tasto Fn consente di
modificare istantaneamente le funzioni operative. Si noti
che i computer Modello C hanno un tastierino numerico
alla destra della tastiera principale.

Figura 4 - Tastiera

 Tasti funzione §

e &N 0

Tasti Bloc Num & Bloc Scorr

SEIEE Tasto Fn wo | W o t

Modelli A & B
I Tasti funzione [ESEEEEENENE e

[ a wHE R T ¥ u [ o P A% T .
[ A 8 D F G H
& = z X [+ v B N F

&l Tasto Fn wsllig e Y =

S

Modello C

188 - Tastiera

4

Altre tastiere

Se la tastiera € danneggiata o si desidera solo cambiarla, &
possibile utilizzare qualsiasi tastiera USB standard. Il sistema
la rilevera e la attivera automaticamente. Tuttavia, funzioni
speciali/Hot Key univocamente riferite alla tastiera regolare del
sistema potrebbero non funzionare.

Caratteri speciali

Alcune applicazioni software consentono di utilizzare i tasti nu-
merici insieme al tasto Alt per produrre caratteri speciali. Tali
caratteri speciali possono essere riprodotti solo utilizzando il
tastierino numerico. | tasti numerici regolari (nella riga supe-
riore della tastiera) non funzionano. Accertarsi che sia attivo il
Bloc Num (tastierino numerico).
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Tasti funzione/indicatori visivi

| tasti funzione (da F1 a F12) agiscono come Hot-Key quando premuti tenendo premuto il tasto Fn). In aggiunta alle
combinazioni di tasti funzione base, quando ¢ installato il driver hot key sono disponibili gli indicatori visivi (vedere la
pagina 204). Dopo aver installato il driver, nella barra delle applicazioni appare I'icona .

Tasti Funzione Tasti Funzione
Riduzione/ .
Fn + ~ Play/pausa (nei programmi Audio/Video) Fn + F8/F9 Aumento lumino- € owe B3
sita LCD a2, 91040,
Fn+ F1 Attivare/disattivare — i Fn + F10 Attivare/disattivare @ @
TouchPad L @ Camera PC B | b |

Spegne la retroilluminazione dello schermo LCD Attivare/disattivare

Fn+ F2 (premere un tasto o utilizzare il TouchPad per ripri- Fn + F11 . (GOH qH
stinare lo schermo) LAN Wireless £ o | @ s
Commutazione Attivare/disattivare
+ +
Fn F3 MUte Volume “I On \r'wlumr;o Mute ' Fn F12 BluetOOth L4 ’"'""9 7‘ L] "_'_'_'_’_';!!
. . Fn + Bloc . N . .
Fn+F4 Commutazione Sospendi Scorr Attivare/disattivare il blocco dello scorrimento
Fn + F5/ | Riduzione/Aumento Fn + Bloc Attivare/disattivare blocco numerico (tastierino Q:J
F6 volume audio Satpantiisiatan Num numerico) - Modelli A & B =
QD
- — - — 5
Fn+ E7 Commutazione Display Bloc Num Attivare/disattivare blocco numerico (tastierino 3

numerico) - Modello C

Tabella 3 - Tasti funzione & indicatori visivi
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Pulsanti Hot-Key

I pulsanti Hot-Key permettono I'accesso rapido al navigatore internet predefinito w ed al programma e-mail 5. | pulsanti
Hot-Key camera PC & (@] [&], possono essere usati per eseguire l'applicazione, per prendere immagini fisse e per
ingrandire e ridurre I'imagine della telecamera quando viene installato il modulo camera PC. In caso nella propria scelta
d'acquisto non sia incluso il modulo camera PC, e possibile installare il driver Quick Button (QButton) per attivare l'uso
dei pulsanti Hot-Key e lanciare le applicazioni di propria scelta (vedere “Applicazione Quick Button (Tasti di avvio
rapido)” a pagina 191 per i dettagli). Si noti che i computer Modello C non supportano le funzioni dei pulsanti di
registrazione audio e di zoom della camera.

Tabella 4 - Pulsanti Hot-Key

Pulsante Hot-Key Funzione
w Attivare il browser Internet predefinito
ﬁ Attivare il programma di posta elettronica predefinito

Camera PC installato Apre il programma BisonCap/VideoView / scatta una foto (vedere la

(.g pagina 209)

Camera PC non installato Attivare |'applicazione Quick Button 1 (vedere la pagina 191)
Modelli Camera PC installato Zoom + camera (vedere la pagina 209)
8 A&B Camera PC non installato Attivare l'applicazione Quick Button 2 (vedere la pagina 191)
‘E Modelli Camera PC installato Zoom - camera (vedere la pagina 209)
C_j A&B Camera PC non installato Attivare |'applicazione Quick Button 3 (vedere la pagina 191)
B chédglli Avvia/stop registrazione audio (vedere la pagina 199)

190 - Pulsanti Hot-Key
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Comparira la finestra di dialogo Apri.

Applicazione Quick Button (Tasti di
Selezionare la cartella contenente I'applicazione exe del

avvio rap id O) programma desiderato (vedere sotto).

Nota: il driver Quick Button (QButton) €& progettato per 5. Fare doppio clic sul file del programma o scegliere Apri.
consentire I'utilizzo dei pulsanti Hot-Key (@ [@ in assenza

del modulo opzionale Camera PC (installare il driver =
Quick Button soltanto nel caso in cui non sia stato w . pA—
installato camera PC). Per abilitare questa funzione &  ——— w0
necessario installare il driver Quick Button (QButton) T E% WE W
(vedere “Applicazione Quick Button™ a pagina 204). Modelli A & B

> ow

ensione

| Mometie

' H H H ' H H 1 ) v MBEISE VI
L'applicazione Quick Button consente I'accesso immediato e e | R e = e

a una serie di applicazioni definite dall'utente, I dorin st
. . . . . Modello C

semplicemente premendo il tasto di avvio rapido. Per

configurare il programma da aprire quando si premono i

tasti di avvio rapido &@@ (vedere la Tabellad a 2

pagina 190) seguire le istruzioni riportate di seguito. Application.exe

L_appllca;!one QUI(f!( BUttOfunzmn_a‘fmChe il programma E necessario localizzare il file eseguibile dell'applica-

viene utilizzato (I'icona [ apparira nella barra delle zione in uso (exe) e non semplicemente il collegamento.

applicazioni). In caso contrario, sara necessario riavviare il Per ritrovare I'applicazione, fare clic con il tasto destro sul
computer. relativo collegamento sul desktop e fare clic su Proprie-

ta. Fare clic sulla scheda Collegamento e verificare Q:J
1. Premere il pulsante &(&][&] o fare clic con il tasto destro dovg S T f T'Ie CEE N XLl G T 2T =
sull'icona E# nella barra delle applicazioni. A [DETECED T, %
2. Selezionare Configurazione dal menu, scorrere fino a AP1/2/ (@)
3 (oppure Applicationl per i computer Modello C) e Figura 5 - Schermate di configurazione dell'applica-
selezionare Custom. zione Quick Button

Pulsanti Hot-Key - 191
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dicator LED Descrizione del sistema: Vista anteriore e

Porta USB posteriore
Jack di ingresso CC

Batteria

Dispositivi di chiusura
dello schermo LCD
(Modello C)

SARE I A o

posteriore 4

Modelli A & B

1

ato anteriore

|‘%.clB':‘ﬂﬂﬁ|

Lato posteriore

Modello C

o
c
&
'
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Figura 6 - Vista anteriore e posteriore
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Descrizione del sistema: Vista sinistra

1. Slot blocco di sicurezza
: 2. Bay unita ottica (per
Modelli A & B periferiche CD/ DVD)
: 3. Foro di espulsione di
emergenza
4. Jack telefonico tipo RJ-
11

5. Jack uscita S/PDIF

6. Jack ingresso del
microfono

7. Jack uscita delle cuffie

8. Jack diingresso di linea

Espulsione di emergenza CD

Se si desidera estrarre manualmente un CD/DVD (per esempio a causa di un'inaspettata interruzione
dell'alimentazione) & possibile spingere I'estremita di una graffetta per carta raddrizzata nel foro di
espulsione di emergenza. Non usare una matita appuntita o un oggetto analogo che potrebbe romper-
si oppure rimanere incastrato nel foro.

Figura 7 - Vista sinistra

. |
Descrizione del sistema: Vista sinistra - 193
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agrwN

Descrizione del sistema: Vista destra

Slot ExpressCard/
54(34) _
Lettore di schede 7-in-1 Modelli A & B

2 Porte USB 2.0 : ' | 3| )

Jack di rete tipo RJ-45 3

Porta per monitor
esterno

Slot ExpressCard

Lo slot ExpressCard accetta il formato ExpressCard/34 oppure il formato ExpressCard/54.

Lettore di schede 7-in-1

Il lettore di schede consente di utilizzare alcune tra le piu recenti schede di memoria digitali.
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro) / MS
Duo (richiede PC adattatore) / Mini SD (richiede PC adattatore) / RS MMC (richiede PC adattatore)

Figura 8 - Vista destra

. |
194 - Descrizione del sistema: Vista destra
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Descrizione del sistema: Vista inferiore L Ventola
2. Batteria
3. Coperchio bay disco
2 2 rigido
4. Coperchio bay CPU/
Modelli A & B Modello C RAM

CPU

La CPU non €& un
componente che
necessita assistenza da
parte dell’'utente.
Accedere alla CPU in
qualsiasi modo implica
una violazione della

garanzia.

Informazioni sulla batteria Surriscaldamento

Per prevenire il
surriscaldamento (o[]
computer, accertarsi che
non vi sia nulla che
ostruisca la (le) ventola
(ventole) durante l'uso del
computer.

Prima di utilizzare una batteria nuova, scaricarla prima completamente, quindi caricarla al massi-
mo. Scaricare completamente e caricare la batteria almeno una volta ogni 30 giorni oppure dopo
una ventina di cariche parziali.

=
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Figura 9 - Vista inferiore

Descrizione del sistema: Vista inferiore - 195
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Menu Start e Pannello di controllo di Windows Vista

La maggior parte dei pannelli di controllo, utilita e programmi che compongono Windows Vista (e la maggior parte delle
versioni di Windows) sono accessibili tramite il menu Start. Quando si installano programmi e utilita, essi vengono
installati sul disco rigido, mentre un collegamentoche punta ad essi viene inserito nel menu Start e/o sul desktop. Fare clic
con il tasto destro sull'icona &3, del menu Start quindi selezionare Proprieta per personalizzare I'aspetto del Menu Start.

1 Windows Update
-
Cerca...

- T Y @] T -
Apni | A & st davl L x_@ Programmi predefiniti Y
) ~ '
IR
P4
Programmi ]
5 Datirecent
e I s T

| Esplora
Proprieta
1B Pannelo di controllo o

Apri cartella Utenti
Esplora cartella Utenti

0% £ &

| & Connessioni di rete

e oot e e e iy e o [ Stomgent

B dude arphcamrs | ST T e s | e s ewarn.

. Barra dell spplicazion € menu Start

Fare clic qui per passare alla Visualiz-
zazione classica

P T geogramemi

Figura 10 - Menu Start & Pannello di controllo

In molte sezioni del presente manuale I'utente avra modo di notare riferimenti al Pannello di controllo. Al Pannello di
controllo é possibile accedere attraverso il menu Start. Il Pannello di controllo consente di configurare le impostazioni
per la maggior parte delle funzionalita principali presenti in Windows (ad es. alimentazione, video, rete, audio, ecc.). Win-
dows Vista fornisce pannelli di controllo di base per molte delle funzionalita, tuttavia molti altri pannelli di controlli ven-
gono aggiunti (o quelli esistenti migliorati) quando si installano i driver elencati nella Tabella5 a pagina 202. Per
visualizzare tutti i controlli potrebbe essere necessario attivare la visualizzazione classica.

. |
196 - Menu Start e Pannello di controllo di Windows Vista
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Funzioni video
Questo computer presenta due opzioni video differenti (VIA per Modello A o NVIDIA per Modelli B & C). Il driver
appropriato si trova sul CD-ROM Device Drivers & Utilities + User's Manual.

E possibile modificare le Impostazioni di visualizzazione dal pannello di controllo Impostazioni schermo (in
Personalizzazione) in ambiente Windows Vista.

Per accedere alle Impostazioni schermo in Window Vista:

1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo).

2. Fare clic su Modifica risoluzione dello schermo nel menu Aspetto e personalizzazione menu (o fare doppio clic
personalizzazione > Impostazioni schermo).

3. Scorrere l'indicatore nella posizione desiderata in Risoluzione o (vedere la Figura 11 a pagina 198).
Fare clic sulla freccia e selezionare l'impostazione desiderata in Colori 9 (vedere la Figura 11 a pagina 198).

5. Fare clic su Impostazioni avanzate... 9 (vedere la Figura 11 a pagina 198) per visualizzare le schede delle Impostazioni
avanzate.

Per VIA
1. Fare clic nelle schede S3 e (vedere la Figura 11 a pagina 198) per apportare tutte le regolazioni video richieste.

Per NVIDIA
1. Fare clic su GeForce 8400M G (scheda).
2. Fare clic su Avvia Pannello di controllo NVIDIA 6 (vedere la Figura 11 a pagina 198) per accedere al pannello di controllo.

3. E possibile accedere al Pannello di controllo NVIDIA anche facendo clic con il pulsante destro del mouse sul desktop e scegliendo
Pannello di controllo NVIDIA.

=
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Figura 11 - Impostazioni schermo
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Funzionalita audio

E possibile configurare le opzioni audio del computer dal
pannello di controllo Audio “* di Windows, oppure
dall'icona VIA Audio Deck nella barra delle
applicazioni, o sul desktop I~ | (viene aperto il menu di VIA
Audio Deck). Il volume puo essere regolato anche con la

combinazione di tasti Fn + F5/F6.

Fare clic sui vari pulsanti (ad es. 1)) sulla sinistra per
espandere le selezioni del menu audio.

Figura 12 - Menu di configurazione di VIA Audio Deck

Guida Rapida per I'Utente

Registrazione audio (Modelli A & B)

Il pulsante Hot-Key di registrazione audio [¢] consente di
registrare audio dal microfono incorporato o da un
microfono collegato all'apposito ingresso.

1. Premere il pulsante Hot-Key di registrazione audio [#] per
awviare la registrazione (l'icona di registrazione ===
lampeggia in alto a sinistra nella schermata).

2. Premere un'altra volta il pulsante Hot-Key di registrazione
audio [¢] per interrompere la registrazione (l'icona di
registrazione scompare dalla parte superiore sinistra della
schermata).

3. llfile audio registrato (in formato wav) si trovera nella cartella
Wav (Computer > Disco locale (C:) > Utenti > (nome di
registrazione) > Wav).

4. Fare doppio clic sul file per riprodurre l'audio registrato.

4

Regolazione del volume audio

Il livello del volume del suono viene impo-
stato utilizzando il comando di regolazione

volume di Windows (e i tasti funzione volu-
me sul computer). Fare clic sull'icona Vo-
lume nella barra delle applicazioni per
controllare I'impostazione.
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Funzioni di risparmio energetico

Il pannello di controllo delle Opzioni risparmio energia (menu Hardware e suoni) di Windows (vedere la pagina 196)
consente la configurazione delle funzioni di risparmio energetico del computer. Selezionando Risparmio di energia &
possibile attivare questa funzione e configurare le opzioni relative al pulsante di alimentazione, pulsante di sospensione,
coperchio del computer (chiuso), schermo e modalita sospensione. Nota: la funzione Risparmio di energia pud influire
sulle prestazioni del computer.

Fare clic su una delle combinazioni esistenti o su Crea combinazione per il risparmio di energia sul menu di sinistra e
personalizzarla per creare una nuova combinazione. Fare clic su Modifica impostazioni combinazione, quindi su Cambia
impostazioni avanzate risparmio energia per accedere a ulteriori opzioni di configurazione.

SN T RaEaie At =6 o= 51| | LI/ = Spon mpmio s+ inporticen i steme ~Talle "

& attivare la protezione con password

Selezionare una combinazione per il risparmio di energia

desicusste par d computis in i, Lo msdiiche appostate sl

o

c
=
'
=

Nota: Sospensione € lo stato di risparmio di energia predefinito per Window Vista

Figura 13 - Opzioni risparmio energia

.|
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Informazioni sulla batteria

. - . o . AL
Attenersi a queste semplici linee guida per ottenere le prestazioni migliori dalla batteria. /ﬁl\
Avviso di batteria scarica
Caricamento della batteria sui computer modello B e C Olanol B ateHA Mok

Si noti che i computer Modello B e C sotto un carico pesante (ad esempio di utilizzo di gEEEEllEE collegare
applicazioni che richiedono molta elaborazione video), quando il computer & alimentato [ SRR

. P e . . l'alimentatore AC/DC al
dalla batteria, impiegano tempo (da 3 a 20 minuti prima dell'inizio della carica) per ricaricare

. R . N X i computer oppure salvare il
la batteria quando collegati all'alimentatore AC/DC. Cido & dovuto ad aspetti legati alla B EVEer = il (e Lu oy

sicurezza che consigliano di attivare la batteria deve iniziare la ricarica solo quando il FEENEIEEHEIERRNEEERE]

computer ha raggiunto una temperatura sicura per eseguire I'operazione. et EellelimenEa e,

Salvare il proprio lavoro quando il LED della batteria lampeggia di colore arancione, quindi
collegare l'alimentatore AC/DC. Il LED della batteria cambia da lampeggiante arancione ad
arancione fisso quando inizia la ricarica (da 3 a 20 minuti prima dell'inizio della ricarica).
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Installazione driver

Il CD-ROM Device Drivers & Utilities + User’s Manual
contiene i driver e le utilita necessari per il corretto
funzionamento del computer. Inserire il CD-ROM e fare
clic su Install Drivers (pulsante), oppure il pulsante
Option Drivers per accedere al menu del driver opzionale.

Installare i driver attenendosi all'ordine indicato nella
Tabella 5. Dopo l'installazione di ciascun driver, lo stesso
viene oscurato (se occorre reinstallare uno dei driver, fare
clic sul pulsante Unlock).

Installazione manuale dei driver

Fare clic sul pulsante Browse CD (Sfoglia CD)
nell'applicazione Drivers Installer e selezionare il file
eseguibile nella cartella del driver corrispondente.

Windows Update

Dopo l'installazione di tutti i driver assicurarsi di aver
attivato Window update per ottenere tutti i recenti
aggiornamenti di sicurezza ecc. (tutti gli aggiornamenti
includeranno i piu recenti hotfixes di Microsoft).

202 - Installazione driver

Driver (Windows Vista) Pagina #
Video (VIA-Modello A) pagina 203
Video (NVIDIA-Modelli B & C) pagina 203
Audio pagina 203
Modem pagina 203
Rete (LAN) pagina 203
Lettore di schede pagina 203
TouchPad pagina 203
Hot-Key pagina 204
Applicazione Quick Button pagina 204
LAN Wireless (opzion) pagina 205
Camera PC (opzion) pagina 206
Lettore d'impronte digitali (opzion) pagina 210

Bluetooth (opzion)

Nota: Non & necessaria nessuna installazione i driver (vedere

la pagina 212)

USB Advance AP (Modello A)

pagina 204

Attivare Window update (vedere a sinistra)

Tabella 5 - Procedura di installazione
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Procedura di installazione dei driver Modem
1. Fare clic su Install Drivers.

Video (VIA - Modello A) 2. Fare clic su 3.Install Modem Driver > Si.
1. Fare clic su Install Drivers. 3. Fare clic su OK.
2. Fare clic su 1.Install Video Driver > Si. 4. 11 modem & pronto per la configurazione della
3. Fare clic su Avanti > Avanti. connessione.
4. Fare clic su Fine per riavviare il computer.
Rete (LAN)
Video (NVIDIA - Modelli B & C) 1. Fare clic su Install Drivers.
1. Fare clic su Install Drivers. 2. Fare clic su 4.Install LAN Driver > Si.
2. Fare clic su 1.Install Video Driver > Si. 3. Fare clic su OK.
3. Fare clic su Avanti. 4. Ora é possibile configurare le impostazioni di rete.

4. Fare clic su Fine per riavviare il computer.
. Lettore di schede
Audio 1. Fare clic su Install Drivers.

1. Fare clic su Install Drivers. 2. Fare clic su 5.Install Cardreader Driver > Si.
. Fare clic su 2.Install Audio Driver > Si. 3. Fare clic su Avanti > Avanti.
4

2
3. Fare clic su Avanti. . Fare clic su Fine per riavviare il computer.
4. Fare clic sul pulsante “Sono d’accordo”, quindi fare clic

su Avanti. TOUChPad
Fare clic su Avanti > Avanti > Avanti. 1 Eare clic su Install Drivers.

6. Fare clic su Fine per riavviare il computer. . . N
P P 2. Fare clic su 6.Install Touchpad Driver > Si.
3. Fare clic su Avanti.
4. Fare clic su Fine > Riavvia ora per riavviare il computer.

o
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Hot-Key

1. Fare clic su Install Drivers.

2. Fare clic su 7.Install Hotkey Driver > Si.

3. Fare clic su Next > Install.

4. Fare clic su Finish > Finish per riavviare il computer.

Applicazione Quick Button

Se non ¢ stato installato un modulo Camera PC, € possibile
installare il driver Quick Button (QButton) per attivare l'uso
dei pulsanti Hot-Key e lanciare le applicazioni di propria
scelta (vedere “Applicazione Quick Button (Tasti di avvio
rapido)” a pagina 191 per i dettagli).

Bisognera installare manualmente il driver Quick Button
visto che non appare nel menu Drivers Installer.

1. Inserire il CD-ROM Device Drivers & Utilities + User’s
Manual nell’unita CD/DVDe fare clic su Browse CD
(pulsante).

2. Fare doppio clic per aprire le cartelle seguenti Option >
QButton.

3. Fare doppio clic Setup.exe.

4. Fare clic su Avanti > Fine per riavviare il computer.

USB Advance AP (Modello A)

Installare il driver solo per i computer Modello A. Cio
aiutera a evitare che tastiere e/o mouse USB 1.1 cessino di
rispondere dopo aver ripreso il normale funzionamento
dopo uno stato di Sospensione.

Fare clic su Option Drivers (pulsante).

Fare clic su 4.USB Advance AP > Si.

Fare clic su Close per completare I'installazione.
Eseguire Windows Update (vedere “Windows Update™ a
pagina 202) per verificare la presenza di aggiornamenti
importanti.

Howd e

204 - Installazione driver
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LAN Wireless Connessione a una rete wireless
Accertarsi che il modulo LAN Wireless sia acceso.

/ 1. Fare clic sullicona della WLAN nella barra delle
applicazioni, e quindi fare clic su Connessione aunarete (0
fare clic con il pulsante destro del mouse sull'icona = e
Attivare l'alimentazione al modulo LAN Wireless utilizzando la quindi fare clic su Connessione a unarete).

Accensione/spegnimento del modulo LAN Wireless

combinazione di tasti SF? + F11). Quando il modulo LAN Wi(rg 2. Nell'elenco Mostra, scegliere Wireless dal menu a tendina.
2 i ) & i i i !
Ie.ss > B, JLED L &l CelRlE VRl @ ICHEEe 3. Verra visualizzato un elenco delle reti disponibili al momento.
viene visualizzato per breve tempo. . o )
4. Fare clic su una rete e quindi su Connetti.
5. In caso non venisse visualizzata una rete alla quale si
. . desidera connettersi, fare clic su Configura una
Installazione del driver del modulo LAN connessione o una rete (verra visualizzato un elenco di
Wi re| ess opzioni che consente la ricerca manuale e la creazione di una

nuova rete).

1. Accertarsi che il modulo sia acceso. . . o
. . . 6. Spostare il cursore sull'icona E della barra delle applicazioni

2. Fare Cl!C su Option Drivers (pU|_Sante)- per visualizzare lo stato della connessione.

3. Fare clic su 1.Install WLAN Driver > Si. 7. Per disconnettersi dalla rete wireless & possibile fare clic

4. Scegliere la lingua desiderata e fare clic su Avanti. sullicona [, della barra delle applicazioni e selezionare

5. Fare clic su Avanti > Installa. Connetti o disconnetti... per accedere al menu della rete,

6. Fare clic su Finish per completare I'installazione. quindi fare clic su Disconnetti (o fare clic con il pulsante

destro del mouse sull'icona E e quindi fare clic su

. A . . Disconnetti da).
Nota: Il sistema operativo € I'impostazione predefinita per

il controllo LAN wireless in Window Vista.
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Camera PC

Per questo computer sono disponibili 2 opzioni di
fotocamera. Il modulo camera da 1,3M pixel utilizza
I'applicazione BisonCap per catturare i file video. Il
modulo di camera da 2,0M pixel utilizza I'applicazione
VideoView per catturare i file video.

Installazione del driver della camera
PC

Per modulo di camera da 1,3M pixel:

1. Accendere il modulo con la combinazione Fn + F10
(lindicatore . @ viene visualizzato per breve tempo
quando il modulo é acceso).

2. Fare clic su Option Drivers (pulsante).

3. Fare clic su 2.Install Camera Driver > Si.

4. Scegliere la lingua desiderata e fare clic su Avanti >
Avanti.

5. Fare clic su Fine per riavviare il computer.

6. Eseguire lI'applicazione BisonCap dal collegamento sul
desktop oppure dalla voce BisonCam del menu Start >
Programmi/Tutti i programmi (se I'hardware & spento,
utilizzare la combinazione di tasti Fn + F10 per
riaccenderlo).

Per modulo di camera da 2,0M pixel:

1.

arwn

~No

Accendere il modulo con la combinazione Fn + F10
(l'indicatore | @ viene visualizzato per breve tempo
quando il modulo é acceso).

Fare clic su Option Drivers (pulsante).

Fare clic su 2.Install Camera Driver > Si.

Fare clic su Installa.

Scegliere Si 0 No alla domanda sul sistema di risparmio
energetico.

Fare clic su Fine > Fine per riavviare il computer.
Eseguire I'applicazione VideoView dal collegamento sul
desktop oppure dalla voce USB2.0 PC Camera del menu
Start > Programmi/Tutti i programmi (se I'hardware &
spento, utilizzare la combinazione di tasti Fn + F10 per
riaccenderlo).

4

Configurazione della Combinazioni di colori

Prima di eseguire I'applicazione Videocamera PC, verificare
che la Combinazione colori in Windows Vista sia impostata su
Windows Aero (Pannello di controllo > Aspetto e persona-
lizzazione > Personalizzazione > Colore e aspetto finestre).

206 - Camera PC
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Pulsanti Hot-Key della Camera PC Configurazione audio della camera PC
E possibile utilizzare i pulsanti Hot-Key camera PC (& (@)  Configurare le opzioni di registrazione audio in Windows
per avviare il programma BisonCap/VideoView, per per catturare video e audio con la camera.

scattare fotografie e per fare lo zoom + e - della camera (solo

Modelli A & B). 1. Fareclic su Start, e fare clic su Pannello di controllo
(oppure scegliere Impostazioni e fare clic su Pannello di
controllo).

Pulsante Hot-Key Funzione 2. Fare clic Audio *? (Hardware e suoni).
3. Fare clic Registrazione (scheda).
Apre il programma BisonCap/Video- 4. Fare clic con il pulsante destro del mouse su “Microfono (VIA
7% View / scatta una foto (vedere la High Definition Audio)” (microfono esterno)/“Front Mic (VIA
pagina 209) High Definition Audio)” (microfono interno) et accertarsi che
la voce non sia disabilitata.

X'%‘dg”' Zoom + camera (vedere la pagina 209) 5. Fare doppio clic su Microfono/Front Mic (o selezionare
Proprieta dal menu di scelta rapida ottenuto con il tasto
destro del mouse).

X‘%‘dg”' Zoom - camera (vedere la pagina 209) 6. Scegliere Livelli (scheda) e regolare il cursore Microfono per
ottenere il livello richiesto.

N

Fare clic su OK, quindi chiudere i pannelli di controllo.

8. Awviare il programma BisonCap/VideoView dal menu Start >
Programmi/Tutti i programmi > BisonCam/USB2.0 PC
Camera

9. Aprire il menu Dispositivi/Devices e selezionare Microfono/
Front Mic (VIA High Definition Audio) (accanto ad esso
dovrebbe essere presente un segno di spunta).

10. Aprire il menu Cattura/Capture e selezionare Audio cattura/

Capture Audio (accanto ad esso dovrebbe essere presente

un segno di spunta).

. |
Camera PC - 207

Tabella 6 - Pulsanti Hot-Key della Camera PC
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BisonCap/VideoView

Le applicazioni BisonCap (per la camera da 1,3M pixel) e
VideoView (per la camera da 2,0M pixel) sono utili
programmi video per la visualizzazione e il test di video
generali, in grado anche di catturare file video in formato
.avi.

1. Awviare il programma BisonCap/VideoView dal menu Start >
Programmi/Tutti i programmi > BisonCam/USB2.0 PC
Camera (si consiglia di Impostare Cattura File prima del
processo di cattura - vedere "Imposta cattura file" di
seguito).

2. Aprire il menu Cattura\Capture (se si desidera catturare file
di audio vedere “Configurazione audio della camera PC” a
pagina 207) e selezionare Avvia cattura\Start Capture.

3. Fareclic su OK (la collocazione del file verra visualizzata nella
casella a scomparsa), per avviare la cattura, quindi premere
Esc per interromperla (é possibile visualizzare il file
utilizzando Windows Media Player).

Imposta cattura file

Prima di effettuare la cattura dei file di video si pu0 selezionare
I'opzione Imposta file di cattur/Set Capture File nel menu
File e impostare il nome del file e la collocazione prima della
cattura (questo contribuira a evitare la sovrascrittura dei file).
Impostare il nome e la collocazione poi cliccare Apri, quindi
impostare la "dimensione del file di cattura:" e cliccare "OK".
Quindi é possibile avviare il processo di cattura di cui sopra.

Eliminazione dello sfarfallio dello schermo
Se la schermata del video nel programma BisonCap/
VideoView ha uno sfarfallio, & possibile provare a regolare
I'impostazione nelle opzioni Video Capture Filter (filtro
di cattura video).

Per BisonCap:
1. Awviare il programma BisonCap.
2. Aprire il menu Options e selezionare Video Capture Filter....

3. Scegliere 50Hz oppure 60Hz sotto Frequenza nella scheda
Pagina delle proprieta.

Per VideoView:
1. Awviare il programma VideoView.
2. Aprire il menu Options e selezionare Video Capture Filter....

3. Scegliere 50Hz oppure 60Hz sotto Flickering Reduction
nella scheda Image.
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Prendere immagini fisse
I programmi BisonCap e VideoView consente di prendere
immagine fisse.

1. Avviare il programma BisonCap/VideoView.

2. (BisonCap) Aprire il menu Opzioni e selezionare Scatta
foto.
oppure
(VideoView) Aprire il menu Capture e selezionare
SnapShot.

3. Lafotografia (in formato JPEG) viene inserita nella cartella
Snapshot _I:] del desktop (non rimuovere o rinominare la
cartella).

Zoom

I programmi BisonCap e VideoView che vi consentono di
ingrandire e ridurre con la camera.

Per BisonCap:

1. Awvviare il programma BisonCap.

2. Aprire il menu Zoom e selezionare Nagyitas/Kicsinyités.
Per VideoView:

1. Awviare il programma VideoView.

2. Aprire il menu Options e selezionare Setting (utilizzare il

cursore per regolare il livello dello zoom, quindi scegliere OK
per salvare l'impostazione).

Guida Rapida per I'Utente
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Aggiungere/rimuovere un modulo Camera PC

Nota: i driver dell'applicazione Quick Button e del modulo
Camera PC non possono coesistere.

Se si desidera aggiungere un modulo Camera PC al computer
in un successivo momento, disinstallare il driver per
I'applicazione  Quick Button (denominato  Multimedia

Keyboard Driver) prima di installare Camera PC e driver. E

possibile disinstallare i driver dal Pannello di controllo
Programmi e funzionalita di Windows.

Se si desidera rimuovere un modulo Camera PC dal computer
in un successivo momento, & necessario disinstallare il driver
Camera PC dopo aver rimosso il modulo della camera. Sara
quindi possibile inserire il CD-ROM Device Drivers & User's
Manual e installare il driver Quick Button (QButton) dal menu
Drivers Installer.

Camera PC - 209
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Lettore d’impronte digitali

Se nell'opzione di acquisto € stato incluso il lettore di impronte
digitali (Opzionale solo per i computer Modelli B e C) sara
necessario installare il driver secondo le istruzioni riportate
sotto.

Assicurarsi di avere i diritti amministratore sul proprio
computer, e avere attivato una password di Windows per
una protezione totale.

Prima di avviare il processo di registrazione si raccomanda
di seguire I'esercitazione per il lettore d’impronte digitali.
Per avviare I'esercitazione fare clic su Start > Programmi/
Tutti i programmi > Protector Suite QL > Esercitazione
Fingerprint.

Installazione del driver per I'impronta
digitale

1. Fare clic su Option Drivers (pulsante).

Fare clic su 3.Install FingerPrint Driver > Si.

Fare clic su Installazione software.

Fare clic su Avanti > Avanti > Avanti.

Fare clic su Fine > Si per riavviare il computer.

a e
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Guida & Manuale

Clic destro sull'icona [ della barra delle applicazioni per
attivare il menu dove selezionare Guida.

Inserire il CD-ROM Device Drivers & Utilities + User's Ma-
nual e fare clic su Option Drivers (pulsante). Fare clic su
Unlock (pulsante) et quindi fare clic su 3.Install Finger-
Print > Si.

Cliccare Documentazione per aprire la cartella dove si
trova il manuale in formato .pdf.

Per installare Adobe Acrobat Reader per leggere il file, in-
serire il CD-ROM Device Drivers & Utilities + User's Ma-
nual e fare clic su User’s Manual (pulsante), e fare clic su
Install Acrobat Reader (pulsante).

Registrazione utente

1.

Fare clic su Start > Programmi/ Tutti i programmi >

Protector Suite QL > Registrazione utente, o fare doppio

clic sullicona [§£] nella barra delle applicazioni.

Al primo avvio del programma viene richiesto di fare clic sul

pulsante di accettazione della licenza, quindi su OK

Fare clic su Avanti e selezionare “Registrazione nel disco

rigido”, e fare clic su Fine.
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4. Nel caso non si sia impostata la password Windows apparira 15. Consultare “Guida & Manuale” a pagina 210 per altri

l'invito per farlo (nota: Nel caso non sia stata impostata la dettagli.
password Protector Suite QL non potra garantire la 16. Se si fa passare il ditto sul lettore ogni volt ache si pud
sicurezza all'accesso al proprio computer). accedere al Biomenu per bloccare il computer, registrare
5. Fare clic su Avanti, e quindi si viene invitato a inserire la siti web, aprire il Control Center e accedere il menu Guida.
propria password Windows. 17. Control Center consente di cambiare le Impostazioni, le
6. Fare clic su Avanti > Avanti (attivare la cassella “Lancia I' Impronte digitali e di visualizzare la Guida.

esercitazione interattiva” per lanciare I'esercitazione
Fingerprint).

7. Fare clic su Avanti ad ogni finestra dell'esercitazione (si puo
premere il pulsante “Salta esercitazione” in qualsiasi
momento).

8. Premere il pulsante per ogni impronta per avviare il processo
di registrazione di quell'importa.

9. Passare l'impronta tre volte per registrare la stessa.

10. Ripetere I'operazione per tutte le impronte che si desiderano
registrare (vedere di seguito), quindi fare clic su Avanti >
Fine.

11. Fare clic su una delle intestazioni sotto “Informazioni su:” per . :
visualizzare ulteriori informazioni relative a un argomento. Registrazione Impronta

12. Fare clic su Chiudi. Si osservi che viene raccomandato di registrare pit di una
13. Riavviare il computer. impronta in caso di ferita ecc.

14. Clic destroy sull'icona Eﬂ della barra di applicazioni per
attivare il menu che permette la Modifica impronte, lanciare
Control Center, accedere al menu Guida ecc. Si pud inoltre
eseguire il Control Center ecc. dalla voce Protector Suite QL
del menu Start > Programmi/Tutti i programmi.

=
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Figura 14 - Registrazione Impronta Q
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Configurazione Bluetooth in
Windows Vista

Impostareil proprio dispositivo Bluetooth
in modo che il computer possatrovarlo

« Fare clic/Fare clic con il pulsante destro del mouse
sull'icona £ e selezionare un’opzione dal menu.

110 Dt B )

4

Trasferimento dati via
Bluetooth

1. Accendere il proprio dispositivo Bluetooth (PDA, cellulare
ecc.). Si noti che il trasferi-
2. Rendere da trovare il dispositivo (per questo si veda la - mento di dati tra il com-

puter e un dispositivo
Bluetooth €& supportato
solo in una direzione
(il trasferimento dati
simultaneo non e sup-
portato).

documentazione che accompagna il proprio dispositivo).
‘ Aggiungi dispesitive Bluetooth

IMestra dispositivi Blustooth

Per accendere il Modulo Bluetooth

1. Utilizzare la combinazione di tasti Fn + F12 per accendere |l
modulo Bluetooth.

2. Un'icona Blutooth f] apparira nella barra di applicazioni (puo
essere necessario attivare I'opzione dal pannello di controllo
Bluetooth).

3. Quindi é possibile effettuare una qualsiasi delle azioni
seguenti per accedere al pannello di controllo Dispositivi
Bluetooth.

Invwia un file

Ricevi un file
Aggiungi a Personal Area Network

Apri impostazicni Bluetooth

1 Rimucvi icona Bluetooth E!

Figura 15 - Dispositivi Bluetooth e cliccare l'icona Menu

Per aggiungere un dispositivo Bluetooth
1. Accedere al pannello di controllo Dispositivi Bluetooth.

2. Fare clic Opzioni (scheda), e accertarsi che la casella di
controllo Consenti ai dispositivi Bluetooth di connettersi
al computer abbia Connessioni sia selezionata.

3. Fare clic Dispositivi (scheda), quindi su Aggiungi.
4. L'Aggiunta guidata dispositivo Bluetooth comparira.

« Fare doppio clic sull'icona g per accedere al pannello di
controllo Dispositivi Bluetooth.

* Fare clic su Start e fare clic su Pannello di controllo
(oppure scegliere Impostazioni e fare clic su Pannello di
controllo), e quindi fare clic su Dispositivi Bluetooth
(Hardware e suoni).
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5. Fare clic per selezionare “ll dispositivo € configurato ed &
pronto per il rilevamento”, e quindi fare clic su Avanti.

D s i s B S Y vap——

3

Agglunta guidata disposisve
Blusteom

CEFEF

Figura 16 - Aggiunta guidata dispositivo Bluetooth

6. L'assistente procedera alla ricerca per qualsiasi dispositivo
Bluetooth nel range.

7. Selezionare il dispositivo con il quale si vuole comunicare e
Cliccare Avanti.

8. Selezionare I'opzione passkey appropriata e cliccare Avanti >
Fine.

0 2ggumts quodets Speiti Bumeeth (==
E nocmssann spocficars una passkey per apgungers i dapoutive 9

Figura 17 - Opzione passkey
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Per cambiare le impostazioni per il
dispositivo Bluetooth

1.
2.

Accedere al pannello di controllo Dispositivi Bluetooth.

Cliccare sul dispositivo che si vuole modificare e Cliccare
Proprieta a:

« Modificare il nome del dispositivo (cliccare Generale,
digitare un nuovo nome e cliccare OK).

« Attivare/Disattivare un servizio (cliccare Servizi, seleziona/eli-
mina la casella di controllo accanto al servizio e cliccare OK).

Per rendere da trovare il proprio
computer Ai dispositivo Bluetooth

1.
2.

Accedere al pannello di controllo Dispositivi Bluetooth.
Fare clic Opzioni (scheda), e accertarsi che la casella di
controllo Consenti ai dispositivi Bluetooth di individuare il
computer abbia Individuazione sia selezionata.

Assicurarsi che la casella di controllo Avvisa quando un
nuovo dispositivo Bluetooth tenta di connettersi abbia
Connessioni selezionata, se si desidera essere notificati
quando un dispositivo Bluetooth vuole connettersi.

) Disposer Blustooth (7==1 Q:J
Figura 18 S?_J
Dispositivi 5
Bluetooth - (@]
Opzioni

.|
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Risoluzione dei problemi

Problema Possibile causa - Soluzione
Non é possibile rilevare i moduli 11/l modulo/i &/sono disattivato/i. Controllare il LED indicatore ) per verificare se il/i modulo/i
LAN Wireless e Bluetooth. e/sono attivato/i o disattivato/i (vedere “Indicatori LED” a pagina 187). Se il LED indicatore e

spento, quindi premere la combinazione di tasti Fn + F11 (WLAN) oppure Fn + F12
(Bluetooth) al fine di attivare i moduli (vedere la Tabella 3 a pagina 189).

Il modulo Bluetooth viene spento I modulo Bluetooth & spento dopo aver ripreso dalla Sospensione (solo computer Modello B
dopo aver ripreso dalla modalita e C). Lo stato predefinito del modulo Bluetooth sara spento dopo aver ripreso dallo stato di
Sospensione. risparmio energetico Sospensione. Utilizzare la combinazione di tasti (Fn + F12) per accendere

il modulo Bluetooth dopo che il computer ha ripreso da Sospensione.

Non & possibile copiare un file da/ Il trasferimento di dati tra il computer e un dispositivo Bluetooth € supportato solo in una
verso un dispositivo Bluetooth direzione (il trasferimento dati simultaneo non & supportato). Se si sta copiando un file dal
connesso. computer a un dispositivo Bluetooth, non sara possibile copiare un file dal dispositivo Bluetooth

al computer finché il processo di trasferimento che parte dal computer non & terminato.

| file video catturati dalla camera Nota catturare file di video ad altra risoluzione molto spazio disco disponibile per ogni file.
PC prendono troppo spazio sul

disco Nota Window Vista richiede un minimo di 15GB di spazio disco libero sulla partizione del

disco C:. Si consiglia di salvare la cattura del file video in un'ubicazione diversa dal disco C:,
limitare la dimensione del file del video catturato o ridurne la risoluzione (Options/Opzioni >
Video Capture Pin... > Dimensioni output).
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Errore di risoluzione dello schermo (Modelli B & C)

In caso di riduzione della risoluzione dello schermo, oppure di fenomeni di sfarfallio dello schermo dopo aver ripreso il
funzionamento del sistema solo dalla modalita di sospensione di Windows Vista, seguire le istruzioni seguenti per
risolvere il problema. Questo errore si verifica in conformita con il criterio di Windows Vista, che attiva il sistema TMM
(Transient Multimon Manager) quando il coperchio del notebook (S3) viene chiuso. TMM disconnette lo schermo LCD
dal sistema operativo e quindi lo ripristina alla riapertura del coperchio. Cid potrebbe avviare TMM per ripristinare una
vecchia impostazione dello schermo, causando in alcuni casi lo sfarfallio dello schermo o il cambiamento della risoluzione.
1. Fare clic su Start, e fare clic su Pannello di controllo (oppure scegliere Impostazioni e fare clic su Pannello di controllo) e fare
doppio clic su Strumenti di amministrazione (Sistema e manutenzione).
2. Fare doppio clic su Utilita di pianificazione (Pianifica attivita).

3. Fare doppio clic su Libreria Utilita di pianificazione > Microsoft > Windows, e fare clic su MobilePC per aprire il pannello di
controllo.

4. Clic destroy sul TMM, selezionare Disattiva, e quindi chiudere tutti i pannelli di controllo.
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Figura 19 - Sistema e manutenzione (Pannello di controllo)
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Ultimi aggiornamenti delle specifiche tecniche

Le specifiche tecniche elencate in questa appendice sono corrette al momento di andare in stampa. Alcuni elementi (in particolare
tipi di processore e velocita) possono essere modificati o aggiornati causa la programmazione del produttore. Per dettagli rivol-
gersi al proprio centro di assistenza.

Funzionalita Specifiche tecniche

Tipi di Processore Intel Core 2 Duo (65nm) tecnologia di processo a 65 nm

processore 478 pin Micro-FCPGA package Cache L2 da 4MB & FSB a 800MHz
T7300/ T7500/ T7700/ T7800 -2,0/2,2/ 2,41 2,6 GHz
Processore Intel Core 2 Duo (65nm) tecnologia di processo a 65 nm
478 pin Micro-FCPGA package Cache L2 da 2MB & FSB a 800MHz
T7100 -1,8 GHz
Processore Intel Celeron M (65nm) tecnologia di processo a 65 nm
478 pin Micro-FCPGA package Cache L2 da 1MB & FSB a 533MHz
530/ 540/ 550 -1,73/ 1,86/ 2,0 GHz

Logica del core VIA VN896CE + VT8237A

Memoria Due prese SODIMM 200 pin, dotata di supporto per la memoria DDRII (DDR2) 533/ 667
Memoria espandibile fino a 2 GB

Sicurezza Slot blocco di sicurezza (tipo Kensington®) Password del BIOS

.|
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Funzionalita Specifiche tecniche
BIOS Phoenix BIOS (SPI Flash ROM da 8Mb) Phoenix BIOS
Opzioni di LCD Modelli A & B Modello C
15,4" - WXGA (1280 * 800) TFT LCD 17,0" - WXGA (1440 * 900) TFT LCD
15,4" - WXGA+ (1440 * 900) TFT LCD 17,1" - WSXGA+ (1680 * 1050) TFT LCD
17,1" - WUXGA (1920 * 1200) TFT LCD

Periferiche di Una unita di tipo ottico (CD/DVD) da 12,7 mm (altezza) - vedere “Opzioni” a pagina 219 per le opzioni

memorizzazione | dellunita
Un disco rigido SATA facilmente sostituibile da 2,5" di 9,5 mm (altezza)

Audio Interfaccia conforme Intel High Definition Audio 2 altoparlanti incorporati
Sistema sonoro stereo 3D Microfono incorporato
Compatibile con Sound-Blaster PRO™
Visualizzazione Modello A Modelli B & C
Video sistema integrato VIA VN896CE Sistema video NVIDIA GeForce 8400M G (NB8M-
(interno sul chip) SE) Discrete (esterno su scheda)
Motore grafico 128-bit 2D/3D integrato Memoria grafica totale TurboCache™ fino a 895MB
Supporto per la risoluzione in pixel di monitor (con memoria di sistema)
analogici fino a 2048 * 1536 128MB DDR3 Videomemoria on Board
Compatibile con MS DirectX® 9 Supporto per doppio schermo e velocit' di p=y
aggiornamento ergonomiche fino a 2048 * 1536 Qo
Compatibile con MS DirectX® 10 Q
=)
(@

Tastiera Tastiera "Win Key"

.|
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Funzionalita Specifiche tecniche
Periferica di TouchPad incorporato (funzionalita tasto di scorrimento integrata)
puntamento

Lettore di schede | Modulo lettore di schede 7-in-1 (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Nota: Schede MS Duo/ Mini SD/ RS MMC richiedono PC adattatore

Interfaccia Tre porte USB 2.0 Un jack uscita S/PDIF
Una porta per monitor esterno Un jack RJ-11 per modem
Un jack uscita delle cuffie Un jack RJ-45 per LAN
Un jack ingresso del microfono Un jack di ingresso CC

Un jack di ingresso di linea (Line-In)

Comunicazione Fax/Modem Plug & Play da 56K conforme V.90 & V.92 Modulo Bluetooth 2.0 + EDR USB (opzione di

LAN 10Mb/100Mb Ethernet fabbrica) _
Modulo WLAN 802.11 b/g USB (opzione) MOdyIO di c.amera.PC USB da 1,3M 0 2,0 M pixel
(opzione di fabbrica)
Slot Slot ExpressCard/54(34)
ExpressCard
Risparmio ener- Supporta ACPI v2.0
gia
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Funzionalita

Specifiche tecniche

Alimentazione

Modelli A & B

Adattatore CA/CC a pieno campo
Ingresso CA: 100-240V, 50-60Hz
Uscita CC: 19V, 3,42A 0 18,5V, 3,5A (65W)

Modello C

Adattatore CA/CC a pieno campo
Ingresso CA: 100-240V, 50-60Hz
Uscita CC: 19V, 4,74A (90W)

Pacco batteria Smart agli loni di Litio (6 celle), 4000mAH (Tutti modelli)

(o]

Pacco batteria Smart agli loni di Litio (6 celle), 4400mAH (Modelli B & C)

Requisiti ambien-
tali

Temperatura
In esercizio: 5°C - 35°C
Non in esercizio: -20°C - 60°C

Umidita relativa
In esercizio: 20% - 80%
Non in esercizio: 10% - 90%

Dimensioni
fisiche & Peso

Modelli A & B

360 (larghezza) x 267 (profondita) x 25,4 - 34
(altezza) mm (min)
2,6 kg con batteria da 6 celle

Modello C

397 (larghezza) x 280,5 (profondita) x 39 (altezza)
mm (min)

2,98 kg +/- 3% con batteria da 6 celle e senza moduli
opzionali

Opzioni

Opzioni modulo unita ottica:
Unita Combo
Unita DVD-Dual (Super Multi)

Modulo WLAN 802.11 b/g USB

Modulo lettore d'impronte digitali

(opzione di fabbrica - solo per i Modelli B & C)
Modulo di camera PC USB da 1,3M o0 2,0 M pixel
(opzione di fabbrica)

Modulo Bluetooth 2.0 + EDR USB (opzione di
fabbrica)
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